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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications. 

This CRM Application Foundation Concepts and Procedures guide provides 
information and instructions to help you work effectively with the Oracle CRM 
Application Foundation components.

This preface explains how the Concepts and Procedures guide is organized and 
introduces other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Oracle CRM business users

■ Customer Service Representatives

■ Field Service personnel

■ System Administrators

This guide assumes that you have the following prerequisites:

■ Understanding of the basic company business processes

■ Knowledge of products and services as defined by your marketing policies
xiii



Structure
This manual is a compilation of the topics in the online help for Oracle CRM 
Application Foundation components. It contains the following topic sections: 

"Understanding" topics provide overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications.

"Using" topics provide process-oriented, task-based procedures for using the 
application to perform essential business tasks. 

"Administering" topics provide task-based procedures for required for ongoing 
system maintenance and includes information on administration tools and utilities.

Related Documents
For more information on Oracle CRM Application Foundation, see the following 
manuals:

■ Oracle CRM Application Foundation Implementation Guide

■ Oracle CRM Foundation Technical Reference Manual

Other Sources of Information
For additional information regarding the Oracle E-Business Suite, consult the 
following:

■ Oracle Application Product Update Notes, Release 11 

■ Installing Oracle Applications, Release 11 

■ Maintaining Oracle Applications, Release 11 

■ Oracle Application Concepts 

■ Oracle Applications System Administrator’s Guide 

■ Implementing Oracle CRM: ERP Functional Flows

■ Implementing Oracle CRM: Foundation Functional Flows

In addition, Oracle offers several relevant courses through Oracle University:

■ 11i Use and Administer Oracle CRM Foundation

■ 11i Implement Oracle CRM Foundation
xiv



Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program web site at 
http://www.oracle.com/accessibility/. 

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace. 
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Understanding Territory Manager

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. 

This section covers the following topics:

■ Territory Management Overview

■ Terms and Definitions

■ Basic Territory Building Blocks

■ Different Ways of Creating Territories

■ Territory Hierarchies

■ Territory Winning Rules

■ Sample List of Predefined Territory Qualifiers

■ Understanding the Territory Details Window

■ Territory Manager Process Flow

Territory Management Overview
The following topics describe what Territory Manager is and when and why you 
use it:

■ What is a Territory?

■ What is the Territory Manager?

■ What is the Territory Lookup Tool?
Understanding Territory Manager 1



Territory Management Overview
What is a Territory?
A territory is an organizational domain with boundaries defined by attributes of 
customers, products, services, and resources.

Territories can be created on multiple criteria including postal code, area code, 
country, vertical market, size of company, and product expertise. It can be created 
based on geographical locations, for example, East Coast and West Coast territories. 
It can also be based on customer name if targeting specific customers or products, 
for example, Business World territory, or the combination of both geographical 
location and customers, such as a West Coast Business World territory.

What is the Territory Manager?
Territory Manager provides user interfaces and functionality that organizations can 
use to manage territories.

Use Territory Manager to automatically assign sales and service teams based on 
their availability and expertise. Also use it to make sales, and service information 
more secure by restricting personnel access to customer data.

Most sales and service territories are one dimensional. They can assign tasks to 
employees based on:

■ postal code

■ area code

■ country

■ vertical market

■ size of company

■ product expertise

Territory Manager makes it possible for you to create multidimensional territories 
using a number of such criteria.

For example, you can assign all large customers within a specific geographical area 
only to those sales representatives who have an expert knowledge of a product and 
have been with the company for more than one year.

You can create multiple such territories for individuals or for teams of sales and 
service representatives. Think of Territory Manager as a high-level programming 
tool that determines the assignment of tasks and resources within your company.
2 Oracle CRM Application Foundation Concepts and Procedures



Terms and Definitions
What is the Territory Lookup Tool?
Many Oracle Sales users need to have the ability to lookup territories and the 
representatives assigned to those territories (which have been defined for Oracle 
Sales and Telesales.) The Territory Lookup Tool allows these users to view the 
appropriate sales representatives that have been assigned to specific territories. 

The Territory Lookup Tool has a dynamic window format that requires no 
customizing. It dynamically displays the account qualifiers for sales that are 
selected in Territory Manager. You can enter criteria in fields that are enabled 
qualifiers.

See Also
Basic Territory Building Blocks

Different Ways of Creating Territories

Terms and Definitions
The following table describes Territory Manager terms and definitions.

Territory Manager Terms and Definitions

Term Description

Automatic Assignment Automatic Assignment refers to the matching of territories to 
resources resulting in a “Winning Territory”

Catch All A Catch All territory is a placeholder used at the top of a 
territory hierarchy when no other has been defined.

Effective Dates The date a territory, member assignment, and so on, is 
effective, or to be in use.

Escalation Territories Escalation territories provide you with the ability to define the 
escalation path in the event of exceptions. This is necessary for 
all administrative purposes and accountability purposes.

Territory based escalation definition will provide you with the 
multi-level escalation path for each territory.

When defining a territory, the user has the option of 
designating the escalation territory. An escalation territory 
must be defined with the escalation flag checked before it will 
be present in the Escalation LOV.

Number of Winners The Number of Winners field is used to specify the maximum 
number of potential winning territories.
Understanding Territory Manager 3



Terms and Definitions
Operators Operators refer to the ability to use arithmetic operators. While 
defining territories, the qualifier values should be either 
discreet using operators (for example, <,>,=<>,<=,>=, LIKE, or 
a range using BETWEEN.

Qualifiers Qualifiers are used to define Territories.

Dynamic Mode
(Default)

Dynamic qualifiers are used to control the number of territories 
after creating a mass number of territories. The values of both 
transaction and resource dynamic qualifiers are exclusively 
mixed together while assigning them to the new territories. 

Static Mode Static qualifiers are used to transfer the qualifier’s values to 
every new territory no matter if it is a transaction or a resource 
qualifier after territory mass creation. Therefore, you can treat 
the values of the static qualifiers as the required values for 
every new territory.

Rank Rank is used to specify the priority of a territory among 
territory random selection.

Resource Qualifiers Resource Qualifiers are the criteria used specifically in 
selecting resources.

TAE Territory Assignment Engine. After territories are defined, each 
module can call a standard API to get a set of qualifying 
employees for a transaction. The API in turn calls the Territory 
Assignment Engine to figure out the qualified Territories that 
are returned to the API, which then figures out the qualifying 
resources.

TM Territory Manager. This is used as a tool that helps manages 
territories.

Territory A territory is an organizational domain with boundaries 
defined by attributes of customers, products, services, and 
resources.

Territory Administrator This person administers the specific and periodic duties of 
Territory Manager. See Getting Started.

Territory Templates A territory template is used to create many similar territories 
simultaneously. They can be based upon territory types.

Whenever a new set of territories needs to be generated, a 
template can be used. (Optional)

Territory Manager Terms and Definitions

Term Description
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Basic Territory Building Blocks
Basic Territory Building Blocks
Use the following basic building blocks to define a territory:

■ Qualifiers

■ Territories

■ Territory Types

■ Territory Templates

■ Escalation Territories

Qualifiers
The following section describes qualifiers in detail:

■ Qualifier Components

■ Transaction Qualifiers

■ Resource Qualifiers

Territory Type Territory Types are used to group transaction qualifiers when 
creating territories. In usage, territory types are based on the 
specific business need. Consequently, territory types can be 
defined to organize the business. Types are also able to be 
based on usage, such as, Marketing, Sales, and Service.

A territory type can be based also upon customer and product. 
Another example can include customer type and location. 

Top-level Territory A top-level territory is a territory that has the "Catch All" as a 
parent.

Transaction Qualifiers Transaction Qualifiers are the criteria used to determine the 
winning territory.

Note: When creating a territory, you may not need all of the 
building blocks. You can create a stand-alone individual territory 
by entering territory qualifiers and their values directly, without 
using a territory type, a territory template, or an escalation territory.

Territory Manager Terms and Definitions

Term Description
Understanding Territory Manager 5



Basic Territory Building Blocks
■ Using Qualifiers

■ Seeded Qualifiers

Qualifier Components
There are two types of qualifiers that help define a territory: Transaction Qualifiers 
and Resource Qualifiers.

A qualifier also consists of three components: name, operator, and value.

The following table describes each component:

Transaction Qualifiers
Transaction Qualifiers are used to specify the criteria about how the territory 
module assigns resources to transactions. It is the first key decision point when 
Assignment Manager tries to assign resources to a document or a task. 

For example, use area code, postal code, company name, or opportunity channel as 
the criteria to help assign qualified resources for transaction needs.

Different territory usages, like Oracle Sales or Service, use different sets of 
transaction qualifiers and those transaction qualifiers are grouped by transaction 
type. For example, a sales or telesales territory has three predefined transaction 
types: Account, Lead, and Opportunity. Some examples of transaction qualifiers 
within the Account Transaction Type are company name, area code, and postal 
code. Opportunity channel is one transaction qualifier for the Opportunity 
Transaction Type.

Qualifier Components

Components Description

Name The name of the qualifier. It can be postal code, item, task priority, request 
status, and job title.

Operator Use operator to connect a qualifier name and its values to make a qualifier 
meaningful. The operator’s list of values (LOV) depends on the data type 
of the qualifier. Possible values are =, < >, >, <, >=, <=, Like and Between. 
The default value for this field is "=".

Value The selection from the LOV in this field is based on the selected qualifier. 
For example, the LOV for the request status qualifier can be Open or 
Closed. If the qualifier is area code, then manually enter this field, for 
example, 408, 415, and so on.
6 Oracle CRM Application Foundation Concepts and Procedures



Basic Territory Building Blocks
Resource Qualifiers
Resource Qualifiers specify what attributes are used to select the individuals 
responsible for those transactions. Examples include job title, competence, and 
language. These qualifiers act as filters which define resource selections.

For example, if you are looking for specific resources who speak Italian for your 
customer needs, then the resource qualifier can be identified as "Language = 
Italian." This aids in selecting resources that qualify for your condition.

You can still make selections from the qualified resources suggested by the resource 
qualifier before assigning them to a territory.

Using Qualifiers
Why use Transaction and Resource Qualifiers?

After understanding the concepts of transaction qualifiers and resource qualifiers, it 
is easier to understand how a territory works. A territory uses resource qualifiers to 
filter resources that you want to attach to a territory. A territory uses transaction 
qualifiers and values to determine if a territory can win in that transaction. If the 
territory happens to win, then the resources attached to the territory can be 
assigned to the transaction. 

Seeded Qualifiers
Territory Manager provides a large number of seeded qualifiers for Defect 
Management, Sales and Marketing, Service, and Trade Management.

Territories
A Territory consists of qualifiers and their values. You can create a territory 
individually or you can create a large number of territories all at the same time 
using a territory template. 

Note: You must enable existing transaction qualifiers before using 
them.

Note: There is no need to specify the resource qualifiers if you 
know exactly what resources are needed for a certain territory. 
Instead, identify the resource names on the Resource tab of the 
Territory Details window.
Understanding Territory Manager 7



Basic Territory Building Blocks
Suppose your company wants to finalize a business transaction with Business 
World Inc. and that it also requires a manager position to close the deal. A territory 
is set up with two qualifiers: "Customer Name = Business World Inc." and "Job Title 
= Manager" for this one time deal. You do not need to use any of the existing 
Territory Type or Territory Template for this territory creation. You can add an 
escalation territory later with a different manager who has a superior record for 
handling complex cases if the assigned manager is not able to close the deal.

The territory creation process can use some or all of the following basic building 
blocks:

■ Escalation Territories

■ Territory Templates

■ Territory Types

See Also
 Different Ways of Creating Territories

Territory Types
A Territory Type is a grouping of transaction qualifiers. Without setting qualifier 
values, you can use it to simplify and systematize the territory creation process. Use 
territory types to group transaction qualifiers used for creating territories. This 
saves time when creating similar territories. 

Suppose you want to create territories by geographical area. In this case, create a 
territory type with the Country and Postal Code qualifiers.

Territory Templates
Use a Territory Template to create many similar territories at the same time. 
Suppose you have two large customers and you want to create a territory for each 
of them for every state in the United States. Creating individual territories requires 
repeating the same procedure 100 times, once for each of the 50 states and again for 
each company. Using a territory template, you can create all of the 100 territories at 
the same time. 

Note: Plan your territories and enable existing transaction 
qualifiers before creating territory types.
8 Oracle CRM Application Foundation Concepts and Procedures



Different Ways of Creating Territories
Escalation Territories
An escalation territory provides the resources responsible for managing escalations.

You use Escalation territories to define the escalation path with appropriate 
resources that the escalation owner identified for the territory in the event of 
exceptions. In case of automatic assignment by using an escalation territory, the 
Assignment Manager is used in conjunction with the Territory Manager. The 
escalation can be automatically assigned to an owner if the escalated document (like 
service request, tasks, or defect) has an escalation territory defined. 

You can create alternate escalation territories to automatically reassign a service call 
when certain conditions are not met. 

a. A repair team assigned to a repair does not take action within five business 
days, so now that repair can be assigned automatically to another group. 

b. A service engineer cannot service a request within a certain time frame 
which is set up in the Business Rule Monitor (BRM), so now the service 
request will be automatically escalated to the resource.

 Different Ways of Creating Territories
You can create territories in one of three ways:

1. Individually

2. With a territory type

3. With a template

Creating Individual Territories 
Create a standalone territory by entering territory qualifiers and their values 
directly. This method does not leverage your work because you have to add both 
qualifiers and their values for each territory you create.

Creating a Territory Using a Territory Type
Create territories using a territory type in a two step process:

■ Create the territory types by adding chosen transaction qualifiers.

■ Use territory types to create territories.

Use this method for creating multiple territories with similar characteristics. Using 
territory types to create territories saves time because you do not have to add 
Understanding Territory Manager 9



Territory Hierarchies
qualifiers to each individual territory, but you still have to create each individual 
territory separately by entering values for the qualifiers.

Creating a Territory Using a Territory Template
Create a large number of territories all at the same time using a territory template. 

Suppose you want to create a separate territory for every state in the United States 
for two large customers. Creating individual territories requires you to repeat the 
procedure 100 times, once for each of the 50 states for each company. Using territory 
types, you still must create each 100 territories separately although the process is 
somewhat shorter. By following the procedure outlined in Using a Template to 
Create Large Numbers of Territories, you can create all 100 territories at the same 
time.

Territory Hierarchies
The purpose of having territory hierarchies is to make the territory assignments and 
searches more efficient. Territory hierarchies also have the ability to store the 
parent-child relationship among territories.

Parent-Child Territory
Any territory consisting of one or more subterritories is considered as a parent 
territory. For example, a West Coast territory could consist of three subterritories: 
Washington, Oregon, and California. This West Coast territory and the three 
subterritories have the parent-child relationship. 

Features of a Child Territory (Subterritory)
To help maintain integrity in the hierarchy, each child territory logically inherits the 
qualifiers and values of the parent territory. Also, additional qualifiers and values 
can be added. 

Note: You must use territory templates to create territories if you 
plan to use resource qualifiers. Territory types limit you to using 
transaction qualifiers only,
10 Oracle CRM Application Foundation Concepts and Procedures



Territory Winning Rules
Territory Winning Rules
Territory Manager uses the Number of Winners field set to the top level of territory 
hierarchy to determine the winning territories. This field cannot be entered if it is 
not the top level territory. 

Territory winning rules are used in several different ways in the Oracle E-Business 
Suite. For example, Oracle Service tends to enter ONE in the Number of Winners 
field, which helps to select the most qualified resources for the service requests.

Multiple winners are commonly used in Oracle Sales to meet the business needs, 
but a single winner is also used in Sales. If the Number of Winners field is not set, 
then the number of winning territories defaults to one for the hierarchy under that 
top-level territory. 

There are two possible outcomes based on values entered in the Number of Winners 
field:

■ One Winner

■ Multiple Winners

One Winner
If you enter 1 in the Number of Winners field in the Overview tab, then Territory 
Manager assigns the transaction to a single territory in the territory hierarchy.

Use the territory ranking mechanism for breaking ties between wining territories. 
The lowest rank of competing territories wins against the higher rank of the 
territories in the territory hierarchy.

Multiple Winners
If you enter a number greater than 1 in the Number of Winners field in the 
Overview tab, then Territory Manager assigns a transaction to multiple qualifying 
territories.

Use the Number of Winners field to limit the number of winning territories. 
However, if there are three territories that qualify for the criteria, but it can only 
have two winners, then ranking determines the final two winners among the three 
territories.
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Sample List of Predefined Territory Qualifiers
Sample List of Predefined Territory Qualifiers
Territory Manager includes pre-defined qualifiers for the following CRM modules:

■ Oracle Defect Management

■ Oracle Sales and Marketing

■ Oracle Service

■ Trade Management

Below is a small sample of both resource and transaction qualifiers.

See Also
Viewing Transaction Qualifiers

Understanding the Territory Details Tab
The table below describes the different tabs available in the Territory Details 
Windows.

Note: Only the territory that has resources attached can be a 
winning territory.

Example of Predefined Territory Qualifiers

Application Type Qualifier Type Qualifier Name

Defect Management Defect Transactions Product

Sales Account  Customer Name Range

Trade Management Trade Account State

Service Service Request Request Type

Territory Details Window Tabs

Tab Description

Overview Tab Use this tab to enter basic territory information including name, 
description, effective dates, and crucial information like rank, 
number of winners, and transaction types.
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Understanding the Territory Details Tab
The following sections describes the fields on each tab in detail.

The Overview Tab
The following table describes the functionalites of the fields on the Overview tab in 
the Territory Details Window.

Transaction Qualifiers 
Tab

Specify transaction qualifiers and their values for a territory. 

Resource Qualifiers Tab 
(Optional)

Use this tab to specify resources qualifiers and their values. 

It is not mandatory to enter resource qualifier information if you 
know exactly what resources you want to use in a territory.

Resources Tab Use this tab to specify resources manually or click the Auto 
Assign Resources button to display and select qualifying 
resources based on resource qualifiers and their values defined in 
the Resource Qualifiers tab. 

Subterritories Tab 
(Optional)

Use this tab when a territory hierarchy includes territories below 
the current territory. Click New Subterritory and repeat the 
territory creation procedure for new subterritories.

WARNING: After creating or modifying a territory, you must run 
the concurrent program “Generate Territory Package.” This 
allows the system to compile the business rules defined in the 
territory creation. 

If this step is not completed, changes to territories will not be 
reflected when the Territory Assignment Engine assigns 
transactions.

Overview Tab

Field Description

Usage Describes the usage of this territory. For example, this territory is 
used for Oracle Service. The usage limits the selection of transaction 
types. 

Escalation Leave this field blank if an escalation territory is not required.

Territory Details Window Tabs

Tab Description
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Understanding the Territory Details Tab
Transaction Types The transaction type is based on the territory usage. For example, 
Service Request and Task are the transaction types for Oracle 
Service. Account, Lead and Opportunity are used by Oracle Sales 
and Telesales. 

The selection of transaction qualifiers is based on the transaction 
type. For example, task type, status and priority are transaction 
qualifiers of Task transaction type for the usage of Service 
application. 

To enable existing transaction qualifiers, select Setup Qualifiers 
from the Administration pull-down menu. 

Type Select the territory type if you want to create multiple territories 
with similar characteristics. 

Once the territory type is selected, the names of the Transaction 
Types fields and the transaction qualifiers on the Transaction 
Qualifiers tab populate automatically because the territory type is a 
group of transaction qualifiers, and the transaction qualifiers are 
based on the transaction type. You only need to assign the value of 
each transaction qualifier to the territory you are going to create on 
the Transaction Qualifiers tab.

You cannot select the territory type if the transaction types are 
selected first because the transaction types override the territory 
type. The (territory) Type field is blocked out. 

Number of Winners Specify the number of winners only at the top level of a territory 
hierarchy, such as the top level territory directly under Oracle 
Service. This field is protected if it is not the top level territory and 
an error message appears. 

Rank Specify the territory ranking information. The lowest rank of 
competing territories wins at the same level in the hierarchy.

End Date Use this field to obsolete a territory. This field is not mandatory. 

Template This field displays the template name if you create a territory using 
a template. 

Freeze Once this field is checked, the territory cannot be updated any 
more. You cannot uncheck this field after it is checked. Once this 
is checked, the territory can only be deleted.

Copy Territory Used to duplicate an existing territory. To duplicate an existing 
territory including the entire hierarchy, click the Copy Territory 
button. A Copy Territory window opens and you can check the 
Copy Hierarchy check box. 

Overview Tab

Field Description
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Understanding the Territory Details Tab
Opportunity, Lead, Task, and Service Request are considered a super set of the 
Account qualifiers. Therefore, the account related transaction qualifiers, such as 
Postal Code and State, are available even if the account transaction type is not 
selected for the territory usage of Oracle Sales or Telesales. 

The Transaction Qualifiers Tab
The following table describes the functionalites of the fields on the Transaction 
Qualifiers tab in the Territory Details Window:

WARNING: Be cautious while using the Freeze check box. It is 
suggested that you leave this freeze box unchecked at all times 
unless it is necessary. You cannot undo a Freeze.

Transaction Qualifiers Tab

Field Description

Name The available transaction qualifiers are based on the transaction 
types and usage defined in the Overview tab. Enter the qualifiers 
manually if you create a territory without a territory type. 

If you cannot find the transaction qualifiers or return no values 
from the list of values (LOVs) then enable them from the Setup 
Qualifiers window.

Use the wildcard blind query “%%%” to bring up the LOV in the 
Value From and Value To fields if you want to list the entire LOV 
for the selected qualifier. Otherwise, enter at least three letters, such 
as “Bus”, to launch the LOV for “Business.”

Allow Overlap The default value for this field is checked. If you do not want to 
allow overlap for a qualifier, uncheck the Allow Overlap check box. 
Allowing overlap enables you to assign overlapping territory 
values to the same qualifier. 

By enabling overlap, you can enter both ranges as values for the 
qualifier. With overlap not allowed, you cannot use any of the 
values within both ranges for a territory at the same level in the 
hierarchy.

If checked the Territory Manager prevents you from entering the 
second range of values for the qualifier. However, you can use the 
values as the qualifier for the next level down or up.

Next Value Set This button is used only in territory template and if the qualifier is 
in dynamic mode. 
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Understanding the Territory Details Tab
The Resource Qualifiers Tab
Unlike the transaction qualifiers, the availability of the resource qualifiers is not 
limited to the usage and transaction types you choose for a territory. 

Enter the resource qualifiers you are going to use if you need assistance in assigning 
resources to a territory. For example, use “Job Title = Manager” to help you identify 
resources with manager title. There is no need to use this tab if you know exactly 
which resources are going to be used for a territory.

The following table describes the functionalites of the fields on the Resource 
Qualifiers tab in the Territory Details Window.

Mass Create 
Territories

Specify the template name in the Overview tab and use this button 
for large numbers of territory creation. 

Show Inherited 
Qualifiers

If this territory is part of a hierarchy of territories, click this button 
to see which qualifiers this territory logically has inherited from its 
parent territories.

WARNING: You must enter transaction qualifiers and values in a 
territory so that it can be considered when a transaction is 
assigned. If you do not specify transaction qualifiers in a 
territory, then the resources attached to the territory will not be 
assigned to any transactions. 

Resource Qualifiers Tab

Field Description

Name Enter the Name of the Resource or use the list of values (LOVs) to 
populate the field.

Type Automatically populates based on the name of the resource 
qualifier.

Next Value Set This button is used only in territory template and if the qualifier is 
dynamic mode.

Operator Use this field to connect a qualifier name and its values to make a 
qualifier meaningful. 

Transaction Qualifiers Tab

Field Description
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Understanding the Territory Details Tab
The Resources Tab
Only territories that have resources attached can be winning territories. Therefore, 
when a resource is added to a territory for the first time, you must run the 
"Generate Territory Package" concurrent program. 

Resources assigned to territories can be any CRM resource defined in the Resource 
Manager, for example, employees, salespeople, groups, teams, parties, partners, and 
supplier contacts. If you know exactly which resources are going to be assigned to a 
territory, then it’s not necessary to use the Resource Qualifiers tab to limit the 
resources. 

The following table describes the functionalites of the fields on the Resources tab in 
the Territory Details Window.

Value From This field is based on the Name entered. There is also an LOV list to 
choose from.

Value To Field is dependent on the Operator chosen.

Mass Create 
Templates

Use this button to create a large numbers of territories at the same 
time. Specify the template name in the Overview tab before clicking 
this button.

 Resources Tab

Field Description

Name Enter the Name of the Resource or use the list of values (LOVs) to 
populate the field.

Type Automatically populates based on the name of the resource 
qualifier.

Group
(Located on the 
horizontal scroll bar.)

Specifies which groups the resource belongs to. 

Role
(Located on the 
horizontal scroll bar.)

 Specifies which roles the resource is assigned to.

Resource Qualifiers Tab

Field Description
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Understanding the Territory Details Tab
If you cannot find any people in the Qualifying Resources window, then go back to 
the Resource Qualifiers tab and either enter a different set of resource qualifier 
values or select resources manually on the Resources tab.

The Subterritories Tab
Use the Subterritories tab when your territory hierarchy includes territories below 
the current territory. This tab helps you create subterritories, also called child 
territories.

Access Type Specifies the transaction type for each individual resource assigned 
to a territory. If this field is blank, then the resource assigned to a 
territory can access every transaction type listed in the Overview 
tab.

For example, if the selected access type for John Doe is Service 
Request, then John can only be assigned to a job related to service 
request. He cannot be assigned to a task or a task through service 
request.

Auto Assign 
Resources

Select the Auto Assign Resources button to view all qualifying 
resources that match the Resource Qualifiers.

Full Access
(Located on the 
horizontal scroll bar.)

This field is only used by Sales and Telesales. If selected, the 
resource has the full access to the transaction type specified 
in the Access Type field. 

For example, if the access type is Lead, the resource can only be 
assigned to Lead and Account. The person cannot be assigned to an 
Opportunity. 

Primary Contact
(Located on the 
horizontal scroll bar.)

Select this box for the primary contact if you have more than one 
resource identified.

Start Date and End 
Date
(Located on the 
horizontal scroll bar.)

Specify the resource available dates.

Note: Auto Assign Resources is functional only if the resource 
qualifiers and their values are entered in the Resource Qualifiers 
tab.

 Resources Tab

Field Description
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Territory Manager Process Flow
The parent territory field populates automatically after clicking the New 
Subterritory. For example, you create a subterritory by clicking this button from the 
Bay Area - South territory, then Bay Area - South becomes the parent territory of 
this new subterritory.

The following table describes the functionalites of the fields on the Subterritories tab 
in the Territory Details Window:

Territory Manager Process Flow
Before using the Territory Manager, your territory planning team must analyze 
your business and organization needs for better territory planning and future 
management. This step should be in place before implementing the Territory 
Manager.

The implementation team enables seeded qualifiers used in your territories 
based on the planning decisions. 

The territory administrator then begins the territory creation process, according 
to the territory plan, using the concept of basic territory building blocks. This 
territory creation process may use different ways to create territories either with 
or without using templates or types. It can include the use of escalation 
territories to help manage future escalations. 

After territories have been created, you can search and view territory 
hierarchies through either the Administration menu or the Navigator tree. The 
territory administrator must run the “Generate Territory Package” concurrent 
program to generate correct territories with changes reflected before calling 
modules assign resources defined in your territories.

The following table describes the order and process of implementing, using, 
and administering the Territory Manager.

Subterritories Tab

Field Description

Start Date Enter the start date.

End Date Enter the end date.

Rank Enter the rank.

New Subterritory Select this button to create a child territory with all the attributes of 
the parent. It repeats the territory creation procedure for the new 
subterritory.
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Territory Manager Process Flow
Territory Manager Process

Steps Description Required Owner

Territory Planning Analyze the territory setup in your organization 
before utilizing Territory Manager. You need 
enterprise-wide cooperation and feedback. 

You must expect to make multiple territory 
revisions in the early months of operation as your 
enterprise discovers omitted information or 
territories that do not work on a day-to-day basis.

Yes Management, 
Implementor, Territory 
Administrator

Enable Qualifiers Use qualifiers as the criteria to delineate a territory. Yes Implementor

Create Territories Create territories for a variety of transactions. For 
example: account, lead, opportunity, and service 
requests. 

Yes Territory Administrator

Create Templates Use a territory template to create many similar 
territories at the same time.

Optional Territory Administrator

Create Types Create territory types to form a grouping of 
transaction qualifiers that can be used to simplify 
and systematize the territory creation process.

Optional Territory Administrator

Create Escalation 
Territories

Use escalation territory to create alternate 
territories where transactions such as a sales lead 
or service call is automatically reassigned when 
certain conditions are not met. It defines the teams 
that handle escalations. It is limited to identifying 
resources. 

Optional Territory Administrator

Create Customer 
Name Range 
Group

Create, modify, or delete an existing name of a 
group and it’s children.

Optional Territory Administrator

Create Mass 
Change Territory 
Resources

Use this tab to mass transfer territory allocations 
from one resource to another.

Optional Territory Administrator

Run Concurrent 
Program

Run the concurrent program "Generate Territory 
Package" after creating or modifying your 
territories.

This allows the system to compile the business 
rules defined during territory creation. If this step 
is not completed, the territories will not work 
correctly.

Yes Territory Administrator
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Territory Manager Process Flow
See Also
Using the Territory Details Window

Search and View 
Territories

Search and view territories based on various 
criteria. 

You do not need to run the Concurrent Program to 
search or view Territories.

Optional All users

Territory Lookup 
Tool

Use this HTML based window to search for sales 
reps. The winning territory is based on the 
Territory setup and search criteria selected. It 
searches down the territory trees to find the 
winning territory. 

Optional All users

Run Reports Run reports to track your selections and changes.

There are two types of reports you can generate in 
either HTML or export to Microsoft Excel:

■ Territory Definition Report

■ Territory Changes Report

Optional All users

Territory Manager Process

Steps Description Required Owner
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Territory Manager Process Flow
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Using Territory Manager

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. The following topics are generally 
performed by all users.

This section covers the following topics:

■ Getting Started

■ Using the Territory Lookup Tool

■ Accessing the Territory Manager

■ Viewing From the Tree Navigator Window

■ Viewing From the Administration Pull-Down Menu

■ Viewing Transaction Qualifiers

■ Viewing Territory Templates

■ Viewing Escalation Territories

■ Viewing Territory Types

■ Viewing the Navigator

■ Running Reports

Getting Started
Use Territory Manager perform the following tasks:

1. Using the Look Up Tool

2. Viewing Territories
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Using the Territory Lookup Tool
3. Viewing Territory Templates

4. Viewing Escalation Territories

5. Viewing Territory Types

6. Searching the Navigator

7. Running Reports

Using the Territory Lookup Tool
The Territory Lookup Tool returns the names of the sales representatives attached to 
the winning territories based on the Territory setup and search criteria. It searches 
down the territory hierarchy to find the resources of the winning territory. 

Perform the following steps to look up a customer’s assigned sales representatives.

Prerequisites
■ Enable qualifiers

■ Create the necessary territories

■  Have appropriate responsibilities

Steps
1. Navigate to the Territory Lookup window.

■ Since the Territory Lookup feature can be customized, the navigation path 
varies depending on client preferences.

■ The Territory Lookup window is dynamically generated, based on the 
enabled qualifiers in Territory Manager.

2. Enter the value(s) in the search fields and click either Search or Go.

■ If you click Go, then the Select an Organization window appears giving you 
a detailed list of values (LOV) based on the organization name including: 
address and organizational name.

■ Select your choice. The Territory Lookup Search Results window appears. 

■ If you click Search, then the Territory Lookup Search Results window 
appears with the search results. This is a list of sales representatives that 
have been assigned to the customer based on the entered criteria.
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Viewing From the Tree Navigator Window
Accessing the Territory Manager
 You can access the Territory Manager in two ways:

■ From the territory tree Navigator window

■ From the Administration pull-down menu

By accessing the Territory Manager, you are able to view and search for territories. 
Use the Navigator to:

■ View the structure of territories in a tree format and create new territories.

■ View and modify territory types and the territories created by using them.

■ View and modify your created escalation territories.

■ View and modify territory templates and the territories created by using them. 

■ Search for the territory you want to view or modify from the tree structure.

View and modify any item in the tree by double-clicking on it. If this is the first 
territory you are creating, then select the node of an Application, for example, 
Oracle Service or Oracle Sales and Telesales applications.

Viewing From the Tree Navigator Window
Perform the following steps to view the navigator window:

Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. From the tree Navigator window, use the View By drop-down list to select 
different territory options in the Navigator. 

The territory tree structure (territory hierarchy) reflects the change of your 
selection.

3. Click on the node that you want to edit, then right-click to select additional 
options from the menu.
Using Territory Manager 25



Viewing From the Administration Pull-Down Menu
Viewing From the Administration Pull-Down Menu
Perform the following steps to view a territory from the Administration pull-down 
menu.

Prerequisites
None

Steps
1. From the CRM Administrator responsibility, select Territory Manager > 

Territory Administration.

The territory tree Navigator window opens. This window allows you to access 
the Administration option menu bar.

2. Select Administration. 

From this menu you can:

■ Enable qualifiers

■ Define templates, and territory types

■ Create individual or escalation territories

■ Define customer name range groups

■ Make mass change territory resources

■ Perform search functions

Viewing Transaction Qualifiers
Perform the following steps to view the entire list of Transaction Qualifiers.

Prerequisites
None

Note: A catch all territory is a placeholder used at the top of a 
territory hierarchy.
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Viewing Escalation Territories
Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. Select Setup Qualifiers from the Administration pull-down menu.

The Setup Qualifier window opens.

3. Leave the Usage field blank. In the status area select All, then click Find.

The Setup Qualifier window is populated with the defined transaction 
qualifiers including a description, transaction type, and organization.

Viewing Territory Templates
Perform the following steps to view the territory templates.

Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. From the View By drop-down list, select Territory Templates.

3. To view territory templates effective on a specific date, enter that date in the 
Date field. The default is today’s date.

■ The Navigator displays the territory template you have created.

■ If you have used the territory template to create territories, then those 
territories appear in a tree under that territory template.

4. Double-click to view or modify a territory template. 

The Template Territory Details window opens.

Viewing Escalation Territories
Perform the following steps to view escalation territories.
Using Territory Manager 27



Viewing Territory Types
Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. From the View By drop-down list, select Escalation Territories.

3. To view escalation territories effective on a specific date, then enter that date in 
the Date field. The default is today’s date.

4. Double-click to view or modify an escalation territory. 

The Escalation Territory Details window opens.

Viewing Territory Types
Perform the following steps to view territory types.

Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. From the View By drop-down list, select Territory Types.

3. To view territory types effective on a specific date, then enter that date in the 
Date field. The default is today’s date.

4. Double-click to view or modify a territory type. 

The Territory Type Details window opens.

Searching the Navigator
Perform the following steps to search for territories, territory types, escalation 
territories, and territory templates.
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Running Reports
Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. From the Administration menu, choose Search.

The Territory Search window appears.

3. From the Search For drop-down list, select the information type:

■ Territory

■ Territory Type

■ Escalations

■ Territory Template.

4. In the Basic tab, enter the desired data and click Search.

■ The results of your search appear in the Search Results field.

■ Use the Advanced tab to search for specific qualifier values.

5. To view any of the found items, select the item from the Search results and click 
Populate Tree.

The Navigator opens to your selection.

Running Reports
Users with administration privileges have the ability to run two types of reports:

■ Territory Definition Report

■ Territory Changes Report

Both reports can be viewed online or saved in a spreadsheet format.
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Territory Definition Report
Territory Definition Report
Perform the following steps to retrieve specific territory information based on 
certain criteria, such as a specific resource or a transaction qualifier. 

Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Reports > Territory Definition Report.

The Territory Definition Report window opens.

2. Select Output Format from the drop-down menu.

Choose either HTML or Excel.

3. Select Sales Rep from the drop-down menu.

4. Select Qualifiers from the drop-down menu and click OK.

Territory Changes Report
Perform the following steps to trace territory change information for a specific 
period of time.

Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Reports > Territory Changes Report.

The Territory Changes Report window opens.

Note: If you want to view your report as a spreadsheet, it is faster 
to verify your selection in HTML and then export it to Microsoft 
Excel.
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Territory Changes Report
2. Select Output Format from the drop-down menu.

Choose either HTML or Excel.

3. Enter Earliest Change Date and Latest Change Date and click OK.
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Territory Changes Report
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Administering Territory Manager

This topic group provides administrative procedures required for creating 
territories and ongoing system maintenance. It also includes information on 
administration tools and utilities.

This section covers the following topics:

■ Getting Started

■ Creating Individual Territories

■ Using the Territory Details Window

■ Creating Territory Types

■ Selecting the Resources for a Territory

■ Creating Escalation Territories

■ Entering Qualifier Territories

■ Using a Template to Create a Large Number of Territories

■ Step 1: Creating A Template

■ Step 2: Creating Mass Territories With a Template

■ Entering Static Qualifier Values for Templates

■ Entering Dynamic Qualifier Values for Templates

■ Creating Geographical Territories Using a Template (Example)

■ Creating Customer Name Range Groups
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Getting Started
■ Creating Mass Change Territory Resources

■ Tips for Fine-tuning Territory Assignment Performance

■ Running Concurrent Programs

Getting Started
The territory administrator begins the territory creation process. This territory 
process may use different ways to create territories either with or without using 
templates or types. It can also include the use of escalation territories to help 
manage future escalations. 

The Territory Administrator performs the following tasks:

1. Creating Individual Territories

2. Creating Territory Types

3. Creating Escalation Territories

4. Using a Template to Create Large Numbers of Territories

5. Creating Customer Name Range Groups

6. Creating Mass Change Territory Resources

7. Running Concurrent Programs

Creating Individual Territories
Perform the following steps to create individual territories with or without using 
territory types:

1. Create territory overview information with the Overview tab.

2. Select transaction qualifiers using the Transaction Qualifier tab.

3. (Optional) Select resource qualifiers using the Resource Qualifier tab.

Note: Before setting up all your territories, set up two or three 
first. Generate the package and test territory assignments to make 
sure that transactions are correctly assigned. When these few 
territories work correctly, continue setting up all territories. 
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Creating Individual Territories
4. Select Resources using the Resources tab.

5. (Optional) Create Subterritories using the Subterritories tab.

Prerequisites
There must be a Territory Plan in place.

Steps
1. From the CRM Administrator responsibility, select Territory Manager > 

Territory Administration. 

2. Select Define Territory from the Administration pull-down menu.

The Territory Details window opens.

3. Select the Overview tab.

a. Use the list of values (LOV) in the Usage field to select the type of 
application you want to use in this territory. Your selection limits the types 
of qualifiers that can be used in the territory definition.

b. Enter a name and description for the territory. 

c. To limit the time the territory is effective, enter the Start and End Dates. By 
default the territory become effective on the date that you create it.

d. (Optional) Verify that the parent territory is the territory you selected in the 
Navigator. If this is not the parent territory, then use the LOV to select the 
appropriate parent territory.

e. (Optional) If you have created an escalation territory for this territory, then 
enter it using the LOV in the Escalation field. 

f. (Optional) If you want to use an existing territory type to create this 
territory, then use the LOV to enter it in the Type field. If you use a territory 
type, then you are restricted to using the qualifiers set up in that territory 
type. 

g. Use the Transaction Types LOV to select one or more types of transactions 
based on the territory usage. Available values include account, lead, 

Note: You can also use the Select the Territory from the Tree 
Navigator that serves as a parent to the new territory and 
right-click to select New from the pop-up menu.
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Creating Individual Territories
opportunity, and service request. Note that some application types allow 
you only one transaction type.

4. Select the Transaction Qualifiers tab.

a. (Optional) If this territory is part of a hierarchy of territories, then click 
Show Inherited Qualifiers to examine which qualifiers this territory has 
inherited from its parent territory or territories.

b. (Optional) If you have used a territory type to create this territory then the 
qualifiers are already prefilled.

c. If you are creating a new territory without a territory type, enter the 
qualifiers you are going to use in the Transaction Qualifiers region. 

d. If you want to enter overlapping values for a qualifier, then check the 
Overlap Allowed check box.

e. Enter the values and operators for each qualifier. 

5.  (Optional) Select the Resource Qualifiers tab.

a. Use the LOV in the Name field to choose the type of resources for the 
territory.

b. Use the LOV in the Operator field and Value field to make the appropriate 
selections. 

 

6. Select the Resources tab.

a. Select the resources for the territory using the LOV in the Name field. 

b. Enter the Group level from the LOV in the Group field. 

c. Enter Role from the LOV in the Role field.

d. Select Access Type from the LOV in the Access Type field.

WARNING: Be cautious while using the Freeze check box. It is 
suggested that you leave this freeze box unchecked at all times 
unless it is necessary.

Note: Use Mass Create Templates only when creating territories 
with a territory template. Specify the template name in the 
Overview tab before clicking this button.
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Creating Territory Types
7.  (Optional) Select the Subterritories tab.

Use this tab if your territory hierarchy includes territories below the current 
territory.

a. Click New Subterritory and repeat the territory creation procedure for the 
new sub-territory.

b. Click Save from the menu.

See Also
■ Understanding the Territory Details Tabs

■  Using a Template to Create Large Numbers of Territories

Using the Territory Details Window
Use the Territory Details window to perform the following.

■ Create Territories

■ Create Escalation Territories

■ Create Territory Templates

See Also
Understanding The Territory Details Tabs

Creating Territory Types
Perform the following steps to create territory types. 

Prerequisites
■ There must be a Territory Plan in place.

■ You must enable your qualifiers.

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. From the Administration menu, select Create Territory Type.
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The Territory Type window opens.

3. If a similar territory type already exists, then you can save time by copying it.

a. Search for a similar territory type.

b. If a similar territory type is found, then click Copy Type. 

The application creates a copy of the existing territory type that can be 
modified.

4. In the Usage field, use the list of values (LOVs) to select the type of application 
using this territory type. 

5. Enter a name for the territory type and a description.

6. Enter a date range to limit the use of the territory type by date.

7. Use the LOV to select one or more transaction qualifiers based on the territory 
usage field.

8. Click OK to save your work and exit.

Selecting the Resources for a Territory
Perform the following steps to select the resources to staff a territory. 

Prerequisites
The Territory Details window is active with the territory you want to staff 
displayed.

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. Navigate to the chosen territory and double-click the territory.

The Territory Details window opens.

3. Select the Resource Qualifiers tab.

Note: It is not mandatory to enter resource qualifier information if 
you know exactly which resources you want to use in a territory.
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a. In the Name fields of the Resource Qualifier region, use the LOV to enter 
the qualifiers related to the skill set of the employees assigned to this 
territory.

b. Enter the values for each qualifier. 

4. Select the Resources tab.

a. Use the list of values (LOVs) to enter the resources in the Name fields if you 
want to assign them to this territory or you have a small pool of people to 
work with.

b. If you do not know the people you want assigned to this territory and have 
a large pool of potential names, then click Auto Assign Resources.

The Qualifying Resources window displays a list of people that fit the 
resource qualifiers values you have entered. 

If no people or the wrong people are found, then go back to the Resource 
Qualifiers tab and enter a different set of resource qualifier values, or select 
resources manually in the Resources tab. 

c. Select the people you want to assign to this territory by checking the Assign 
check box next to their name.

d. Click OK when you are finished.

e. Check the Primary Contact check box next to the name of the person 
designated to become the primary contact for the territory. 

f. For each resource you can add a Start and End Date to limit their 
participation.

g. For each resource, enter the transactions you want them to access. 

For example, you want some resources to access account and contact 
information, but not lead information. 

h. To enter access for an individual select the resource in the Resources region.

i. Select the access type in the Access region below. 

5. Click Save on the toolbar.

Creating Escalation Territories
Use this procedure to create escalation territories. Escalation Territories are alternate 
territories in which transactions such as a service call are automatically reassigned 
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Entering Qualifier Values
when certain conditions are not met. Escalation Territories define the resources that 
handle the escalations. 

Prerequisites
■ There must be a Territory Plan in place.

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. From the Administration menu, select Escalation Territories.

The Escalation Territory Details window appears.

3. In the Overview tab, use the list of values (LOVs) in the Usage field to select the 
type of application you want to use in this territory. Your selection limits the 
types of qualifiers used in the territory definition.

4. Enter a name and description for the territory. 

5. Enter the Start and End Dates to limit the time the territory is effective.

By default the territory become effective on the date created.

6. Select the resource qualifier for the escalation territory 

See the procedure in Selecting the Resources for a Territory.

7. Click Save on the toolbar.

Entering Qualifier Values
Use this procedure to enter qualifier values while creating individual territories. 
You cannot use this procedure for entering qualifier values in territory templates. 

Prerequisites
The Transaction Qualifiers or Resource Qualifiers tab is selected. 

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.
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Creating a Template
2. Navigate to the chosen territory and double-click the territory.

The Territory Details window opens.

3. Select either the Transaction Qualifiers or Resource Qualifiers tab.

4. Select the qualifier in the Qualifiers region.

You will see the possible value types. For example, if you are entering values for 
the Customer Name qualifier used in Sales applications, then enter a value.

5. Select an operator using the list of values (LOVs). 

The list of operators varies depending on the type of qualifier selected. For 
example, some qualifiers allow only the " =" symbol.

6. Enter the values in the appropriate fields. 

Some operators limit the range of values. The field names change depending on 
the qualifier.

Using a Template to Create a Large Number of Territories
Use this procedure to create a territory template that automates the process of 
creating a large number of territories. After you create the territories, then open up 
each individual territory and select the resources you want assigned to each 
territory.

The following procedure consists of two sections: 

■ Creating a template

■ Creating a large number of territories from that template 

Creating a Template

Prerequisites
■ If you want to use territory types to create territories, then create the territory 

types first.

■ There must be a Territory Plan in place.

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.
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The territory tree Navigator window opens.

2. In the Navigator, select the territory that serves as a parent to the new territory. 
If this is the first territory you are creating, then select Catch All.

3. Right-click and select New from the drop-down menu.

The Template Territory Details window appears.

 If you selected an existing territory as the parent, then the Usage and Parent 
fields are pre-filled. If Catch All is the parent territory, then use the list of values 
(LOVs) in the Usage field to select the type of application you want to use for 
this territory. Your selection limits the types of transaction qualifiers you can 
use in the territory definition.

4. In Transaction Types fields, use the LOV to enter one or more transactions. 

You can create territories for a variety of transactions. These include account, 
lead, opportunity, and service request. CRM applications restrict the types of 
transactions that can be used for territory creation. For example, you cannot 
create a territory for leads for a service application.

5. If you want to use an existing territory type to create this territory template, 
then use the LOV to enter it in the Type field. 

If you use a territory type, then you are restricted to using the qualifiers set up 
in the territory type. 

6. Select the Transaction Qualifiers tab.

a. Use the LOV to enter the qualifiers in Qualifier Type.

If you are using a territory type to create the territory template, then some of the 
Qualifier names are already prefilled.

b. Select either Static or Dynamic from the Qualifier Mode drop-down list for 
each qualifier.

c. Enter values for each transaction qualifier:

d. Select the qualifier in the Transaction Qualifiers region.

e. If the qualifier you have selected is a static qualifier, then enter the values.

f. If the qualifier is a dynamic qualifier, then enter the values or value sets, 
clicking Next Value Set between each entry or set of entries. 

g. If you do not want to add resource qualifiers for this template, then go 
directly to the Creating Mass Territories step.
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7. (Optional) Select the Resource Qualifiers tab.

a. Use the list of values (LOVs) to enter the qualifiers in the Name fields.

b. Select either Static or Dynamic from the Mode drop-down list for each 
qualifier.

c. Enter values for each resource qualifier:

* Select the qualifier.

* If the qualifier selected is a static qualifier, then enter the value(s).

* If the qualifier is a dynamic qualifier, then enter the value(s) or value 
set(s), clicking Next Value Set between each entry or set of entries.

8. Save your work.

Creating Mass Territories With a Template

Prerequisites
■ You must have created a template.

■ There must be a Territory Plan in place.

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The territory tree Navigator window opens.

2. Navigate to the chosen territory and double-click the territory.

The Territory Details window opens.

3. Open the Transaction Qualifier tab or the Resource Qualifier tab.

The chosen tab window opens.

4. Click Mass Create Territories.

The system creates territories with generated names in the form:

<template name> - GENERATED TERRITORY #<number>

For example, the territory template named "US Time Zones" generates three 
territories with the following names:
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US Time Zones - GENERATED TERRITORY #1 

US Time Zones - GENERATED TERRITORY #2 

US Time Zones - GENERATED TERRITORY #3 

See Also
Creating Geographical Territories Using a Template (Example)

Entering Static Qualifier Values for Templates
Use this procedure while creating territory templates to enter values for static 
qualifiers. Static qualifiers values exist in all the territories you are mass creating.

Prerequisites
Use this procedure as you create territory templates.

Steps
1. Open the Transaction Qualifier tab or the Resource Qualifier tab.

The chosen tab window opens.

2. Select the name of the qualifier at the top of the window.

The possible value type(s) appear below. 

For example, if you are entering values for the Name of Customer transaction 
qualifier, then you can enter one value: the name of the customer. 

If you are entering values for the Interest Type qualifier used in sales 
applications, then you can enter three values: for the interest type, for the 
primary and for the secondary interest. 

Resource Qualifiers can consist of static qualifiers.

3. Use the Operator list of values (LOVs) to select an operator.

The list of operators varies depending on the type of qualifier used. Some 
qualifiers, such as Name of Customer, allow only the "=" or "<>" operators.

4. Enter the values in the fields provided. Some operators allow a range of values 
to be entered; others only a single value. 

The number of fields and field names change depending on the qualifier.
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See Also
Creating territory templates

Entering Dynamic Qualifier Values for Templates
Perform the following steps while creating territory templates to enter values for 
dynamic qualifiers. Dynamic qualifiers have a different value in each territory 
created. 

Both transaction qualifiers and resource qualifiers are shown in the following steps.

Prerequisites
Use this procedure as you create territory templates.

Steps
1. Choose the Transaction Qualifier tab or the Resource Qualifier tab.

The selected tab window opens.

2. Choose the name of the qualifier at the top of the window.

For example, if you are entering Customer Name as the transaction qualifier, 
then you can enter only one value: the name of the customer. 

If you are entering values for the Language Type resource qualifier used in sales 
applications, then you can enter two values: English and French. 

3. Use the Operator list of values (LOVs) to select an operator.

The list of operators varies depending on the type of qualifier used. Some 
qualifiers, such as Name of Customer, allow only the "="  or "<>" operators.

4. Enter the value(s) in the fields provided. Some operators allow you to enter a 
range of values; others only a single value. 

The number of fields and field names change depending on the qualifier.

5. Click Next Value Set.

A new entry line opens.

6. Enter the next value or set of values in the same manner. 

7. Repeat this procedure for all the values for this qualifier.

Each time you click Next, the Value Set number increases by one.
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For example, if you want to enter all the states of the United States as values for 
the dynamic qualifier State, then:

a. Enter the first state in the Value field and click Next.

You can manually enter "1" in the Value Set field.

b. Enter the second state in the Value field and click Next.

You can manually enter "2" in the Value Set field.

c. Repeat the procedure for each of the remaining states.

8. When you have entered all of the values, complete the procedure for creating 
territory templates.

Creating Geographical Territories Using a Template (Example)
The following procedure is an example of using a template to create geographical 
territories using the following business scenario. The steps include:

■ Setting Up the Template

■ Setting Up Overview Information

■ Setting Up Transaction Qualifiers

■ Setting Up Resource Qualifiers

The Business Scenario
Suppose you want to create territories for telephone support and field service 
engineers for different city branches of two large customers: Vision Enterprises and 
Business World Inc. 

Also assume you want to ensure that the field service engineers are located in the 
same city as the branch they service. 

You want to create four territories for each city. For example:

■ Vision Enterprises: San Francisco with Manager Resource

■ Vision Enterprises: San Francisco Technician Support

■ Business World Inc.: San Francisco with Manager Resource

■ Business World Inc.: San Francisco Technician Support

Below are the steps required to create territories for this business scenario. 
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Setting Up the Template
1. Navigate to Administration >Territory Management >Mass Create Territories.

2. In the Overview tab, set up the basic information about the territory template.

3. In the Transaction Qualifiers tab, set up one dynamic transaction qualifier, 
Customer Name, and one static transaction qualifier City. 

4. In the Resource Qualifier tab, enter the qualifiers that are used to pick the 
resources who handle the transactions you set up in the Transaction Qualifier 
tab. 

* If you are setting up geographic territories and you want the resources 
to come from the same geographical area as the transactions, then you 
must set up a geographical structure for the resource qualifiers that is 
parallel to the one you set up for the transaction qualifiers.

* The one resource qualifier used in this example is: Job Title with values 
of manager and technician. 

a. Click Mass Create Territories.

The system creates territories with generated names in the form.

* Vision Enterprises/Business World by city: GENERATED TERRITORY 
#1

* Vision Enterprises/Business World by city: GENERATED TERRITORY 
#2

* Vision Enterprises/Business World by city: GENERATED TERRITORY 
#3

* Vision Enterprises/Business World by city: GENERATED TERRITORY 
#4

b. Open each generated territory and change the generated name to a 
recognized one.

5. In the Resources tab, click Auto Assign Resources.

The Qualifying Resources window displays a list of people that fit the resource 
qualifiers values you have entered. 

6. Select the people you want to assign to this territory by checking the Assign 
check box next to their name and click OK.

7. Check the Primary Contact check box next to the name of the primary contact 
for the territory. 
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8. For each resource add a Start and End Date to limit their participation.

9. Click Save from the menu.

Setting Up Overview Information
Perform the following steps to set up the template overview information:

1. In the Usage field, select from the list of values (LOVs) the type of application 
using this territory template. 

Your selection limits the types of qualifiers you can use in the territory template 
definition.

2. Enter a name and description for the territory template. 

For example, Vision Enterprises/Business World by city.

3. To limit the time the territory template is effective, enter the dates. 

By default the territory template becomes effective on the date created.

4. Choose from the LOVs in the Parent field.

5. Use the LOV to select one or more types of transactions that will be assigned to 
each territory. 

Available values depend on your territory usage.

Setting Up Transaction Qualifiers
Perform the following steps to set up transaction qualifiers.

1. Select the Transaction Qualifiers tab.

2. Use the list of values (LOVs) to enter the City and Customer Name qualifiers in 
the Qualifier Type fields.

3. From the Qualifier Mode drop-down list, select Static for City transaction 
qualifier.

4. Select "=" as the operator.

5. Enter the first city, San Francisco, as a value for the City qualifier.

6. Enter the Customer Name qualifier in the qualifier region.

7. Select Dynamic in the Mode field.

8. Select "=" as the operator.
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9. Enter the first of the two companies, Business World, as a value for the 
Customer Name qualifier.

10. Click Next Value Set.

The "1" shows up in the Value Set field or you can manually enter "1" in the 
Value Set field.

11. Enter Vision Enterprises as a value for Customer Name.

12. Repeat step 10 but change the number to "2".

Setting Up Resource Qualifiers
Perform the following steps to set up resource qualifiers:

1. Select the Resource Qualifiers tab and add the Job Title qualifier. 

2. From the Qualifier Mode drop-down list, select Dynamic for the Job Title 
qualifier.

3. Select "=" as the operator.

4. Select the list of values (LOVs) to choose the first of the two: 
Job Title and Manager.

5. Repeat step 10 of the Setting up Transaction Qualifiers.

6. Enter the second job title, Technician, following the same procedure.

7. Repeat step 12 of the Setting up Transaction Qualifiers but enter a value of "2."

Creating Customer Name Range Groups
The Customer Name Range Group allows you to create a new group, or modify or 
delete an existing group name. Deletion can only occur when it has not been 
associated with Customer Name Range transaction qualifier value.

Perform the following steps to create a new group.

Note: The Customer Name Range Group applies only to Sales 
and Telesales. It has a customer name range transaction qualifier 
associated with it which is of account type.
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Creating Mass Change Territory Resources
Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The Navigator window opens.

2. Select Define Customer Name Range Group from the Administration drop 
down menu.

The Define Customer Name Range Group window opens.

3. Enter your name and description in the appropriate fields 

4. Save and close the screen.

5. Either create a new Sales and Telesales Territory or open an existing one.

The Territory Details window opens.

6. Select the Transaction Qualifier Tab. 

■ In the Name field, select the LOV list. The Select Transaction Qualifiers 
window opens. Select Customer Name Range and click OK.

■ In the Operator field, the default is "=".

■ In the Group field, select your Customer Name Range group from the LOV.

■ In the Value From field, enter all applicable customer names.

7. Save your work.

Creating Mass Change Territory Resources
The Mass Change Territory Resources allows you to transfer territories which have 
been assigned to a particular resource to another resource.

An example of using this would be if salesperson A was leaving the company and 
wanted to transfer his territories to the incoming salesperson B.

Perform the following steps to make mass changes in Territory Resources.

Note: An Account Transaction Type must exist.
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Tips for Fine-tuning Territory Assignment Performance
Prerequisites
None

Steps
1. From CRM Administrator responsibility, select Territory Manager > Territory 

Administration.

The Navigator window opens.

2. Select Mass Change Territory Resources from the Administration drop down 
menu.

The Mass Change Territory Resource window opens.

3. In the Resource field in the Find Territories region, select from the LOV.

If the resource field is left blank and you click Find, then a list of all the 
territories that do not have any resources attached appears.

4. Click Find to find all territories assigned to that resource.

5. In the Operation region select either the Replace or Add button.

6. In the Scope region, select either the All or Selected button.

7. In the Resource field in the Assignee region, select the new resource from the 
LOV. Click OK. 

8. Select Update Territories to save.

Tips for Fine-tuning Territory Assignment Performance

Ranking Strategy
You can speed up processing time by ranking more frequently used territories 
higher than less frequently used territories.

Note: If you choose to select certain resources, hold down the 
control key on your keyboard as you use your mouse to select.

Note: Resources that have territories "replaced" will not be 
associated with these territories again.
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For example, if you have two sales organizations, one in Canada and one in the 
United States, and you know that some 80 percent of your customers are coming 
from the United States, then rank the US territory higher than the Canada territory. 
The application saves processing time as a result because it looks for a US territory 
before it looks for a Canadian territory.

You must use caution that your modifications do not result in erroneous 
assignments, however. 

Suppose you have two overlapping territories.

■ Territory A

Qualifier: Company Name Range = F%

■ Territory B

Qualifier: Company Name Range =Vision Enterprises%

If you rank territory A higher than territory B, then territory B never receives 
any assignments. All Vision accounts are assigned to territory A.

Comparison Operators
Avoid using "<>", NOT LIKE and NOT BETWEEN operators.

Troubleshooting
The following tips can be useful.

■ Set up territories in hierarchical fashion for easy maintenance.

■ Make the territories as generic as possible.

■ If you create a territory and do not assign resources to it, then the Territory 
Manager does not return this territory as a qualifying territory. 

■ You can create your own module specific "Catch All." 

Running Concurrent Programs
After defining territories using Territory Manager, run the Generate Territory 
Package concurrent program. This builds the Territory Assignment Engine. 

Note: The % symbol is a wild card.
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Running Concurrent Programs
After the concurrent program runs successfully, the Territory Manager module 
automatically assigns the most qualified individual to a transaction. 

Run this program every time a territory is added or changed.

Pre-Seeded Concurrent Programs

Name Function

Generate Territory Packages ■ Builds the API that returns the winning 
territories which are defined in territory setup.

■ Returns the winning territories and resources.

■ Creates search index for faster performance.
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Understanding Resource Manager

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. This section covers the 
following topics:

■ Resource Manager Overview

■ What are Resources?

■ Roles versus Role Types

■ Understanding Groups

■ Determining Group Hierarchy

■ Understanding Teams

■ What is a Salesperson?

■ Terms and Definitions

Resource Manager Overview
The Resource Manager provides lists of resources—as individuals, groups, and 
teams—for applications to access and manage their resources. Resources are 
defined as the employees, supplier contacts, parties and partners that are used by 
the different CRM components to accomplish business objectives. You can use 
Resource Manager to import and view resources, define resources, define roles and 
role types, create teams and groups, and organize resources within those teams and 
groups. Defining and organizing your resource information makes your resources 
available to the connected application modules for work action. Resources can be 
organized into groups and teams. Each group or team can be defined in one of two 
ways, a role or a role type.
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What are Resources?
What are Resources?
The following table describes all five resource categories used in the Resource 
Manager.

Roles versus Role Types
A role may encompass one or more job description and title. You assign seeded 
roles to resources, resource groups and resource teams. For example, the seeded 
roles for Sales include Manager, Administrator, Approver, and Representative. The 
seeded roles for Telesales include Manager, Administrator, and Agent. You can 
define custom roles for your business needs.

A role type is a collection of roles associated with a particular CRM module. For 
example, Sales, Telesales, Marketing, Sales Compensation, Support, Call Center are 
all role types. Role types are seeded by the different modules that access the 
Resource Manager. You can define custom role types for your business needs.

Resource Category Descriptions

Resource Description

Employee An employee is a person who has been hired to work for a 
company. Employee resources can be imported as resources 
from the Human Resources Management System (HRMS). 

Supplier Contact A supplier contact is the contact information for a person or 
agency that sells raw material or goods. Supplier resources can 
be imported as resources from the Purchasing (PO) application. 

Party A party is an entity that can enter into a business relationship. 
A Party resource can be imported as resources from Accounts 
Receivables. 

Partner A partner is one of two or more persons who contribute capital 
to establish or maintain a commercial venture and who usually 
share in the risks and profits. A Partner resource can be 
imported as resources from Accounts Receivables. 

Other/TBH This is the only resource that is created and not imported. Use 
this resource to create a salesperson that is going to be hired 
(TBH) but is not yet an employee.
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Understanding Groups

Resource Groups
A group is based on the similar functionality or the roles of its members. It can 
consist of individual resources and groups. For example, Linda’s group includes 
individual resources, John, Mark, and Carol, as well as another resource group, 
Mary’s group.

A resource can belong to multiple groups. For example, Mary reports to Linda as a 
west regional sales manager. She has three sales representatives directly working for 
her. Since Mary is an invaluable resource, she can be assigned to a new product 
development group to provide market feedback. 

Group Member Roles 
Roles and responsibilities can be associated with all members of a resource group. 
For example, a sales group has one sales manager and a few sales representatives. 
The sales manager and the sales representative are job roles assigned to the group 
members. 

Each member can have multiple roles defined within a group. For example, Mid 
West Sales Group consists of only two people due to resource constraints, one of 
them plays two roles, sales manager and field sales agent, at the same time.

Group Roles
Multiple roles can be assigned to a resource group. For example, Group A has three 
resources (An employee, a Party, and a Partner). Those three resources play a role in 
Group A, even if they have different roles assigned to them individually. The Party 
can have an individual Team role but the role it plays in group A is Manager role.

Determining Group Hierarchy
Individual resources can be assigned to a group, and a group can belong to another 
group or to multiple groups. Resources therefore can be organized through a group 
hierarchy with a parent-child relationship.

For example, Jack William and Frank Nelson are sales representatives who belong 
to the Product A group and directly report to Pat Smith, the Sales Manager of 
Product A. However, Jack and Frank indirectly report to Jeff Walsh who leads the 
Field Sales Group as Field Sales Manager. The Field Sales Group and the Product A 
group have a parent-child relationship. You can use the group hierarchy to view 
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direct reporting or all reporting information for a resource. Refer to the Viewing 
Group Hierarchy section of this manual for more detailed information.

Understanding Teams

Resource Teams
A team is a collection of cross-functional resources. Team members are chosen for 
their availability and qualifications. You define a team to organize the necessary 
resources to accomplish an objective or a particular task. It consists of groups and 
individual resources that work together to efficiently complete a project. A resource 
can belong to multiple resource teams. For example, a solution team can have 
support and sales groups as well as a telesales agent, an individual resource. 

Team Member Roles
Each team member, whether it is an individual resource or a resource group can 
have multiple roles assigned to a team. For example, a team member can have both 
Sales Manager and Sales Representative roles due to resource constraints in a team.

Team Roles
You can assign multiple roles to a team. For example, a solution team plays a 
support manager role, and a sales approver role at the same time while sales 
demand is strong.

What is a Salesperson?
A salesperson is any person involved in the sale or support of products and 
services. Salespeople are typically field personnel, but can also be support teams 
and other product specialists involved either directly or indirectly in generating 
revenue for the organization. 

Depending on their relationship to the sales organization, salespeople may be 
internal employees or external people or organizations. Employees, Parties, 
Partners, and Supplier Contacts can all become salespeople by having sales 
numbers and relevant information assigned to them after being imported to the 
Resource Manager. However, these imported resources will always carry their 
original resource categories of Employee, Party, Partner, or Supplier Contact. These 
resource categories will never change. 

For example, your company partners with Vision Enterprises to promote certain 
products. Vision Enterprises can be imported as category “Partner” from Accounts 
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Receivables and be given a sales number and relevant information, thus Vision 
Enterprises becomes a salesperson and can be assigned to your group or team, still 
with the same category “Partner”, for marketing campaign or opportunities.

In addition to imported resources, the only resources you can create, and not 
import, is a salesperson with resource category of OTHER, or TBH.

Terms and Definitions
The following table describes terms and definitions associated with the Resource 
Manager.

Resource Manager Terms and Definitions

Term Description

Resource Manager A single place for defining, accessing, and maintaining all 
CRM and ERP Resources.

Workflow Oracle Workflow lets you automate and continuously improve 
business processes, routing information of any type according 
to business rules you can change. Oracle Workflow manages 
business processes according to rules that you define. The 
rules, which we call a workflow process definition, include 
the activities that occur in the process and the 
relationship between those activities. An activity in a 
process definition can be an automated function defined 
by a PL/SQL stored procedure or an external function, a 
notification to a user or role that may optionally request 
a response, a business event, or a sub flow that itself is 
made up of a more granular set of activities.

Employee An employee is a person who has been hired to work for a 
company. Employee resources can be imported as resources 
from the Human Resources Management System (HRMS). 

Supplier Contact A supplier contact is the contact information for a person or 
agency that sells raw material or goods. Supplier resources can 
be imported as resources from the Purchasing (PO) application. 

Party A party is an entity that can enter into a business relationship. 
A Party resource can be imported as resources from Accounts 
Receivables. 

Partner A partner is one of two or more persons who contribute capital 
to establish or maintain a commercial venture and who usually 
share in the risks and profits. A Partner resource can be 
imported as resources from Accounts Receivables. 
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Terms and Definitions
Other/TBH This is the only resource that is created and not imported. Use 
this resource to create a salesperson that is going to be hired 
(TBH) but is not yet an employee.

Resource Manager Terms and Definitions

Term Description
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Using Resource Manager

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. This section covers the following 
topics:

■ Getting Started

■ Importing Resources

■ Finding a Resource

■ Viewing a Resource From the List

■ Defining a Salesperson

■ Defining Resource Groups

■ Defining Resource Teams

■ Viewing Group Hierarchy

■ Running an Audit Report

■ Viewing an Audit Report

■ Running a Group Structure Report

■ Viewing a Group Structure Report

Getting Started
Typically, procedures are performed in the following order:

1. Select Import Resources from the navigator to import employees, parties, 
partners, and supplier contacts.
Using Resource Manager 61



Importing Resources
2. Select Resources from the navigator to assign role, group, and team information 
to resources and to define a salesperson (Other/TBH).

3. Select Groups from the navigator to define a group, assign resources to the 
group, and specify parent-child group relationships.

4. Select Teams from the navigator to define a team and assign resources to the 
team.

5. Select Dynamic Groups from the navigator to define a group based on criteria 
specified in SQL statements.

6. Select Group Hierarchy from the navigator to view resources reporting 
information.

Importing Resources    
The Resource Manager allows the user to import a resource into Resource Manager 
from different application databases depending on the resource category you select. 
After selecting a resource based on its category, identify its role and eligibility dates 
before saving it to Resource Manager. 

Employees, Parties, Partners, and Supplier Contacts can be imported into the 
Resource Manager from HRMS, Purchasing and Accounts Receivables, depending 
on the resource category you select. The only resources you can create, but not 
import through the Resource window, is the salesperson with the resource category 
of OTHER, or TBH (to be hired). Perform the following steps to import a resource.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Maintain Resources > Import Resources.

The Selection Criterion window opens.

2. Select from the list of values (LOV) in the Resource Category field. 

3. (Optional) Refine your resource search by selecting from the LOV in the 
available fields.

Different resource categories have different search field options.

4. Click Search.
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Finding a Resource
The application populates the Category and Name fields in the Search Results 
region.

5. Choose a resource by deselecting the Select check boxes for the undesired 
resources and click Create Resource.

The Default Values window opens, and the application populates the Start Date 
field with the current date.

6. (Optional) Select an end date, managing employee, role, and role effective 
dates.

7. Click OK.

The Selected Resources window opens displaying the resource selections.

8. Deselect the undesired resource check boxes and click Save Resource if you 
want to save a resource to Resource Manager.

Resource importation and definition is complete.

9. If you want to further define the resource roles, groups, teams, or other details 
use this procedure.

a. Click Details.

The Resource window opens.

b. Define the resource information from the tab options.

c. Choose File > Save.

Guidelines
The Comments field in the Selected Resources window indicates whether the 
resource entry is a new record, duplicate record, or has a new role definition.

Finding a Resource
Use the Find Resources window to perform the following actions:

■ Defining a search criteria to find one or more resource summaries

■ Defining a salesperson

Prerequisites
Create or Import a Resource
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Viewing a Resource From the List
Steps
You can search for a resource on any single or combination of fields. Perform the 
following steps to find one or more resource summaries.

1. In the CRM Administrator responsibility, navigate to Resource Manager > 
Maintain Resources > Resources.

The Find Resources window opens.

2. Choose one or more parameters upon which to search. 

Typical search parameters are:

■ Number

■ Category

■ Transaction Number

■ Name

3. Enter the required dates for the resource in the Start Date and End Date fields.

4. Click Find.

The Resource Search Results window opens.

Viewing a Resource From the List
Use the Resource Search Results window to select a resource for detailed viewing. 

Prerequisites
Perform a resource search before you can view the summary results.

Steps
1. Select the desired resource from the Resources list.

2. Click Resource Details.

The Resource window opens. From this window, you can view or update 
existing resource information.
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Defining a Salesperson
Defining a Salesperson 
You designate a resource as a salesperson in the Receivables tab. A resource 
designated as a salesperson in this manner is organization specific, although in 
general, resources are not.

The following table describes the types of tasks that you can perform in the 
Resource window.
.

Prerequisites
None

Steps
Perform the following steps to create a salesperson.

1. Click New in the Find Resource window.

The Resource window opens.

2. Select either TBH or Other for the Category.

3. Enter a valid value for the Salesperson Number.

4. Enter the new salespersons name in the Name field.

5. Enter a Start Date for the new salesperson.

Note: You can only create a resource of category Other, or TBH (to 
be hired), through the Resource window. If your resource is of 
another category, it must be imported.

If a salesperson is defined with category TBH, then this salesperson 
is not visible within Accounts Receivable. A Salesperson defined in 
this manner can be viewed only within CRM.

Tasks Available through the Resource Window

Task Performing the Task

Create (define) a new salesperson of 
type Other or TBH

Use the steps following

Update a resource definition Modify the resource definition as desired.

View resource details View the resource details as desired.
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Defining a Salesperson
You must enter at least a start date here. The end date defaults to an open end 
data and is optional.

6. Select the Receivables tab.

For an explanation of each tab, see the Guideline following.

7. Enter the range of dates that this salesperson is to be active. 

The Date Active (start date) is a required field and defaults as the current date. 
However, you can change it by accessing the calendar through the list of values 
(LOV). If you do not enter a Date Active (end date), this salesperson is active 
indefinitely. The Date Active cannot precede the Start Date.

If the salesperson’s status is Active but the transaction date that you enter is not 
within this date range, Receivables does not display this salesperson in the LOV 
in the Transactions window. 

8. (Optional) Enter the new salespersons E-mail address.

9. (Optional) Enter a Geo Override value for this salesperson. This value 
associates the salesperson with a unique tax jurisdiction.

The Geo Override and Inside City Limits fields are available only if you have 
installed a sales tax vendor of type Taxware Sales/Use Tax System  or Vertex 
Quantum .

If you entered a value in the Geo Override field and the tax jurisdiction for this 
address is within city limits, select the Inside City Limits check box. This check 
box is enabled only if your sales tax vendor is Vertex Quantum.

For additional information, see the following: 

■ Integrating Oracle Receivables with Taxware Sales/Use Tax System, Release 11i.

■ Integrating Oracle Receivables with Vertex Quantum, Release 11i.

10. Check the Active for Receivables check box to indicate that this resource is a 
salesperson. 

11. Enter a quota Sales Credit Type. 

Oracle Order Management uses this information to determine if the sales credit 
for an order is a quota or non-quota amount. You can define additional sales 
credit types in Oracle Order Management. However, you can only assign Sales 
Credit Types that are of type ’Quota’ to salespersons in Receivables.
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Defining a Salesperson
12. (Optional) Enter the Accounting Flexfield for your Revenue, Freight, and 
Receivable Accounts.

Receivables can use this information, along with your AutoAccounting rules, to 
determine the revenue, freight, and receivable accounts for invoices you assign 
to this salesperson. 

13. (Optional) Assign a territory to this salesperson. 

The Territory Flexfield must be set up before an assignment is made. 

14. (Optional) If you assigned a territory to this salesperson, then enter the range of 
dates that this territory is to be assigned to this salesperson.

The Start Date defaults as the current date, but you can change it. If you do not 
enter an End Date, this salesperson will be active indefinitely, or as long as the 
territory is active.

15. (Optional) Enter more information in the other tabs to further specify the 
resource.

16. Choose File > Save to save your work. 

This action populates the Resource Number field with the automatically 
generated resource tracking number.

Guidelines
The following table describes tabs which appear in the Resource window.

Resource Tab Descriptions

Tab Description

Roles Use this tab to view, assign, and modify information about roles and role types. The role 
type is the actual role a resource plays, for example, Administrator or Contractor. These 
roles, role types, and role attributes check boxes are defined in the Setup screen. The 
Start Date default is the current date, and it can be modified.

Groups Use this tab to view, assign, and modify information about groups. Groups are not 
necessarily one person, and a resource can belong to more than one group. The Groups 
tab reveals in detail which groups the resource belongs to, and the role in the group. 
Resources can play multiple roles in a group. Click the group name to display the group 
member roles if this resource has group member roles assigned. 

See Defining Resource Groups for details.
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Defining a Salesperson
The following table describes fields which appear in the Receivables tab, in the 
Resource window, which are used to define a salesperson.

Teams Use this tab to view, assign, and modify information about teams. Teams can comprise 
multiple groups and combinations of groups and individuals. Click the team name to 
view the Team Member Roles. 

See Defining Resource Teams for details.

Service Use this tab to define the Cost per Hour and Time Zone information. The Support Site 
field is not operational, and not used at this time. You define the currency type in the 
Compensation tab.

Interaction Center Use this tab to view, assign, and modify the e-mail addresses and the Agent ID numbers 
of resources associated with the eMail Center or Call Center modules. This tab is used 
primarily by the Call Center and eMail Center modules. All fields are read-only. If the 
resource is not associated with either center, these fields are blank. 

(Optional) Enter the Scripting Agent Login if the employee uses Oracle Scripting. Use 
the Telephony Parameters region to enter middle ware configuration, parameters, and 
values for the agent. Which telephony parameters are required and which values to 
specify depend on the types of switch and CTI middle ware used in the Call Center.

Compensation Use this tab to view or define the Currency Type corresponding to the Cost per Hour 
listed on the Service tab. 

Receivables Use this tab to define a salesperson. 

Miscellaneous Use this tab to view personal information about the resource. The fields in this tab are 
read-only.

Field Descriptions for the Receivables tab in the Resource Window

Field Description

Date Active In this field you should enter the range of dates that this 
salesperson is to be active. Date Active (start date) is a required 
field, the Date Active (end date) is optional. If you do not enter 
an end date, this salesperson is active indefinitely.

Geo Override and Inside 
City Limits

The Geo Override value associates the salesperson with a 
unique tax jurisdiction. Both fields are available only if you 
have installed a sales tax vendor of type Taxware Sales. Oracle 
recommends you use Tax System or Vertex Quantu.

Resource Tab Descriptions

Tab Description
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Defining Resource Groups
Sometimes a resource is not just one person. Dividing these single resources into 
groups can strengthen their skills and save time when allocating resources to a job. 
A group of people and a resource can belong to more than one group. Choose to 
search for an existing group or create a new group; then define the group’s 
members, roles, usages, and relations. Perform the following steps to define a 
resource group.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Maintain Resources > Groups.

The Define Groups window opens.

2. (Optional) To find an existing resource group, then use this procedure.

a. On the application tool bar, click View > Find.

The Find Group window opens.

b. Select a group name from the list of values (LOV) in the Group Name field 
and click Find.

The application populates the Results region with the group name search 
results.

Accounting Flexfield The accounting flexfield includes Revenue, Freight, and 
Receivable Accounts. Receivables can use this information, 
along with your AutoAccounting rules, to determine the 
revenue, freight, and receivable accounts for invoices that you 
assign to this salesperson.

Territory Flexfield If you want to assign a territory to this salesperson, then in this 
field you should enter the range of dates that this territory is to 
be assigned to this salesperson. The Start Date defaults as the 
current date, but you can change it. If you do not enter an End 
Date, this territory is active for this salesperson infinitely.

Field Descriptions for the Receivables tab in the Resource Window

Field Description
Using Resource Manager 69



Defining Resource Groups
c. Select a group name in the Results table and click OK.

The application populates the Define Groups window with the group 
information.

3. If you want to create a new group, then use this procedure.

a. Enter a group name in the Name field.

b. Enter a brief description of the group in the Description field.

c. Enter the effective dates for the team in the Start and End fields.

4. (Optional) Select the Exclusive Flag check box to assign resources to this group 
with a particular member role and usage that is not assigned to any other 
exclusive group with the same member role and usage, in the same time frame.

5. In the Members tab, select a resource category and member number from the 
LOV in the Category and Number fields.

The application populates the Name field with the member’s name and 
affiliated organization.

6. (Optional) Select a member name and click one of the available buttons.

For a detailed description of the group member button options, see the 
Resource Group Member Buttons table in the Guidelines section.

7. In the Roles tab, select a role type and role name from the LOV in the Role Type 
and Role fields.

The roles relationship to its category is indicated by the role attributes check 
box selections.

8. In the Usages tab, select one or more usage descriptions from the LOV in the 
Usage field.

9. Choose File > Save.

10. Select either the Parent Group or Child Group tab depending on the relation 
type.

11. Select a group number from the LOV in the Group Number field of the selected 
tab.

The application populates the Group Name field of the Parent Group or Child 
Group tab.

12. Select effective dates for the relation from the LOV in the Start and End Date 
fields.
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Defining Resource Groups
13. Choose File > Save to save the group definition.

The new group is accessible from the Group tab in the Resource window.

Guidelines
The following table describes buttons which appear on the Resource Group 
Member window.

The following table describes tabs which appear on the Define Group window.

See Also
Defining Resource Teams

Note: If the reporting hierarchy needs to be changed, it is better to 
delete a group member role rather than end dating it.

Resource Group Member Buttons

Button Action

Member Details This button opens the main Resource window and record of 
the member.

Move Member This button opens the Move Member window, where you can 
assign the member to another group.

Member Roles This button opens the Member Roles window, where you can 
define the member role type, name, and effective dates.

Define Group Tab Descriptions

Tab Description

Members Use this tab to define the member category and member 
number of the group.You can also view a members details, 
assign the member to another group, and view a members role 
type in this tab.

Roles Use this tab to define roles and role types for the group.

Usages Use this tab to determine what CRM modules will use the 
group.

Parent Group Use this tab to define a group as a parent group. 

Child Group Use this tab to define a group as a child group. 
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Defining Resource Teams
Resource groups provide candidates for teams or an individual resource. Team 
members represent a resource group, and are chosen for their availability and 
qualifications. Teams consist of people that work together to efficiently complete a 
project. Perform the following steps to define a team.

Prerequisites
Define a resource group

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Maintain Resources > Teams.

The Define Teams window opens.

2. (Optional) To find an existing resource team, then use this procedure.

a. On the application tool bar, click View > Find.

The Find Team window opens.

b. Select a team name from the list of values (LOV) in the Name field and click 
Find.

The application populates the Results region with the team name search 
results.

c. Select a team name in the Results table and click OK.

The application populates the Define Teams window with the group 
information.

3. Enter a team name in the Name field.

4. (Optional) Select the Exclusive Flag check box to assign resources to this team 
with a particular member role and team usage that is not assigned to any other 
exclusive team with the same role and usage, in the same time frame.

5. Enter a brief description of the team in the Description field.

6. Enter the effective dates for the team in the Start and End fields.

7. In the Members tab, select a category and member from the LOV in Category, 
and Number fields. For a detailed description of the group member button 
options, see the Resource Group Member Buttons table in the Guidelines 
section.
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Viewing Group Hierarchy
The application populates the Name field with the member’s name.

8. (Optional) Click Member Roles to assign team member roles to a team.

9. (Optional) Select a member name and click Member Details to view specific 
member information.

10. In the Roles tab, select from the LOV in the Role Type and Role fields.

The roles relationship to its category is indicated by the role attributes check 
box selections.

11. In the Usages tab, select from the LOV in the Name field.

12. Choose File > Save to save the team definition.

The new team is accessible from the Team tab in the Resource window.

Guidelines
The following table describes tabs which appear in the Define Team window.

See Also
Defining Resource Groups

Viewing Group Hierarchy
Use group hierarchy to view both the subordinates and a direct manager for a 
specific resource. For example, you can view only those resources that report 
directly, or you can view all resources that report to a particular person. This feature 
does not identify who the manager is and who the subordinates are for this 
resource. You can restrict your view by resource category. Perform the following 
steps to view the hierarchy of a group.

Define Team Tab Descriptions

Tab Description

Members Use this tab to define members of a team.

Roles Use this tab to define the team roles and role types. 

Usages Use this tab to determine what CRM modules will use the 
team.
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Running an Audit Report
Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Maintain Resources > Group Hierarchy.

The Group Hierarchy window opens.

2. Select a resource from the list of values (LOV) in the Name field and click View 
to view the groups of a particular resource member.

The application populates the Groups region with the member’s groups and 
effective enrollment dates.

3. Select a resource category from the Category LOV and click View to view the 
groups and members of a resource category.

The application populates the Groups and Members regions with the group and 
member names and effective enrollment dates.

4. Select All from the Category LOV and click View if you want to view all the 
resource groups and members in the database.

The application populates the Groups and Members regions with all the groups 
and their members and their effective enrollment dates.

Guidelines
Selecting Reports Directly from the LOV in the View By field searches the database 
for members that report directly to a specific resource.

See Also
Defining Resource Teams

Defining Resource Groups

Importing Resources

Running an Audit Report
Resource Manager supports the ability to run an audit report detailing changes to 
resources and resource groups created with a defined date. For example, any 
changes made to new members of a group will display, but role change information 
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Running an Audit Report
is not. This will provide an audit trail of the actions taken for specific groups, and 
resources. Perform the following steps to run an Audit report.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Others > Requests > Run.

The Submit a New Request window opens.

2. Select the Single Request radio button and click OK.

The Submit Request window open.

3. Use the Name list of values (LOV) to select a report.

The Reports window opens.

4. Select Group Audit Report from the list of reports and click OK.

The Parameter window opens.

5. Enter parameters for the report. 

In order for an Audit Report to run successfully, it is necessary to define both 
Report Based On and Date Range/No. of Days for the report. The report runs 
based on the information you enter for the following criteria.

a. Report Based On

b. Group

c. Resource

d. Updated By

e. Date Range/No. of Days

f. Start Date

g. End Date

Note: Only the movement of a resource from a given group to 
another group will be tracked. Resources changing roles within the 
same group are not reported in the Audit Report.
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Viewing an Audit Report
h. Number of Days for

6. (Optional) Change the time frame the report will run by clicking Schedule.

The Schedule window opens.

7. Select when you want the report to run:

■ As soon as possible

■ Once

■ Periodically

■ On specific days

8. Click OK.

9. (Optional) Click Options to determine who should be notified when the report 
is complete and where you want to print the output to.

10. Click Submit.

11. A dialog opens confirming your request was submitted.

Viewing an Audit Report
A user can monitor the status of an audit report to see when it has been completed, 
and if it completed successfully. Perform the following steps to view an Audit 
report.

Prerequisites
Run a Group Audit Report successfully

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Others > Requests > View.

The Find Requests window opens.

2. Select the All My Requests radio button.

3. Click Find.

The Requests window opens.

4. Select a Group Audit Report to view.

5. Click View Log to display the results of the report. 
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Running a Group Structure Report
The report details will open in an HTML window along with a log file for the 
report.

Running a Group Structure Report
Resource Manager supports the ability to run a Group Structure report detailing 
any changes made to a specific the Parent or Child relationship of a resource group. 
This ability provides users with a reliable audit trail of the actions taken for a 
specific group. Group name changes, or any resource changes within the same 
group, will not be reported in this report. Perform the following steps to run a 
Group Structure report.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Others > Requests > Run.

The Submit a New Request window opens.

2. Select the Single Request radio button and click OK.

The Submit Request window open.

3. Use the Name list of values (LOV) to select a report.

The Reports window opens.

4. Select Group Structure Report from the list of reports and click OK.

The Parameter window opens.

5. Select the group you want to run the report on from the list of values (LOV) and 
click OK.

6. (Optional) Change the time frame the report will run by clicking Schedule.

The Schedule window opens.

7. Select when you want the report to run:

■ As soon as possible

■ Once

■ Periodically
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■ On specific days

8. Click OK.

9. (Optional) Click Options to determine who should be notified when the report 
is complete and where you want to print the output.

10. Click Submit.

A dialog opens confirming your request was submitted.

Viewing a Group Structure Report
A user can monitor the status of an audit report to see when it has been completed, 
and if it completed successfully. Perform the following steps to view your Group 
Structure report.

Prerequisites
You must first run a Group Structure Report successfully

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Others > Requests > View.

The Find Requests window opens.

2. Select the All My Requests radio button.

3. Click Find.

The Requests window opens.

4. Select the Group Structure Report.

5. Click View Log to display the results of the report. 

The report details will open in an HTML window along with a log file for the 
report.
78 Oracle CRM Application Foundation Concepts and Procedures



Administering Resource Manager

This topic group provides task-based procedures required for ongoing system 
maintenance and includes information on administration tools and utilities. This 
section covers the following topics:

■ Running Concurrent Programs

■ Managing a Party Merge

Running Concurrent Programs
Oracle recommends that the system administrator regularly run the concurrent 
programs, listed in the following table, on a regular basis, to synchronize data 
between the Resource Manager and following applications and maintain data 
integrity.

Resource Manager Concurrent Programs

Name Parameters Oracle Applications

Synchronize Employees No: Synchronize only the employees that currently 
exist in Resource Manager.

Yes: Synchronize all the employees that currently exist 
in Resource Manager plus all new active employees in 
Human Resources that have not been imported yet.

Human Resources

Synchronize Group Denorm None N/A

Synchronize Party and Partners None Accounts Receivable

Synchronize Supplier Contacts None Purchasing
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Managing a Party Merge
Resource Manager supports the ability to register entities that reference parties in 
order to support party merges. This functionality supports the basic requirement to 
merge one party into another when duplicate parties have been identified. Each 
team must subscribe to the Trading Community Architecture (TCA) engine in order 
to utilize the party merge functionality. 

The Party Merge functionality within the TCA is specifically designed to eliminate 
duplicate data in the Registry layer in order to keep the database accurate. Party 
information now can be merged to provide a consolidated view.

Resource Manager’s registration of the entities that reference parties and defining 
the merge procedure allows the users to utilize the merge functionality. A batch 
program runs to determine the duplicate party records and merge them 
accordingly.

Note: It is strongly recommended that an employee or party or 
supplier contact not have more than one entry in FND_USERS. If 
an employee linked to two or more FND_USERS is imported into 
Resource Manager, then the USER_ID column in JTF_RS_
RESOURCE_EXTNS table randomly picks a value from FND_
USERS for that employee.
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Using Notes

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. This section covers the following 
topics:

■ Creating Notes

■ Finding Notes

Creating Notes
A note records descriptive information that has been generated by users about 
business transactions so that it may be referenced. You can use the Notes 
component from different applications in the product suite to access the comment 
log that relates to a specific transaction. Use this procedure to create a note.

Prerequisites
None

Steps
1. On the application menu bar, click Tools and select Notes.

The Notes window opens.

2. On the Notes toolbar, click New.

The application populates the source, owner, and date fields.

3. Enter the note information in the Notes field.

4. Optionally, click More to enter a note in the Detailed Notes window.

The Detailed Notes window holds textual notes up to 32 K in size.
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Finding Notes
5. Select note type and status from the LOV for each field.

6. Select from the LOV in the Related To field.

7. Enter a value in the Value field.

Define the information you enter in the Related To and Value fields according to 
the relationship between the note and business transaction. Use the Related To 
field to identify the source type for the note information and the Value field to 
specify the source name or number.

8. Save your note.

Note creation is complete.

Guidelines
View the note log in spread table format via the Notes tab and text format via the 
Summary tab. Clicking Latest First in the Summary tab organizes the note history 
so that the most recent note appears at the top of the summary.

See Also
Finding Notes

Finding Notes
Find notes by performing a search for source number, owner, date, or note type. Use 
this procedure to find an existing note.

Prerequisites
None

Steps
1. On the application menu bar, click Tools and select Notes.

The Notes window opens.

2. On the application toolbar, click Find.

The Find Notes window opens.

3. Select source and number from the LOV for each field and click Search.

The application populates the main note window with the note information.

4. Optionally, search for notes by owner, date, or note type.
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Finding Notes
Use this procedure to search for notes without a source value.

a. Enter owner, date, or note type and click Search.

The application populates the Notes tab in the Notes window with the 
possible matches.

b. Click to select your note and scroll right for additional information.

The note search process is complete.

Guidelines
Further refine your note search by entering Related To information in the Find 
Notes window. Selecting a match option also helps you focus your search.

See Also
Creating Notes
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Understanding Calendar

This topic group provides overviews of the Calendar application and its 
components, as well as explanations of key concepts, features, and functions. This 
section covers the following topics:

■ Calendar Overview

■ Calendar Setup

■ Calendar Datebook

Calendar Overview
Calendar is a scheduling tool used to define and view available and non-available 
time for a resource or group of resources. You can create a calendar for yourself or 
another resource, associate work shifts with calendars, and assign a resource to a 
shift depending on availability. There are two types of Calendar screens: Calendar 
Setup and Calendar Datebook.

Calendar Setup
Use the Calendar Setup screens to set up shifts, define available and non available 
time for a resource, and define a calendar for a resource.

Calendar Datebook
Use the Calendar Datebook to view time availability for yourself, a resource, or a 
group of resources. You can also create a private Todo List or access the Tasks screen 
to edit a task for a resource. If you want to change availability times or a work shift, 
you must use the Calendar Setup screens.
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Calendar Setup
Calendar Setup
Use Calendar Setup to create time periods in a calendar datebook for yourself or a 
resource. Calendar Setup uses shifts and patterns to define time availability and 
accommodate the most complex situation for a resource. You can set up everything 
you need to create pertinent information in your datebook. 

What is Available Time?
Available time is defined using shifts and patterns. 

What is a Shift?
A shift defines when a person is available to work. Using the simplest example, a 
shift can be created that defines the default working week Monday to Friday 8:30 to 
17:00.   

What is a Shift Pattern?
A set of shifts can be set into a pattern. 

For example:

Shift A, named Field Support, starts at 8:00 and lasts 9 hours. 

Shift B, named Stand By, starts at 20:00 and lasts 12 hours. 

On days 1 to 4, the resource can be assigned shift A, and then days 6 and 7 shift 
B, and day 5 can be free. 

What Is Non-available TIme?
Non-available time is a defined block of time when a resource is not available to 
accept a task. 

Non available time can be a number of entries:

■ A personal entry

■ An entry or task sent by another resource.

■ A group appointment or entry created by the resource or another resource.

■ Public holidays

■ Meetings

■ Personal vacation

■ Illness
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Calendar Datebook
■ Personal or work appointment.

Calendar Datebook
In your Datebook you can view:

■ Working hours 

■ Assigned tasks 

■ Personal appointments 

■ Official holidays and vacation days. 

In addition, you can:

■ Create a To Do list for the day, week, or month. 

■ Access the Tasks application to edit a task. 
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Calendar Datebook
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Using Calendar

This topic group provides process-oriented, task-based procedures for using the 
Calendar Setup screens and the Calendar Datebook. This section covers the 
following topics:

■ Defining Availability

■ Defining Non-Availability (Exceptions)

■ Defining a Calendar

■ Using the Assign Shift/Exceptions Window

■ Assigning a Calendar to a Shift

■ Assigning a Calendar to an Exception

■ Assigning a Resource to a Calendar

■ Creating Tasks and ToDos in a Calendar

■ Viewing a Datebook

■ Creating a ToDo List

Defining Availability
Defining availability means defining your working hours. A shift is the time a 
resource is available, and a shift pattern is the shift that extends for a longer period 
of time. Use this procedure to define shifts and shift patterns. For more information 
see Calendar Setup.

Prerequisites
None
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Defining Non-Availability (Exceptions)
Steps
1. Navigate to the Define Shifts screen.

2. In the Name field, create a name for your shift. You will be attaching this 
specific shift to your calendar later. 

3. In the Description field, enter a description of the shift.

4. In the Effective Dates area, enter the Start and End Dates.

5. In the Shift Pattern area, define recurrent days off, such as Saturday and 
Sunday. 

The time on the days off should range from 00:00 - 00:00.

6. In the Shift Pattern area, select the day of the week from the LOV.

7. Enter the times you are available for the selected work day.

8. In the Availability Type field, select the availability type from the LOV. You can 
manually enter a type if the list doesn’t provide you with an appropriate type. 

9. In the Effective Dates area, enter the Start Date. 

The field is automatically populated with today’s date. 

10. In the To field, select the LOV to view a calendar. 

11. Save your work. Your shift pattern is saved to the database. 

Defining Non-Availability (Exceptions)
When you are setting up your calendar you must define not only your working 
hours, but also the times when you are not available for work, such as federal 
holidays, vacation, or sick days. These days are exceptions to your regular working 
shift. Use this procedure to define non-availability. 

Prerequisites
None

Steps
1. Navigate to the Exceptions screen.

2. In the Name field, create a name for your non-available work time. 

3. In the Category field, select a category from the LOV. A category is a predefined 
type of exception. 
90 Oracle CRM Application Foundation Concepts and Procedures



Assigning a Calendar to a Shift
4. In the Description field, enter a description of your exception.

5. Click Save. Your exception information is saved to the database.

Defining the Calendar
In order for your shifts and times to appear in the Datebook, you must create a 
calendar. Once your calendar is defined, then you can link your shifts and times to 
it. Use the procedure to define a calendar. 

Prerequisites
None

Steps

1. Navigate to the Define Calendar screen.

2. In the Name field, select the calendar name form the LOV. 

3. In the Type field, select the type of calendar you want to create from the LOV. 

4. In the Description field, enter a description of the calendar type. 

5. In the Effective Dates fields, enter the time period for the calendar. 

Using the Assign Shift/Exceptions Window
You can use the Assign Shift/Exceptions window to:

■ Assign a Calendar to a Shift

■ Assign a Calendar to an Exception

Assigning a Calendar to a Shift
Use this procedure to assign shift patterns that have already been defined to a 
specific calendar. The shifts and patterns are then displayed in your datebook.

Prerequisites
You must first define your availability and non-availability (shift patterns). 

Steps
1. Navigate to Assign Shift/Exceptions.
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Assigning a Calendar to an Exception
2. Select the Shifts tab.

3. In the Calendar Name field, enter a calendar name. 

4. Enter the calendar description.

5. Enter the effective dates.

6. In the Shifts field, select your already defined shift from the LOV.

See also
Defining Non-availability (Exceptions)

Defining Availability

Assigning a Calendar to an Exception
Use this procedure to assign exceptions that have already been defined to a specific 
calendar. These exceptions are then displayed in your datebook.

Prerequisites
You must first define your availability and non-availability (shift patterns). 

Steps
1. Navigate to Assign Shift/Exceptions.

2. Select the Exceptions tab.

3. In the Calendar Name field, select a calendar name from the LOV. 

4. Enter the calendar description.

5. Enter the effective dates.

6. In the Shifts field, select your already defined shift from the LOV.

See also
Defining Non-availability (Exceptions)

Defining Availability
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Creating Tasks and ToDos in a Calendar
Assigning a Resource to a Calendar
In addition to creating your own personal calendar, you can assign a resource to a 
calendar. Use this procedure to assign a resource to a calendar.

Prerequisites
None

Steps
1. In the Calendar Name field, select the calendar name from the LOV. 

2. From the Resource Type drop-down list, enter the resource type. 

3. In the Name field, enter the name of the resource. 

4. Enter the Start and End Dates. 

5. Click Save.

Guidelines
You can assign more than one calendar per resource. 

Creating Tasks and ToDos in a Calendar
Use the following procedure to gain access to your personal calendar and there 
create and edit tasks and ToDos.

Prerequisites
You must have a personal calendar.

Steps

1. Navigate to Control Tower.

The Control Tower form opens with resources displayed on the Plan Board tab 
at the bottom of the form.

2. Right-click a resource name to open a pop-up menu.

3. Select Show Calendar to open the calendar for the selected resource name.

The Calendar opens to display tasks and ToDos.
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Viewing the Datebook
4. (Optional) Select Task and click New to create a task.

The Tasks form opens.

See Creating and Updating Tasks for details.

5. (Optional) Select ToDo and click New to create or edit a ToDo.

 The Create/Edit Todo form opens. Fill in the appropriate information and click 
OK. 

See Creating a ToDo List for details.

6. Save your changes and close the Calendar. 

Viewing the Datebook
Use the Datebook screen to view a work shift, task, or time off for yourself or a 
resource, or a group of resources. 

Prerequisites
None

Steps

1. Navigate to the Datebook screen.

2. From the Calendar Name field, select the calendar name you want to view. For 
example, a personal or work calendar.

3. From the drop-down list next to the Resource Employee field, select the 
resource or group of resources available for the chosen calendar. 

4. Select either the Day, Week, or Month tab depending on the time period you 
want to view. 

Creating a ToDo List
You can create a personal ToDo list for yourself. Use this procedure to create a ToDo 
list. 

Prerequisites
None

Steps
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Creating a ToDo List
1. Navigate to the Datebook screen.

2. Select the ToDo radio button.

3. Click New. The Create/Edit ToDo screen appears.

4. Enter the name of your ToDo. This entry appears in the ToDo region.

5. Enter a description of the ToDo. Use this text field to add more detail to your 
one line ToDo name.

6. In the Priority field, enter the priority. 

7. In the Status field, enter the status.

8. Enter the effective dates.

9. Click OK.
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Creating a ToDo List
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Using Task Manager

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. This section covers the 
following topics:

■ Creating and Updating Tasks

■ Setting Dependencies for Tasks

■ Assigning and Scheduling Resources

■ Scheduling Recurring Tasks

■ Tracking Planned, Scheduled, and Actual Dates

■ Setting Task Flags

■ Documenting Multiple Contact Information

■ Tracking a Task Record

■ Launching Task Workflow

■ Linking Tasks to Source Documentation

Creating and Updating Tasks
Tasks consist of work assignments that detail the actions required of company 
personnel. Use this procedure to create or update a task.

Prerequisites
Before you create a task from a template, a template design must exist. 
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Creating and Updating Tasks
Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, click New.

The Tasks window opens.

3. Use one of the following procedures to create a task:

a. Select the template information from the LOV for the required fields, and 
click Create Tasks.

b. Click Create Task from Template to use a template.

The Create Tasks from Template Group window opens. 

Enter your basic task information into the required fields by selecting from 
each LOV. 

4. Click More.

The Task Details window opens.

5. In the Resource tab, define Requirements by selecting from the LOV for each 
field.

6. In the Dependencies tab, enter the task dependencies by selecting from the LOV 
for each field.

7. In the References tab, enter the reference objects by selecting from the LOV for 
each field.

8. In the Recurrences tab, enter the recurrence rules by selecting from the option 
buttons and the LOV for each field.

9. In the Resources tab, enter the resource assignments by selecting from the LOV 
for each field.

10. Save your task.

The new task number appears in the task spread table.

11. If you want to update a task, then perform the following steps:

a. Navigate to Task Manager.

b. In the Find Tasks window, click Find.

c. The Tasks window opens.

d. Update information.
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Setting Dependencies for Tasks
e. Save your changes.

Guidelines
Clicking Launch Workflow in the Tasks window automatically reserves the 
designated resources and notifies the task owner of task creation via e-mail. 

See Also
Designing Task Templates 

Launching Task Workflow

Setting Dependencies for Tasks
Dependencies determine the order among tasks. When an action requires the 
creation of several tasks, setting a dependency for each task ensures the completion 
of a designated task before the start of another. Use this procedure to set task 
dependencies.

Prerequisites
A task must exist before you can set dependencies for it. 

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Dependencies tab, select the dependent task number from the LOV in the 
Task Number field.

The corresponding task name populates the Task Name field.

5. Enter a numerical value in the Offset field.

6. Select from the LOV in the UOM field and click OK.

7. Save your task.

A task dependency now exists for the original task.
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Assigning and Scheduling Resources
Guidelines
Use a numerical value of time in the Offset field. The Offset value determines the 
time that separates the action of initial tasks from subsequent tasks. Use this feature 
to organize tasks with time-sensitive restrictions.

See Also
Creating and Updating Tasks

Assigning and Scheduling Resources
Define resources as the tools and personnel necessary for the completion of a task. 
The task owner assigns and schedules the required resources after choosing the best 
available options. Use this procedure to assign and schedule resources.

Prerequisites
None 

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Resources tab, select from the LOV in the Resource Type field.

Choosing Select populates the Assignments Type and Name fields for the 
corresponding Resource Type.

5. Enter a numerical value in the Unit field.

The Unit value determines the numbered amount of a particular resource.

6. Select from the LOV in the Type and Name fields.

7. If you want to schedule a resource, then select Schedule.

Enter scheduled distance and duration values, and select a unit of measure.

8. If you want to update actual schedule information, scroll right and enter the 
actual values in the required fields and click OK.
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Scheduling Recurring Tasks
9. Save your task.

Resource assignment and scheduling is complete.

Guidelines
The Enabled check box allows you to activate varied resources according to task. 
Use this option to select live resources when updating.

For tracking purposes, update the Actual schedule fields after task completion.

See Also
Creating and Updating Tasks

Scheduling Recurring Tasks
Schedule a task to automatically reoccur daily, weekly, monthly, or yearly. Use this 
procedure to schedule recurring tasks.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Recurrences tab, select an Occurrence option.

5. Select from the LOV in the required fields and click OK.

6. Save your task.

The task now reoccurs automatically.

See Also
Creating and Updating Tasks
Using Task Manager 101



Tracking Planned, Scheduled, and Actual Dates
Tracking Planned, Scheduled, and Actual Dates
Track task progress by entering date information after three task milestones:

■ Task creation

■ Resource reservation

■ Task completion

Use this procedure to track planned, scheduled, and actual dates.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. In the Dates section, enter information into the Planned fields.

The application populates the GMT field with the correct Greenwich Mean 
Time Deviation value.

4. After reserving resources for the task, enter information into the Scheduled 
fields.

5. Upon task completion, enter final information into the Actual fields.

6. Save your task.

Reference date information to track task completion status.

Guidelines
Updating the Actual Start and End Dates in the Resource tab populates the 
corresponding Actual date fields in the main Task form.

See Also
Creating and Updating Tasks 

Assigning and Scheduling Resources
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Setting Task Flags
Setting Task Flags
Use task flags to select different configurations for each task. Setting flags 
customizes each task according to your needs. Use this procedure to set task flags.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Miscellaneous tab, select task flags.

For a detailed description of flag options, see the Task Flag Definitions table in 
the See Also section.

5. Click OK.

6. Save your task.

The task owner receives the task flagged as a Milestone.

Guidelines
Optionally, design templates with predetermined flags.

See Also
Creating and Updating Tasks 

Designing Task Templates

The following table defines each task flag.

Task Flag Definitions

Task Flag Definition or Action

Auto Notification Launch notification workflow automatically.

Milestone Indicate task importance.
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Setting Task Flags
Private Restrict task access to non-task owners.

Publish Allow task notification to non-task owners.

Restrict Closure Require the completion of a child task before a parent task.

Task Flag Definitions

Task Flag Definition or Action
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Documenting Multiple Contact Information
Documenting Multiple Contact Information
Associate more than one person’s name and contact information with a task. Use 
the Contacts tab to document the complete list of contacts for a particular task while 
defining the primary contact individual. Use this procedure to document multiple 
contact information.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Contacts tab, enter information into the Contacts fields.

5. Enter the corresponding telephone information into the Contact Telephones 
fields.

6. Select the Primary check box to mark the primary contact individual and click 
OK.

7. Save your task.

The task contact information is recorded.

Guidelines
Also use the Contacts tab to enter contact information for dependent tasks. The 
contact individual may differ for task dependencies. Entering multiple contacts and 
selecting one as the primary records the correct communication channel for the 
selected task.

See Also
Creating and Updating Tasks 

Setting Dependencies for Tasks
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Tracking a Task Record
Tracking a Task Record
The task record documents and dates the history of task change. Each update to a 
task results in an entry to the task record. The task record provides a trail from the 
original task through to the current task status. Use this procedure to access the task 
record.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Audit tab, view the task history.

Each row documents the status of the task. The bottom row contains the most 
recent task record.

5. Scroll to the right to view the New and Old values.

6. Click OK to return to the Task Details window.

Guidelines
The Audit tab contains a read-only record of the task change. 

See Also
Creating and Updating Tasks

Launching Task Workflow
Define workflow as the actions following a task creation or update. After creating or 
updating a task, you need to notify the task assignees of their involvement. The 
Launch Workflow feature automates this process and contacts the necessary parties 
through e-mail.
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Linking Tasks to Source Documentation
Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. Select the Resources tab.

5. Create an Assignee by filling in the fields from the LOV.

6. Click OK.

7. In the Task Details window, click Launch Workflow.

8. Save your task.

Workflow e-mails the task owner and resource scheduler with the task creation 
or update information.

See Also
Creating and Updating Tasks 

Setting Task Flags

Linking Tasks to Source Documentation
Linking a task to a source document allows you to reference pertinent background 
information. Define source documentation as the original request document that 
resulted in the creation of a task. Use this procedure to link a task to its source 
document.

Prerequisites
None
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Linking Tasks to Source Documentation
Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the References tab, select from the LOV in the Reference Type field.

The application populates the Details field with a description of the reference 
type.

5. Enter the identification number of the source document in the Number field.

6. Optionally, enter additional information into the Usage and Reference Code 
fields.

7. Click OK.

The type and number information populate the Source Doc Type and Source 
Doc Number fields in the main task list.

8. Save your task.

The source document now links to its corresponding task.

Guidelines
Double-clicking the Source Doc field in the main task screen brings up the source 
document for viewing.

See Also 
Creating and Updating Tasks
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Understanding Interaction History

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationship to other Oracle or third-party applications.

The topics covered in this group include:

■ Interaction History Overview

■ How does Interaction History Work?

■ Interaction History’s Dependencies and Integration

■ Interaction History Features

Interaction History Overview
Interaction History tracks all customer-agent interactions and serves as a repository 
for the interaction data. You can view the interaction data as well as the Oracle CRM 
application data associated to the interaction. Activities associated to each 
customer-agent interaction can also be viewed. Within Interaction History, you can 
filter interaction and activity views. Any notes that have been entered for an 
interaction or activity will also display for viewing.

What is an Interaction?
An interaction is a point of contact and may relate to customers, campaigns, agents, 
orders, quotes, etc. This point of contact could be a direct interaction with a 
customer, the customer’s system, a potential customer, or through an automated 
agent. An interaction is generally timed and has an outcome or result that can be 
tracked. Multiple activities can occur during the course of a customer interaction. 
Each customer-agent interaction may include various forms of communication (i.e., 
media items).
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How does Interaction History Work?
What is an Activity?
An activity is a business act performed by an agent or automated agent as a part of 
a customer interaction. Interaction activities typically relate to the media item for 
which the activity occurred. Within the customer interaction, the interaction activity 
may involve how a media item was handled, (e.g., transferred call). It may also 
include details as it pertains to the Oracle CRM application, (e.g., request for 
product information or balance inquiry).

What is a Media Item?
Media items represent a media occurrence that is handled by an Oracle CRM 
application or a user of the application. They can be generated by a customer 
directly, the agent, the system or the Oracle CRM application. Media items can be 
inbound or outbound. For example, an e-mail sent from an agent to a customer 
would be an outbound media item.

How does Interaction History Work?
When a customer-agent interaction occurs, the interaction data is captured and 
tracked within Interaction History. 

The following is an example of the types of interaction and activity data that is 
tracked:

■ Customer

■ Account number

■ Agent

■ Campaign

■ Date and time

■ Activity Type (Media and Activity)

■ Outcome or result of interaction or activity

■ Duration

■ Notes

Interaction History’s Dependencies and Integration
Interaction History is integrated with the following Oracle CRM applications.
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Interaction History Features
■ Oracle Multi-Channel Manager

■ Oracle iCenter

■ Oracle Advanced Outbound

■ Oracle Universal Work Queue

■ Oracle Customer Care

■ Oracle Support

■ Oracle Telesales

Interaction History Features
Within Interaction History, you can view customer-agent interactions, activities and 
notes. Interactions can be filtered by customer, agent, campaign, date range, and 
account number. Activities can be filtered by customer, agent, activity type, media 
type, and date range. Notes that exist for customer-agent interactions and activities 
are available for viewing in Interaction History.
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Interaction History Features
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Using Interaction History

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

The topics covered in this group include:

■ Searching Interactions

■ Viewing Interactions

■ Viewing Interaction Notes

■ Searching Activities

■ Viewing Activities

■ Viewing Activity Notes

Searching Interactions
You can search customer-agent interactions by identifying the criteria for which the 
search will be based. You can filter your search by customer, agent, campaign, date 
range, or account number. You may also search interactions by choosing a 
combination of values. For example, you may need to identify all campaigns that 
pertain to a particular customer.

Once identified, the filtered results will display in the Interactions tab in the 
Interaction History window. Use this procedure to search customer-agent 
interactions.

Prerequisites
A customer-agent interaction must exist in Interaction History.
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Viewing Interactions
Steps
1. Navigate to the Interactions Filtering Criteria Tab, enter the criteria for 

searching interactions in any of the following fields. 

2. In the Customer field, enter the customer’s name. 

3. In the Agent field, enter the agent’s name.

4. In the Campaign field, enter the campaign name.

5. In the Date from and to fields, click the LOV button in each field to display the 
calendar. Click the date on the calendar from which to begin the search. You 
may also specify the time. Click OK.

The date will display in the Date from field and you will automatically proceed 
to the Date to field.

6. Click the date on the calendar to end the date range. You may also specify the 
time. Click OK.

The date will display in the Date to field.

7. In the Account field, enter the customer’s account number.

8. Click the Search button.

The interactions that exist for the search performed will display in the 
Interactions tab in the Interaction History window.

Guidelines
Sentence case must be used when entering the customer’s or agent’s name. For 
example, Fred Smith. A lookup of the customer’s or agent’s name, and campaign 
can be performed by placing the % sign after the partial entry. For example, when 
looking up Fred Smith, you would enter Fred Smi% to find all occurrences.

Viewing Interactions
Once you filter the interactions for viewing, the data associated to the interaction(s) 
will display in the Interactions tab. Any notes that were entered for an interaction in 
the Oracle CRM application will display in the modal window of the Interactions 
tab. Use this procedure to view customer-agent interactions. 

Prerequisites
A customer-agent interaction must exist in Interaction History.
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Searching Activities
Steps
1. From the Interactions tab, click on the interaction to view or use the scroll bar to 

scroll through the interactions.

The interaction data is grouped within columns and rows. Dragging your 
mouse over the heading of a column will display a description of the column as 
a tool tip. You can expand and collapse columns in the Interactions tab as 
needed. By default, the first interaction that matches the criteria for the search 
will be highlighted. A sort indicator will appear in the column header for the 
column for which the primary sort occurred. A record indicator will display for 
the row currently highlighted.

You can scroll across the Interactions tab to view the columns information for 
the interaction.

Any notes that were entered for an interaction in the Oracle CRM application 
will display in the modal window of the Interactions tab.

2. When finished viewing the interaction(s), close the Interaction History window.

Viewing Interaction Notes
Notes that have been entered for customer-agent interactions display in the modal 
window in the Interactions tab. Use this procedure to view interaction notes. 

Prerequisites
A note must have been entered for the customer-agent interaction in an Oracle CRM 
application.

Steps
1. From the Notes window in the Interactions tab, select the note to view.

2. When finished viewing the interaction note, click on another interaction to view 
another note or close the Interaction History window to exit from the 
interaction view.

Searching Activities
You can search customer-agent interactions by activity. You can filter your search by 
customer, agent, activity type, media type, date range, or account number. You may 
also search activities by choosing a combination of search parameters. For example, 
you could search for activities by activity type, customer, and date range.
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Searching Activities
Once you identify the search parameters, the filtered results will display in the 
Activities tab in the Interaction History window. Use this procedure to search 
activities within customer-agent interactions.

Prerequisites
An activity must exist for the customer-agent interaction in Interaction History and 
the Oracle CRM application.

Steps
1. Navigate to the Activities Filtering Criteria tab, enter the criteria for searching 

activities in any of the following fields.

2. In the Customer field, enter the customer’s name. 

3. In the Agent field, enter the agent’s name.

4. In the Activity Type field, enter the type of activity.

5. In the Media Type field, enter the type of media.

6. In the Date from and to fields, click the of values button in each field to display 
the calendar. Click the date on the calendar from which to begin the search. You 
may also specify the time. Click OK.

The date will display in the Date from field and you will automatically proceed 
to the Date to field.

7. Click the date on the calendar to end the date range. You may also specify the 
time. Click OK.

The date will display in the Date to field.

8. Click the Search button.

The activities that exist for the search performed will display in the Activities 
tab in the Interaction History window.

Guidelines
Sentence case must be used when entering search parameters in any of the fields in 
the Activities Filtering Criteria tab. For example, Ann Johnson. A lookup of the 
customer’s or agent’s name can be performed by placing the % sign after the partial 
entry. For example, when looking up Ann Johnson, you would enter Ann John% to 
find all occurrences.
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Viewing Activity Notes
Viewing Activities
Activities performed for a customer-agent interaction in an Oracle CRM application 
are viewed from the Activities tab in Interaction History. Use this procedure to view 
activities for customer-agent interactions.

Prerequisites
A customer-agent interaction must exist in Interaction History.

Steps
1. From the Activities tab, click on the activity to view or use the scroll bar to scroll 

through the activities.

The activity data is grouped within columns and rows. Dragging your mouse 
over the heading of a column will display a description of the column as a tool 
tip. You can expand and collapse columns in the Activities tab as needed. By 
default, the activity that matches the criteria for the search will be highlighted. 
A sort indicator will appear in the column header for the column for which the 
primary sort occurred. A record indicator will display for the row currently 
highlighted.

You can scroll across the Activities tab to view the columns information for the 
activity.

Any notes that were entered for an activity in the Oracle CRM application will 
display in the modal window of the Activities tab.

2. When finished viewing activities, click on another activity or interaction to 
view.

Viewing Activity Notes
Notes that have been entered for an interaction activity will display in the modal 
window in the Activities tab. Use this procedure to view activity notes. 

Prerequisites
A note must have been entered for the interaction activity in an Oracle CRM 
application.
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Viewing Activity Notes
Steps
1. From the Notes window in the Activities tab, select the note to view.

2. When finished viewing the activity note, click on another activity to view 
another note or close the Interaction History window to exit from the activity 
view.
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Administering Interaction History

This topic group provides task-based procedures that are required for ongoing 
system maintenance and includes information on administration tools and utilities.

The topics covered in this group include:

■ Overview of Interaction History Administration

■ Defining Outcomes

■ Defining Results

■ Pairing an Outcome With a Result

■ Pairing a Result with a Reason

■ Defining a Wrap-Up

Overview of Interaction History Administration
Use the Interaction History Administration window to define attributes that users 
can assign to interaction records. This section covers the following tabs in the 
Interaction History Administration window:

■ Outcomes

■ Results

■ Outcome-Results

■ Results-Reasons

■ Wrap-Ups
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Defining Outcomes
Defining Outcomes
The outcome is the immediate response to an agent’s call, such as Contact, No 
Answer, or Busy. One outcome can be used by more than one campaign. To close an 
interaction the agent must report an outcome. Use the following procedure to define 
the outcomes that the agent can use.

Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Outcomes tab.

The Outcome Code and Short Description fields must be defined. Some 
pre-defined values are available for these fields.

3. Click on the Outcome Code field and choose View > Find All.

The pre-defined values are now visible in the Outcome Code and the Short 
Description fields. 

4. Press the Up or Down arrow keys to review all the pre-defined values. You can 
also enter your own values in either field.

5. If you need to use Numeric Values, select the Telephony Related check box. 

Select either Success option–Yes or No–and enter the appropriate Numeric 
Value. Yes has a range of 1 to 100; No has a range of 101 to 255.

6. Choose whether the outcome requires a Private or Public callback.

7. Choose File >Save and Proceed to save the outcome definition.

Guidelines
Some telephony-related applications use Numeric Values, which are recorded as the 
Versatility Code in database tables. Versatility Codes are used by version 3i of the 
following applications: Oracle TeleBusiness for Telecom/Utilities, Oracle 
TeleBusiness for Financial Services, Oracle Integration Manager, and Oracle 
Campaign Plus. If you do not use these earlier applications, you do not need to use 
Numeric Values.
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Pairing an Outcome with a Result
Defining Results
A result of a transaction is the business-related consequence of the agent’s call, such 
as Sale, No Sale, or Complaint. While all transactions must have an outcome, a 
result is not mandatory. Use the following procedure to define a result.

Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Results tab.

The Results Code and Short Description fields must be defined. Some 
pre-defined values are available for these fields.

3. Click on the Results Code field and choose View > Find All.

The pre-defined values are now visible in the Results Code and the Short 
Description fields. 

4. Click the Up or Down arrow keys to review all the pre-defined values. You can 
also enter your own values in either field.

5. If the business rules of the enterprise require a Reason for every Result, select 
the Reason Required check box.

You may also define Result-Reason pairs. See Pairing a Result with a Reason.

6. Choose File >Save and Proceed to save the result definition.

Pairing an Outcome with a Result
You can create a new option by pairing an Outcome with a Result. Any Outcome 
may be paired with more than one Result. Each pair appears as one option on the 
agent’s screen.

Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Outcome-Results tab.

Note: Each Outcome-Result pair must be unique. 
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Pairing an Outcome with a Result
3. Select a value from the Outcomes list.

4. Select a value from the Results list.

5. Choose File >Save and Proceed to save the Outcome-Result pair.

Guidelines
The values on the Outcomes list were defined on the Outcomes tab. The values on 
the Results list were defined on the Results tab.

See Also
Defining Outcomes

Defining Results
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Defining a Wrap-Up
Pairing a Result with a Reason
You can create a new option by pairing a Result with a Reason. Any Result may be 
paired with more than one Reason. Each pair appears as one option on the agent’s 
screen.

Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Result-Reasons tab.

3. Select a value from the Result list.

4. Select a value from the Reason list.

5. Choose File >Save and Proceed to save the Result-Reason pair.

Guidelines
The values on the Results list were defined on the Result tab. The values on the 
Reasons list were defined on the Reason tab.

See Also
Defining Results

Defining a Wrap-Up
A wrap-up is a summary of a transaction that an agent enters after completing a 
transaction. A Promotion code and Campaign Type are essential elements in the 
definition of a wrap-up. When an agent is working on a specific promotion, the 
wrap-ups defined for that promotion become available on the agent’s screen.

The business rules of an enterprise determine whether or not to include the 
Outcome Code, Result Code and Reason Code in the definition of the wrap-up.

Use this procedure to define a wrap-up for an interaction.

Note: Each Result-Reason pair must be unique.
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Defining a Wrap-Up
Steps 
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Wrap-Ups tab.

3. Choose values for Promotion Code and Campaign Type. Choose values for the 
remaining codes when required.

4. Choose File >Save and Proceed to save the wrap-up definition.
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Understanding Fulfillment

This topic group provides overviews of Fulfillment and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. This section covers the 
following topics:

■ Fulfillment Overview

■ What is a Fulfillment?

■ What is a Query?

■ What are Datasource Files?

■ Terms and Definitions

Fulfillment Overview

Fulfillment is defined as an automated way to send information to customers 
electronically through e-mail. It provides the ability to immediately satisfy a 
customer’s requests for information, literature, and other correspondence. 
Customer Service Representatives handle a variety of requests ranging from 
product and service inquiries, pricing questions, billing inquiries, and general 
customer care issues. Many of these requests will result in some dissemination of 
literature, collateral, forms of application, letters, or correspondence to the 
customer. Fulfillment provides the ability for call center administrators, mobile field 

Note:  1-to-1 Fulfillment is a module that is called from other 
CRM applications. It is not designed to be, nor should it be used 
as, a stand-alone product.
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What are Fulfillments?
representatives, marketing managers, customer care representatives, and other 
service agents to respond to different customer needs quickly and easily using 
e-mail.

Some key features of Fulfillment include:

■ Providing automated delivery of information to customers using e-mail

■ Supporting multiple types of customizable Fulfillments used in CRM 
applications such as documents, templates, and collateral

■ Prioritizing requests

■ Updating customer information through Interaction History

■ Merging data into formatted outgoing e-mails to create consistent personalized 
messages

■ Using Oracle Workflow Builder to launch a request, manage the request as it 
moves through the Fulfillment cycle, monitor the status of each Fulfillment 
request, and notify users about the disposition of particular events

What are Fulfillments?
The following table describes the five types of available fulfillments.

WARNING: Windows relating to either print, fax, or file server 
functionality or capability are not supported at this time, and 
should not be used.

These capabilities are enhancements intended for future releases, 
but are not available in the current release of Fulfillment.

Types of Fulfillments

Type Description

Fulfillment A Fulfillment is information distributed to people through 
e-mail such as a thank you e-mail for inquiring about services a 
company provides.

Template A template is a predefined package of electronic brochures, 
newsletters, or other customer-oriented information that an 
agent sends to customers in response to a request for 
information such as a brochure of the services that the 
company provides. 
126 Oracle CRM Application Foundation Concepts and Procedures



What are Datasource Files?
What is a Query?
A query is a SQL statement that collects specific kinds of data from the database 
when fulfilling a request. From the query window, you can create, update, or restore 
queries along with creating the Datasource files where the results of the query are 
stored.

Queries are used for generating and populating data in master documents 
dynamically. Dynamic information comes from the query and the associated bind 
variables and is a part of the master document. The bind variables contain the data 
that is required to process a Fulfillment query. The bind variables correspond to the 
items required by the query that serves the template specified. These are generally 
items listed in the WHERE clause of the SQL query.

For example, the bind variable for the SQL statement:

Select person_last_name lname from jtf_contact_points WHERE person_first_name = 
:fname is, fname.

What are Datasource Files?
A Datasource file is a text file that contains tab-separated merge fields. Once the 
query and datasource file have been created, upload the Datasource file to the 
server. Then, the Datasource file can be used in a Master Document and sent out as 
part of a Fulfillment request. Use datasource files to create Master Documents. 

Merged Data Merged data is a the specific chunk of data that has been taken 
from several sources and merged together. For example, if a 
company wants to send a thank you email to everyone that has 
inquired about their company, the resulting merged data is the 
query retrieving all customers that have inquired about the 
company and associated with a master document. 

Master Document A Master Document is a dynamic HTML file or HTML 
Aggregate Zip file. If documents contain merged data 
(dynamic), it must be passed to an API and merged into the 
document or the merged data must come from a query.

Collateral Collateral is a static Fulfillment document that does not contain 
merged data.

Types of Fulfillments

Type Description
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Terms and Definitions
The following table describes Fulfillment terms and definitions.

Fulfillment Terms and Definitions

Term Description

Administrator A person at a management level who is responsible for 
creating and managing Fulfillment templates.

Agent or User The person who initiates a Fulfillment request from within a 
CRM application. Agents or users usually interact directly with 
customers, either on the phone or face-to-face. In Web-based 
self-service applications, a customer or prospect may be the 
requesting agent.

Attachment A document that has been generated by another application 
and included as part of a Fulfillment request. Attachments 
allow information such as bank account activity, service 
request status, credit information, or invoices to be sent to a 
customer. Attachments are static documents.

Collateral Informational material created by a customer organization 
such as marketing, and sometimes pre-printed. Collateral is 
static; no merge can be done with collateral. Collateral may 
need to be inventoried or charged to a corporate cost center or 
customer. Marketing refers to collateral as deliverables.

Customer A person who has purchased a product or service.

Master Document A dynamic document containing merges fields that are filled 
with data during the execution of a Fulfillment request. Master 
documents may be cover letters or other correspondence that is 
written for a customer or prospect. Master Documents may be 
viewed by users but cannot be overwritten. They do not 
include merged documents; therefore, they are static 
documents.

Fulfillment Request An action that results in providing information to a customer 
or prospect. Information is delivered to the customer as email.

Fulfillment Server The Fulfillment server, a Java-based multi-threaded server, 
processes the requests, manages customer data, merges data 
into Master Documents, dispatches final output, and logs 
completed request in Fulfillment History table, as well as, 
write to Interaction History tables if the Party ID is passed.
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Group A set of agents or users usually related by workgroup, function 
or department. Each user must belong to at least one group 
and have exactly one default group. These groups are 
associated with a Fulfillment server.

Integration points CRM Fulfillment integrates with other application products 
through APIs included with the core Fulfillment product.

Items The contents of a Fulfillment request. Items are selected from 
the list of all possible documents and collateral material 
available to the user from Fulfillment template.

Output The delivery medium of a Fulfillment request. Currently only 
e-mail is supported.

Prospect A person who is a candidate to purchase a product or service.

Query A SQL statement or list created by the administrator (or an 
external other) that is used to merge specific data with a master 
document. Used for batch lists, mass mailings, or mail blitzes.

Summary Screen and 
Detail Screen

Summary screens contain lists of things such as all open 
Fulfillment requests, all available campaigns, or all output 
devices on a server. A Detail screen displays information about 
a specific open request, campaign, or output device.

Workflow Template Each Fulfillment template contains a workflow template that 
manages the flow (direction), timing, approvals, and 
notifications associated with specific Fulfillment requests. If a 
particular Oracle customer requires a workflow template 
outside of the scope of the pre-defined template, Workflow 
builder needs to be used (by the customer or by Oracle 
Consulting) to create custom templates.

Fulfillment Administrative 
Console

Used to configure Fulfillment servers, group, templates, 
queries, and locate request statuses and histories.

Fulfillment Agent A set of agent Java Server Pages (JSPs) that are provided to 
CRM applications for creating basic Fulfillment requests.

Fulfillment Terms and Definitions

Term Description
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Administering Fulfillment

This topic group provides task-based procedures required for ongoing system 
maintenance and includes information on administration tools and utilities. This 
section covers the following topics:

■ Getting Started

■ Logging onto Fulfillment

■ Using the Quick Find Search Feature

■ Viewing or Updating Listed Items

■ Updating a Fulfillment Template

■ Changing a Template’s Availability

■ Creating a Query

■ Creating a Datasource File

■ Downloading a Datasource File

■ Updating a Query

■ Uploading a Master Document

■ Associating a Master Document with a Template

■ Removing a Master Document from a Template

■ Removing Collateral from a Template

■ Uploading a Master Document to the Marketing Encyclopedia System

■ Creating New Groups

■ Adding a New Group to the Server
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Getting Started
■ Adding Agents to a Group

■ Removing Agents from a Group

■ Modifying Groups

■ Modifying Fulfillment Servers

■ Reconfiguring Email Servers

■ Reconfiguring Fax Servers

■ Reconfiguring File Servers

■ Reconfiguring Printers

■ Modifying a Group-Server Association 

■ Removing Output Devices and Groups.

■ Checking a Request Status

■ Viewing Requests

■ Canceling a Request

■ Resubmitting a Fulfillment Request

Getting Started
Now that Fulfillment functionality has been defined, the process of how to 
administer Fulfillment should be addressed.

The steps involving the Fulfillment process include:

1. Creating a template.

2. Creating a query.

3. Creating a datasource file (if using merged data).

4. Uploading a master document.

5. Associating a master document to templates.

6. Sending out Fulfillments.

Note: Click on any highlighted column link in any tab to display 
the information in the opposite order.
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Logging in as the Fulfillment Administrator
Logging in as the Fulfillment Administrator

Prerequisites
You must have administrator responsibilities.

Steps
1. To open the jtflogin.jsp page, enter its URL: 

http://<host.domain_name>:<port>/<docroot>/jtflogin.jsp

2. Enter your user ID and password in the appropriate fields

3. Use the following for the variable parameters:

■ host.domain_name: The hostname where the Apache Server is installed. For 
example, apo23sum.us.oracle.com is a fully qualified host name.

■ port: The port on which the Apache Web listener is configured.

■ docroot: The document root defined for the Apache Server that contains the 
JSP pages.

Once you log in to Fulfillment, the Fulfillment Administrator home page is the 
default page.

4. Use the Fulfillment Administration windows to perform various functions. 

The following table describes the tabs found in the Fulfillment interface.

Guidelines

Fulfillment Tab Descriptions

Tab Description

Home Use this tab to access the Fulfillment Administrator home 
page. Use this window to access servers, groups, templates and 
queries. Additionally, use the Fulfillment Administrator Status 
windows to view history and status’ of requests.

Server Use this tab to create and modify server information, remove 
groups as well as add and remove agents from those groups. 
You can also add and remove additional email servers to an 
existing server from this tab.

Group Use this tab to create and modify groups, add agents to groups, 
and remove agents from groups. You can also change the 
server associated to the group.
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Using the Quick Find Search Feature
See Also
Setting Up a Fulfillment Administrative User

Using the Quick Find Search Feature
Perform the following steps to use the Quick Find search feature in Fulfillment.

Prerequisites
None

Steps

1. Using the Quick Find drop-down list, select search criteria:

■ jtffmserver

■ jtffmgroup

■ jtffmquery

■ jtffmtemplate

■ jtffmstatus

2. Enter a keyword for the search. 

Template Use this tab to view, create and modify a template. You can 
also associate a master document or collateral to a template by 
uploading the document to the Fulfillment server.

Query Use this tab to generate and populate data in Master 
Documents dynamically. In order to create a query, the 
administrator must have thorough knowledge of SQL*Plus and 
must identify the bind variables that are needed for the query.

Status Use this tab to re-submit a Fulfillment request or view the 
history of a request or the status of requests.

Note: The Quick Find search feature is case sensitive.

Fulfillment Tab Descriptions

Tab Description
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Updating a Fulfillment Template
For example, if you are searching jtffmgroups, enter the group name. To search 
for all groups, enter %.

3. Click Go.

4. Click on any item to display the details.

Viewing or Updating Listed Items
To view more detail or make changes to an item listed on the selected window, 
choose the item to open a detailed configuration window.

Updating a Fulfillment Template
For each template, you can change the Name, Status, and Description. Perform the 
following steps to update a template.

Prerequisites
A template must first exist and have availability assigned to it.

Steps
1. Select the Template tab.

The Template window opens.

2. (Optional) Use the list of values (LOV) to organize existing templates in three 
different views (all templates, active templates, or inactive templates).

3. In the Template window, choose the name of the template that you want to edit.

The View Template window opens.

4. Edit the information as necessary. You cannot edit the name of the template.

5. (Optional) If you make an error, click Restore to revert back to the original 
information.

6. Click Update.

Note: Changing the name of a template that is already in use may 
render that template inaccessible.
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Changing a Template’s Availability
If you want to prevent a template from being used for Fulfillment requests, then 
change the template’s status. For example, you can change an inactive template to 
active if you want it to be available or change an active template to inactive. 
Perform the following steps to change the status of a template.

Prerequisites
A template must first exist and have availability assigned to it.

Steps
1. Select the Template tab.

2. In the Template Name column, click the template that you want to change.

The View Template window opens.

3. In the Status drop-down list, choose the appropriate Status: Active or Inactive.

4. Click Update.

Creating a Query
A query is an SQL statement that directs Fulfillment to collect specific kinds of data 
from the database when fulfilling a request. Perform the following steps to create a 
query.

Prerequisites
■ You must identify the bind variables.

■ You must identify the fields (columns and aliases) you want to associate with 
the query.

■ You must identify what master document the query will be associated with.

Steps
1. Select the Query tab and click Create.

The Create Query window opens.

2. Enter a unique name for the new query in the Name field.

3. Enter a description for the new query in the Description field.
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Creating a Query
4. Enter the SQL query string in the Query String field.

See the SQL Query Guidelines following for details on creating a query.

5. Click Create.

The Queries window opens and the newly created query displays in the 
Queries list.

See also
Updating a Query

SQL Query Guidelines

Use the following syntax when creating an SQL query:

SELECT <column name> <alias>,
       <column name> <alias>,
       <column name> <alias>,
       <column name> <alias>
FROM <table name>
WHERE <column name> = :<bind variable>

In the above code:

■ Standard SQL commands are all in capital letters.

■ Column names contain underscores.

■ Column name aliases follow the column names and appear before the comma 
or the next keyword. Use aliases as substitutes in master documents for the 
actual column names.

■ The table from which the columns are selected follows the FROM keyword.

■ The bind variable specifies which row is pulled from the table to give the actual 
bits of data for each merged document. A colon in front of a bind variable 
makes it a global variable. This enables the query to recognize it after the value 
is passed in from the user interface. 

For example:

WARNING: SQL statements typically end with a semicolon (;). 
However, in this case, the query engine appends the semicolon 
itself. Do NOT append a semicolon to the end of this query.
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Creating a Datasource File
SELECT person_last_name lname, 
       party_id CustNumb, 
       creation_date cdate,
       phone_number phone 
FROM jtf_contact_points_v 
WHERE person_first_name = :fname;

If you enter the above sample query as the query string, then the data source utility 
pulls the aliases rather than the column names when it creates the data source file.

The window opened by the data source utility would then show the following in a 
plain background window with nothing else:

lname    CustNumb    cdate    phone

Merge fields should match exactly with the Master Document.

Creating a Datasource File
A Datasource file is a text file that contains tab-separated merge fields that have 
been obtained by a query. Use the datasource file to obtain the columns available 
from the query so that they can be used as merged fields. Perform the following 
steps to create a datasource file.

Prerequisites
The query for the Datasource file must already exist. See Creating a Query.

Steps
1. Select the Query tab.

2. In the Query window, click Datasource.

The Create Datasource File for Query window opens.

3. From the Query Name drop-down list, choose the query. For example, select the 
Query that was just created.

4. Click Create.

The Create Datasource window opens.

5. Right-click the Datasource link.

The Datasource appears in a separate browser window.
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Downloading a Datasource File
Before a datasource file can be used in a master document, it must be downloaded. 
Perform the following steps to download a datasource file.

Prerequisites
You must have already created the Datasource file. See Creating a Datasource File. 

Steps
1. From the browser File menu, select Save As.

2. Choose plain text file (.txt) as the file type.

3. Navigate to the desired save location.

4. Click Save.

5. Close the browser window.

Updating a Query
Perform the following steps to change the parameters or other specifications of a 
query.

Prerequisites
You must have already created the query. See Creating a Query.

Steps
1. Select the Query tab.

2. In the Query name column, click the query you want to update.

The Update Query window opens.

3. Update the information as necessary. The Query name cannot be edited.

4. (Optional) If you make an error, click Restore to revert back to the original 
information.

5. Click Update. 
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Uploading a Master Document

A Master Document contains text that is used repeatedly, such as a form or a 
contract. You create master documents in a word processing application. A Master 
Document can have one of the following extensions:

■ .zip

■ .html

■ .pdf

After creating a master document with the HTML editor of your choice, upload it to 
make it available for Fulfillment requests. When you upload a Master Document, it 
is stored in the Marketing Encyclopedia System (MES).

To upload a Master Document, see Uploading a Master Document to the Marketing 
Encyclopedia System.

Associating a Master Document to a Template

A template is a pre-defined package of brochures, newsletters, or other 
customer-oriented information that an agent locates and directs to customers in 
answer to a Fulfillment request. Use the following procedure to associate one or 
more master documents to a template.

Prerequisites
A template must exist.

One or more master documents must be available in the list of Master Documents.

Note: You cannot upload collateral in Fulfillment. You can only 
upload a Master Document. Collateral is created by Marketing and 
uploaded through the Marketing Online application.

Note: If the Master Document in HTML was originally created in 
Microsoft Word, you must use the Notepad or an HTML text editor 
to remove information that is proprietary to Microsoft from the 
HTML header. See Uploading a Master Document to the Marketing 
Encyclopedia System.
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Removing a Master Document from a Template
Steps
1. Select the Template tab.

The Templates window opens.

2. In the Template Name column, click the template that you want to associate to a 
master document.

The View Template window opens.

3. Click Master Document in the left frame.

The View Template, Master Documents window opens.

4. Choose Go to begin a search of master documents.

The Master Document window opens.

5. Enter the initial letter of a master document with % and click Search.

6. Click on the name of the Master Document.

The View Template window opens and the selected Master Document is now 
associated with the Template.

7. Click Update.

Removing a Master Document from a Template
Perform the following steps to remove a master document from a template.

Prerequisites
A template must exist and have a master document associated with it.

Steps
1. Select the Template tab.

2. In the Template Name column, click the template that is associated with the 
Master Document.

3. Click Master Document in the left frame.

4. Select the Remove check box beside the master template that you want to 
remove.

5. Click Update.

The Master Document is no longer associated with the template.
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Removing Collateral from a Template
Perform the following steps to remove collateral from a template.

Prerequisites
A template must exist and have collateral associated with it.

Steps
1. Select the Template tab.

2. In the Template Name column, click the template that is associated with the 
Master Document.

3. Click Collateral in the left frame.

4. Select the Remove check box beside the collateral that you want to remove.

5. Click Update.

The collateral is no longer associated with the template.

Uploading a Master Document to the Marketing Encyclopedia System
After Creating a master document, upload the Master Document to the Marketing 
Encyclopedia System (MES) where it will be available for Fulfillment requests.

Perform the following steps to upload a Master Document to the MES.

Prerequisites
■ The Master Document must be an HTML file or an Adobe Acrobat PDF file.

■ In HTML files, remove from the HTML code any propriety information inserted 
by the word processor, otherwise the server will not process the document. For 
example, saving a Microsoft Word document as HTML inserts Microsoft 
proprietary information in the <HTML> header tag, that is, a line in the header 
stating 

<META NAME ="Generator" CONTENT="Microsoft Word 97> 

To remove such propriety information, use a generic text editor such as Microsoft 
Notepad or WordPad
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Steps
1. Select the Template tab and click Master Document.

The Master Document window opens.

2. Click Upload.

3. Enter the file name or click Browse.

The File Upload dialog box opens.

4. Choose the Master Document file and click Upload.

The Update Master Document window opens.

5. (Optional) In the Description field, type a description of the Master Document.

6. From the Query drop-down list, choose a query to associate with the Master 
Document.

7. Click Upload.

The Master Document uploads to MES.

See also 
■ Creating a Query

■ Updating a Query

■ Associating a Master Document with a Template

Creating New Groups
To create a new group, use the following procedure. 

Note: If a master document requires information that must be 
pulled from a database table, then create an appropriate query to 
associate with a master document. Otherwise, the correct data 
cannot be sent with the request Fulfillment.
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Adding a New Group to the Server
Prerequisites

None

Steps
1. Select the Group tab and click Create.

The Create Group window opens.

2. Enter a unique name for the Group in the Group Name Field.

3. Enter a description for the group in the Description field.

4. Use the drop-down list to select the server where you want to add the group.

5. To add agents, click Go and select the agent to add to the group.

6. Click Create.

The new group is added to the list in the groups window.

Adding a New Group to the Server
Perform the following steps to add a newly created group to a Fulfillment server.

Prerequisites
A group must already exist in the system.

Steps
1. Select the Server tab.

2. In the Server Name column, click the server where you want to add the group.

The General window opens.

3. Click Groups in the left frame.

The Groups window opens.

4. Select Add Group.

The Select Group window opens.

5. From the drop-down list, choose the group to add to the Fulfillment server.

6. Select Go.

The Add Group window opens.
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Adding Agents to a Group
7. In the Output Devices tables, select the output devices to associate with this 
agent group. The output devices should be in a physical location accessible to 
the agents.

8. To make output devices available, click Create.

9. Click Save when you are done adding output devices.

Adding Agents to a Group
Perform the following steps to add agents to a group.

Prerequisites
None

Steps
1. Select the Group tab. 

2. In the Group Name column, click the name of the group to which you want to 
add agents.

The Group Detail window opens.

3. In the Agents table, click Go.

The Select Agents window opens.

4. Select an agent from the list or enter % and an agent’s name and click Search.

The Group Detail window opens and the new agent is listed in the Agents table.

5. Click Update.

6. Repeat these steps to add additional agents to a group.

See also
Removing Agents from a Group

Creating New Groups

Modifying Groups

Modifying a Group-Device Association
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Removing Agents from a Group
Perform the following steps to remove agents from a group.

Prerequisites
None

Steps
1. Choose the Group tab. 

The Groups window opens.

2. In the Group Name column, click the name of the group to which you want to 
remove an agent.

The Group Detail window opens.

3. In the Agents table, select the check box beside the Agent’s name you want to 
remove.

4. Click Update.

The agent is removed from the group.

Modifying Groups
Perform the following steps to modify a group. 

Prerequisites
None

Steps
1. Select the Group tab.

The Group Details window opens.

2. In the Group Name column, click the name of the group that you want to 
modify.

The group details window opens.

3. Edit the following information as necessary:

■ Description
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■ Server names

■ Agent Information

4. Click Update to save the information to the database.

The View Groups window opens.

See also
Modifying Fulfillment Servers

Modifying Fulfillment Servers
Perform the following steps to modify a Fulfillment server.

Prerequisites
None

Steps
1. Select the Server tab.

2. In the Server Name column, click the name of the server that you want to 
modify.

The General window opens.

3. Edit the following information as necessary:

■ Start Time

■ Shutdown time

■ Request Queue Name

■ Response Queue Name

■ Description

4. Click Continue.

The Email Servers window opens.

5. Click Update to save the new configuration.

See also
Reconfiguring Email Servers
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Reconfiguring Email Servers
Reconfiguring File Servers

Reconfiguring Email Servers
Perform the following steps to reconfigure an email server.

Prerequisites
None

Steps
1. Select the Server tab.

2. In the Server Name column, click the name of the server that you want to 
reconfigure.

The General window opens.

3. Click Email Servers in the left frame. 

The Create Email Server window opens.

4. Edit the following information as necessary:

■ Physical name

■ Incoming Server

■ Outgoing Server

5. To add a new email server, click Add Email Server.

6. Click the Output ID link to edit the email server details in the Create Email 
Server window.

a. Enter the Email Server Name

b. Enter the Return Address

c. Enter the Incoming Server

d. Enter the Outgoing Server

7. Click Save.

Note: You can only have one Email Server associated with a 
Group.
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Modifying a Group-Server Association
8. Click Update.

Reconfiguring Fax Servers

Reconfiguring File Servers

Reconfiguring Printers

Modifying a Group-Server Association 
Perform the following steps to remove an association between a device server and a 
group.

Prerequisites
An association between a group and a device server must exist.

Steps
1. Select the Server tab, 

2. In the Server Name column, click on the server to which the group is associated.

The General window opens. 

3. Click the Groups link in the left frame.

4. The Groups window opens with a list of the groups associated to the 
Fulfillment server with the device servers to which each group is associated.

WARNING: Windows relating to fax functionality or capability 
are not supported at this time, and should not be used.

WARNING: Windows relating to file server functionality or 
capability are not supported at this time, and should not be used.

WARNING: Windows relating to either print functionality or 
capability are not supported at this time, and should not be used.
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Removing Output Devices and Groups
5. Select the Remove check box beside the group to remove.

6. Click Update to complete the process.

Removing Output Devices and Groups
Perform the following steps to remove an output device or agent group.

Prerequisites
None

Steps
1. Select the Server tab. 

2. In the Server Name column, click the server you want to remove.

The General window opens.

3. Click the Groups link in the left frame.

The Groups window opens.

4. Select the Remove check box next to the group you want to delete. 

5. Click Update.

The group is removed from the server.

Checking a Request Status
Perform the following steps to check the status of a request.

Prerequisites
None

Steps
1. Select the Status tab.

2. In the Request Identifier column, click the number of the request to which you 
want to see the status.

The View Status window opens detailing the status of the request.
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Viewing Requests
Perform the following steps to view a request.

Prerequisites
None

Steps
1. Select the Status tab.

2. Using the drop-down list, select the view you wish to see:

■ Submitted

■ Re-submitted

■ In Process

The information appears in the status window.

Cancelling a Request
When you submit a Fulfillment request, the request goes into a queue for 
processing. When the server begins to process the request, it extracts the request 
from the queue. 

To cancel a Fulfillment request, in the Administrative Console choose the Status tab, 
and then in the appropriate request Action column choose Cancel.

Re-submitting a Fulfillment Request
Perform the following steps to resubmit a Fulfillment request.

Prerequisites
You must have already created the Fulfillment request.

Note: Once the server extracts the request from the queue, the 
request cannot be cancelled.

Note: You can resubmit a successful request.
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Re-submitting a Fulfillment Request
Steps
1. Select the Status tab and click History.

In the row that contains the request identifier that you want to resubmit, click 
Re-submit.
152 Oracle CRM Application Foundation Concepts and Procedures



Understanding Assignment Manager

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. This section covers the 
following topics:

■ Overview of Assignment Manager

■ Assigning Process

Overview of Assignment Manager
Use Assignment Manager to:

■ Assign responsibility for documents and tasks

■ Assess the availability of qualified resources needed to perform a task

The assignment process uses criteria based on preferred resources, availability, and 
territories. Scheduler provides additional features to optimize scheduling.

For more detail see:

■ Ownership Assignment

■ Resource Availability Assignment

■ Additional Features of Oracle Scheduler

■ Options for Assigning Ownership and Availability

Ownership Assignment
When you create a document or a task, you must assign an owner to it to ensure 
action is taken. A document owner can be a service manager, expediter, marketing, 
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Overview of Assignment Manager
service, or sales person. A task owner can be a planner, dispatcher, or service 
representative. An owner is defined as a resource within Assignment Manager.

Resource Availability Assignment
A resource must be available before it can perform a task in the field. Assignment 
manager uses the calender to check the availability of a resource. When you assign a 
task to a resource, that resource becomes unavailable for the period of time 
described by that task. 

Additional Features of Oracle Scheduler
Oracle Scheduler is an add-on option that is designed specifically for the needs of 
field service. Scheduler is especially helpful for users that have frequent schedule 
changes, relatively large geographical territories per service representative, or dense 
city areas. If you have Scheduler installed, then the Assignment Manager screen 
displays the Intelligent and Window to Promise options. 

When you use the assignment manager to find an available resource, the 
information is passed to Oracle Scheduler. Scheduler then optimizes the schedule, 
based on travel time and a larger set of business-driven criteria.

Options for Assigning Ownership and Availability
There are several ways you can assign ownership and availability in Assignment 
Manager. 

The following table describes the two options for assigning ownership. 

Option Description

Assisted Use this option if you want assignment manager to find a list 
of qualified resources based on a predefined set of criteria.

With automatic assignment, when no resource can be found 
based upon the selection criteria, use the Assisted screen to 
adjust your criteria and perform a search.

Unassisted Use this option if you want to assign a document without 
taking the criteria into account, or to overrule the criteria set. 
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Assigning Process
The following table describes the four options for assigning availability.

Assigning Process
The process of selecting a qualified resource is based upon selection criteria and 
customer selections. To make these criteria effective, some requirements need to be 
met. To understand the process for assigning documents and availability, the 
following is explained in more detail:

■ Assignment Manager Dependencies

■ Assignment Manager Selection Criteria

■ The Effect of Customer Selections

Option Description

Assisted Use this option if you want assignment manager to find a list of 
qualified resources based on a predefined set of criteria.

The resources calendar displays tasks and task status. When no 
qualified resource is shown, you must adjust your criteria and 
re-perform a search.

With automatic assignment, when no resource can be found 
based upon the selection criteria, use the Assisted screen to 
adjust your criteria and perform a search.

Intelligent An option specific to field service that is only available when 
Oracle Scheduler is installed. Oracle Scheduler assigns the task 
to a qualified resource. 

For more information, see Scheduling Intelligent.

Window to Promise An option specific to field service that is only available when 
Oracle Scheduler is installed. The Window to Promise displays 
time intervals at which a resource (service representative) can 
visit the customer to perform the task. 

For more information, see Scheduling with the Window to 
Promise.

Unassisted Use this option to assign a task without taking the criteria into 
account or actually overruling the criteria set.
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Assignment Manager Dependencies
To make optimal use of Assignment Manager’s capability of assigning ownership 
and availability, the following table describes required dependencies.

Assignment Manager Selection Criteria
In addition to the requirements listed in Assignment Manager Dependencies, the 
following table describes the criteria Assignment Manager uses to select a qualified 
resource for a document or task.

The Effect of Customer Selections
The assigning of ownership and availability is influenced by customer selections. 
The customer selections are set up within Assignment Manager and consist of 

Dependency Description

Preferred resource 
information

A preferred resource is a single person or a resource group that 
is defined in Oracle Contracts or recommended from the 
installed base in Oracle Service. When there is no preferred 
resource, use the Assignment Manager set-up screen to define a 
relation between document source and resource definition. 

Territory definition Territories are defined in Territory Manager. A territory has 
resources or resource groups assigned to it. 

For more information, see Territory Manager.

Task duration 
information

Task duration is essential for checking the availability of the 
resource and for designating a resource as unavailable in the 
resources calendar after a task has been assigned.

Resource’s availability 
information

Availability of the resource is provided by the Calendar 
component in which availability is defined.

For more information, see Calendar. 

Criteria Description

1. Preferred 
Resources

The first and foremost criteria the Assignment Manager considers in 
the assignment process.

2. Territories Used to retrieve all the qualified resources for the assignment from the 
selected territories. 

3. Resource 
Availability

After a preferred or qualified resource, based upon territories, is 
selected, the availability of the resource is considered.
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Assigning Process
making a selection from the selection criteria. The combination of the criteria 
selected results in the selection of the qualified resource. 

See Also
Selecting Assignment Criteria
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Using Assignment Manager

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. This section covers the following 
topics:

■ Assigning Options

■ Assigning Unassisted

■ Assigning Assisted

■ Assigning Intelligent

■ Assigning with the Window to Promise

■ Selecting Assignment Criteria

Assigning Options
Choose one of the following options for assigning tasks:

■ Assigning Unassisted

■ Assigning Assisted

■ Assigning Intelligent

■ Assigning with the Window To Promise

■ Selecting Assignment Criteria

Assigning Unassisted
Use the Unassisted option to assign responsibility to a resource of your choice, 
without using the criteria set or the features of Oracle Scheduler.
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Assigning Assisted
The Gantt chart displays tasks that have already been assigned in green. Move your 
cursor over a task to view details.

Prerequisites
None

Steps
1. Select the Unassisted option from the Selection Criteria.

2. Make an entry at Resource Partial Name or Resource Type. 

3. Click Search. 

The Gantt chart for the resource or resources found is displayed.

4. Double-click on the preferred resource. 

The selected resource appears below the Gantt chart.

5. Enter the preferred Start Time and End Time.

6. Click OK to commit the assignment or click Cancel to leave Assignment 
Manager without changes.

Assigning Assisted
Use the Assisted option to assign responsibility to a resource based upon the 
selection criteria.

The Assignment Manager always appears with the Assisted option selected and 
displays a list of qualified resources based upon the selection criteria.

The Gantt chart displays tasks that have already been assigned in blue and plan 
options in green. Move your cursor over a task to view details.

Prerequisites
None

Steps
1. Select the Assisted option from the Selection Criteria. 

The calendar for the qualified resource appears.

2. Adjust the Selection Criteria and click Search when the Gantt chart is empty.
160 Oracle CRM Application Foundation Concepts and Procedures



Assigning Assisted
For more information, see Selecting your Assignment Criteria.

3. Double-click on the resource with the preferred Start and End Time. 

The selection appears below the calendar.

4. Click OK to commit the assignment or click Cancel to leave Assignment 
Manager without changes.
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Assigning Intelligent
The Intelligent option is only available when Oracle Scheduler is installed. Use the 
Intelligent option to assign a task to a resource. 

The Gantt chart displays resources with costs, tasks that have been assigned in blue, 
and travel time between tasks. Move your cursor over a task to view details

Prerequisites
You must have Oracle Scheduler installed.

Steps
1. Select the Intelligent option from the Selection Criteria. 

The Gantt chart for the qualified resource or resources displays a related cost.

2. Adjust the Selection Criteria and click Search when the Gantt chart is empty.

For more information, see Selecting your Assignment Criteria.

3. Double-click on the resource with the preferred Start and End Time. 

The selection appears below the calendar.

4. Click OK to commit the assignment or click Cancel to leave Assignment 
Manager without changes.

Guidelines
The resource with the lowest cost related to the assignment is in most cases the best 
option to select. This plan option appears in green on the Gantt chart.
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Assigning with the Window To Promise
Use the Window To Promise option to assign a time slot to a customer. It is only 
available when Oracle Scheduler is installed.

The Window To Promise displays possible time slots to offer to the customer and 
related cost.

The assignment of the task results in a time slot reserved for a resource. It can later 
be optimized to another resource. 

Prerequisites
You must have Oracle Scheduler installed.

Steps
1. Select the Window To Promise option from the Selection Criteria. 

Possible time slots with related cost are displayed.

2. Adjust the Selection Criteria and click Search when the Gantt chart is empty.

For more information, see Selecting your Assignment Criteria.

3. Select the preferred time slot by checking it. 

The selection appears below the calendar.

4. Click OK to commit the assignment or click Cancel to leave Assignment 
Manager without changes.

Guidelines
The time slot with the lowest cost related to the assignment is in most cases the best 
option to offer your customer.
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Selecting Assignment Criteria
Selecting Assignment Criteria
Use the following chart to help you decide which options to choose when setting up 
assignment criteria. This is done in the Assisted screen of the Assignment Manager. 
A selection of the following criteria is possible:
 

P
re

fe
rr

ed
 R

es
o

u
rc

es

Te
rr

it
o

ri
es

R
es

o
u

rc
e 

A
va

ila
b

ili
ty

Selection results in:

X A search for the preferred resource, availability is not taken into 
account. 

X A search for a qualified resource in the selected territories, 
availability is not taken into account.

X A search for an available resource, preferred or qualified is not 
taken into account.

X X A search for the preferred resource, availability is not taken into 
account. 
When no preferred resource is available, a search for a qualified 
resource in the selected territories is done, availability is not 
taken into account.

X X A search for a preferred resource, availability is taken into 
account. 

X X A search for a qualified resource in the territories selected, 
availability is taken into account.

X X X A search for the preferred resource, availability is taken into 
account. 
When no preferred resource is available, a search for a qualified 
resource in the selected territories is done, availability is taken 
into account.
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Understanding Escalation Management

This topic group provides an overview of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. 

The topics covered in this group include:

■ Overview

■ Workflow Notifications

■ Escalation Territories

Overview
Escalations occur in support centers for a wide variety of reasons. An escalation 
management system allows an organization to identify, track, monitor, and manage 
situations that require increased awareness and swift action.

Escalation Management features include:

■ Escalation situation tracking information

■ Service Request, Task, and Defect linking capability

■ Ownership assignment based on escalation territory

■ Resolution plan definition with associated tasks and notes

■ Automatic notification of escalation progress to identified contacts

■ De-escalation and closure

Basic information is captured in an escalation document including the requester, the 
business situation, the required resolution date, and additional contacts that are 
involved. 
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Workflow Notifications
An escalation is managed by creating an escalation document, assigning an 
escalation owner, defining the actions needed to resolve the escalation, and 
communicating the progress. Once a situation is de-escalated, the escalation closure 
note is captured and a final communication is sent to the contacts involved.

Workflow Notifications
Notifications are an integral part of the Escalation functionality. Oracle Workflow is 
used to process and deliver the notifications regarding the escalation activity. 

Notifications are sent for the following reasons:

■ Escalation creation

■ Escalation status changes

■ Escalation owner assignment and changes

■ Escalation level changes

■ Escalation target date changes

Notifications are sent to those people (employees or customers) that are identified 
on the Contacts tab, and for which the Notify check box has been checked.

Typical recipients include:

■ Owner of the object (Service Request, Task, or Defect) that is being escalated

■ HR manager of the owner of the Escalation document

■ Owner of the Escalation document

Escalation Territories
An escalation territory is a placeholder for resources that you want to put into 
service under certain conditions. Escalation territories are defined in Territory 
Management. Ensure that at least one resource is identified in the Catch All 
Escalation Territory.

See also
View the following topics in Territory Manager for additional information:

■ Basic Territory Building Blocks

■ Viewing Escalation TerritoriesCreating Escalation Territories
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Using Escalation Management

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. See Overview for an explanation of 
the Escalation Management features.

The following topics are covered in this section:

■ Creating Escalations

■ Managing a Service Request Escalation

■ Managing a Task Escalation

■ Managing a Defect Escalation

Creating Escalations
Three object types can be escalated: service requests, tasks, and defects. An 
escalation is managed by creating an escalation document, assigning an escalation 
owner, defining the actions needed to resolve the escalation, and communicating 
the progress. Once a situation is de-escalated, a final communication is sent to the 
contacts involved.

An escalation is initiated by a person using a service channel (telephone, web, 
e-mail). An escalation can also be initiated by the system that is based on 
pre-defined rules that have been established to monitor business situations. (See 
Starting the Business Rules Monitor for more information on automated 
escalations.)

To initiate an escalation you must accept a request for an escalation, review the 
situation, create an escalation document, and notify the involved parties. An 
escalation request can be initiated on behalf of a customer, an employee, or other 
involved party.
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Managing a Service Request Escalation
See also
Managing a Service Request Escalation

Managing a Task Escalation

Managing a Defect Escalation

Managing a Service Request Escalation
A service request is a document that tracks information regarding a customer’s 
product and service problems. 

Use this procedure to manage a service request escalation.

Prerequisite
A service request has been entered into the system.

Steps
1. Navigate to View Service Request and query the existing service request.

2. Verify that the service request has never been escalated. In the Request 
Information area of the header, verify that “Never Escalated” appears in the 
Escalation Level field. 

You may have to scroll down in the Request Information header region to see 
the Escalation Level field. 

3. From the Tools menu, choose Request Escalation.

The Escalations Window appears. The customer and account information fields 
will automatically be filled out, along with the reference document information 
(service request).

4. Select a Status.

5. Select a Reason.

6. Enter a target date.

7. Select the escalation level.

8. Assign the escalation to yourself or another existing resource using one of the 
two methods listed: 

a. Select a resource from the LOV.
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Managing a Task Escalation
Click Assign to choose an escalation owner from the Assignment Manager.

b. Click Search. 

The resources from the Escalation Territory(s) of the escalated document(s) 
become visible. If there are no Escalation Territories set up, then the 
resources from the Catch All territory display.

Select the resource name and click OK.

9. Enter a situation summary.

10. Enter the name of the customer or employee contact (requester), and select the 
Requester check box.

There can be more than one contact, but only one requester. 

11. Optionally, enter any additional contact points.

12. Optionally, add more reference documents to the escalation.

13. Save the escalation, and make a note of the displayed escalation number. 

14. Optionally, click Notes to create a note about the escalation.

15. Optionally, click Tasks to create a task to manage the escalation.

16. Close the Escalation window to return to the Service Request screen.

Re-query the service request to view the updated escalation level.

Managing a Task Escalation
A task is a document that tracks work to be done by a support center. Service 
requests and defects may have associated tasks that define work to be done by a 
support center. A task can be escalated due to an issue with a service request or 
defect. A task can also be escalated independently.

Use this procedure to manage a task escalation.

Prerequisite
A task has been created and entered into the system.

Note: Only click Search in the Selection Criteria region. Leave the 
other fields as defaulted.
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Managing a Task Escalation
Steps
1. Navigate to Tasks. 

2. Find the task to be escalated.

3. From the Tools menu, choose Request Escalation. 

The Escalations window appears.

4. Verify that the task has never been escalated.

The escalation level and owner display on the main Task screen.

5. Enter the task number into the Number field in the Reference Documents tab.

6. Select a Status.

7. Select a Reason.

8. Enter a target date.

9. Select the escalation level.

10. Assign the escalation to yourself or another existing resource using one of the 
two methods listed: 

a. Select a resource from the LOV.

Click Assign to choose an escalation owner from the Assignment Manager.

b. Click Search. 

The resources from the Escalation Territory(s) of the escalated document(s) 
become visible. If there are no Escalation Territories set up, then the 
resources from the Catch All territory display.

Select the resource name and click OK.

11. Enter a situation summary in the Escalation Summary field.

12. Enter the name of the customer or employee contact (requester), and select the 
Requester check box.

There can be more than one contact, but only one requester. 

13. (Optional) Enter any additional contact points.

Note: Only click Search in the Selection Criteria region. Leave the 
other fields as defaulted.
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Managing a Defect Escalation
14. Save the escalation, and make a note of the displayed escalation number.

Query the escalated task to view the updated escalation level.

Managing a Defect Escalation
A defect is a document which tracks product problems and resolutions. A defect 
can be escalated without an associated service request. Any employee can escalate a 
defect.

Use this procedure to manage a defect escalation.

Prerequisite
■ A Defect with an open status has been created and entered into the system.

■ This defect has not yet been escalated. (You can use the Find window to search 
for an escalation on a particular document.)

Steps
1. From within the Customer Support Responsibility, choose Manage Escalations.

The Escalations window appears.

2. Enter the desired information (no information will default into the form).

3. Enter Defect into the Documents field in the Reference Documents tab.

4. Select a Status.

5. Select a Reason.

6. Enter a target date.

7. Select the escalation level.

8. Assign the escalation to yourself or another existing resource using one of the 
two methods listed: 

a. Select a resource from the LOV.

Click Assign to choose an escalation owner from the Assignment Manager.

b. Click Search. 
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Managing a Defect Escalation
The resources from the Escalation Territory(s) of the escalated document(s) 
become visible. If there are no Escalation Territories set up, then the 
resources from the Catch All territory display.

Select the resource name and click OK.

9. Enter a situation summary in the Escalation Summary field.

10. Enter the defect owner name in the contact field.

11. Save the escalation, and make a note of the displayed escalation number.

Note: Only click Search in the Selection Criteria region. Leave the 
other fields as defaulted.
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Using Dynamic Tables

This topic group provides process-oriented, task-based procedures for working 
with the embedded spreadtables.

This section covers the following topics:

■ Dynamic Tables

■ Sorting

■ Finding

■ Copying and Exporting

■ Customizing Layout

Dynamic Tables
Dynamic tables provide flexibility in displaying and handling data. Use them to 
track, sort, search, copy and export data, and customize your display. 

You can perform the following tasks with dynamic spreadtables:

■ Sorting

■ Finding

■ Copying and Exporting

■ Customizing Layout

Sorting
You can sort two ways:

1. To sort a category, click on the grey dot in its column header. 
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Dynamic Tables
The arrow that replaces the grey dot indicates a direction of order, for example, 
ascending or descending alphabetical or chronological order, where applicable. 

Re-sort in the opposite direction by clicking the header arrow again.

2. You can right-click on a cell and select Sort in the table from the pop-up menu 
that appears. This action opens a dialog box in which you can select up to three 
columns for sorting.

Finding
To find specific information in the table, right-click on a cell and select Find from 
the pop-up menu that appears. 

Find a matching value by typing the desired sequence of characters into the text 
field that appears. Indicate whether to match case, and select the direction of the 
search, backward or forward. 

Click Cancel to stop a long running search. 

Copying and Exporting
To copy a cell, selected rows, or all rows of data to the clipboard, right-click in a cell. 
From the menu, choose the appropriate option that appears.

When you insert the copied selection into a spreadsheet application, such as 
Microsoft Excel, the appropriate headers automatically migrate with the selection 
and appear as its first row. Rows are copied in a tab-delimited format.

Cells that display values as check marks or X display differently when copied and 
exported: positive values are expressed as asterisks (*) and negative values do not 
display.

Customizing the Layout
Adjust the table layout to accommodate your needs:

■ You can make changes to the column width, sequence, visibility, and sort order.

■ Resize the columns or rows to display text as you wish.

■ Depending on the application, you can resize the window also, and the 
spreadtable display will adjust accordingly.

Note: Hidden information does not migrate with exported data.
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Dynamic Tables
■ Resequence the columns: in a header, click and hold mouse until a black box 
appears. Move the header to the selected position. Allow for the delay before 
moving.

■ To make irrelevant or confidential information invisible, right-click the header 
of the column you wish to hide and then select Hide Column on the pop-up 
menu. 

■ The Show Column option reveals a submenu that lists currently hidden 
columns. Select all or only those you wish to display.

■ Hidden information does not migrate when data is copied to the clipboard.

■ To preserve changes you make to the table layout, right-click a column header. 
Choose Customizations, and from its submenu, choose Save. 

■ To restore default settings, right-click a column header. Choose Customizations, 
and from its submenu, choose Clear.
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Account adjustment
An adjustment to a subledger account, made via journal entries.

Acknowledgment
A token response, indicating that a given request was received. 

Acquirer
A financial institution that establishes an account for a merchant and processes 
credit card payment authorizations and payments.

Action
A user-initiated step taken to resolve an incident.

Activity
Any data change—including customer, administrator, or system events—that the 
system can log for reporting purposes or to trigger e-mail notifications. 

Examples of activities: 

n User login

n Customer payment of a bill

n Data upload
lossary-1



Activity logger 
The component of the application that records all activities—including customer, 
administrator, or system events—for use in reporting and e-mail notifications. See 
activity.

Adapter
Mediation layer provided by Service Delivery Platform to interface with various 
network elements.

Adapter type
Different kinds of adapter provided by Service Delivery Platform.

Address
A physical location for a customer or a contact.

Adjusted pipeline
The amounts for the latest, committed opportunity-level forecast. The amounts 
displayed are the amounts committed by the user or by the user’s subordinates at 
the opportunity level.

Advertisement
In iMarketing, an advertisement is a campaign without an offer attached to it.

Advertiser
In iMarketing, an advertiser is an affiliate that displays a merchant campaign 
(promotion, survey, ad, event) on its site. Advertisers can be subsidiaries, suppliers, 
channel partners, ad networks, portals, and so on.

Affiliate
In iMarketing, affiliates are third parties (subsidiaries, suppliers, channel partners, 
ad networks, and so on) that participate in the merchant’s campaigns. Two types of 
affiliates are publishers and advertisers.

Aging
In accounting, the activity associated with the amount of time that a customer claim 
is unresolved. Claims with comparatively long periods of aging represent funds 
that are inaccessible or cannot be accurately measured. 
Glossary-2         



Alphanumeric number type
An option for numbering documents, employees, and suppliers where assigned 
numbers can contain letters as well as numbers.

Alternate unit of measure
All other units of measure defined for an item, excluding the primary unit of 
measure.

AMPS
Advanced Mobile Phone Service. An analog cellular voice communication system 
that operates in the 800 MHz range.

ANSI
American National Standards Institute, which establishes national standards for the 
United States and serves as the North American representative to ISO (International 
Standards Organization). The parent organization for X12.

AOL
Applications Object Library.

API (Application Programmable Interface)
A set of procedures that import or export information between an application and 
an operating system or other system program.

Application building block
A set of tables and modules (forms, reports, and concurrent programs) that 
implement closely-related entities and their processing.

Approve
An action you take to indicate that you consider the contents of a purchasing 
document to be correct. If the document passes the submission tests and you have 
sufficient authority, Purchasing approves the document.

Asset category
Assets may be grouped by category. All assets in a category share the same asset 
cost accounts and depreciation accounts for each depreciation book.
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Asset hierarchy
Assets can be grouped and placed in a hierarchy of larger groups. For example, 
computers can be grouped for each floor of a building. The floor groupings can then 
be grouped into one logical grouping of computers for the whole building. The 
hierarchy would consist of all computers in the building at the top as a parent to 
each floor grouping of computers. Each floor grouping is a parent to the individual 
computers.

Asset hierarchy batch
Any changes made to a hierarchy are recorded in a batch that, when applied, will 
make the changes in your financial books.

Asset hierarchy node
A node represents a logical collection of assets. Several logical groupings (nodes) 
can be placed in a hierarchical structure, with the asset records serving as children 
of the lowest level logical nodes. Each node can have only one parent but can have 
many children.

Asset hierarchy purpose
An asset hierarchy purpose provides a justification for building an asset hierarchy 
that serves some useful accounting purpose. At least one asset hierarchy rule must 
exist before a purpose can be created. An asset hierarchy purpose is required to 
build a hierarchy.

Asset hierarchy rule
An asset hierarchy rule determines the values of attributes for nodes in the asset 
hierarchy.

Asset item
Anything you make, purchase, or sell including components, subassemblies, 
finished products, or supplies, which carries a cost and is valued in your asset 
subinventories.

Asset status
A user-defined field. This field may be used to search for an asset in the Find Assets 
window. This field also affects Mass Additions, Mass Transfers, and Batch Transfers.
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Asset subinventory
A subdivision of an organization that represents either a physical area or a logical 
grouping of items. An example is a storeroom where quantity balances are 
maintained for all items and values are maintained for asset items.

Attachment
A file of any type that is associated with a value such as a customer site, a to do, or 
an opportunity. An example is a contract created in a word processing file that is 
attached to a customer.

Attribute - Oracle Provisioning
A type identifier.

Attribute, profile
A name-value pair that identifies one of the pieces of information the system asks 
the user to provide about him- or herself for a user profile. Examples of profile 
attributes: State, FavoriteColor. 

There are two types of profile attributes:

n Generic: The attribute is used with all users of that profile type. 

n Conditional: The attribute is used with a subset of the users of that profile type 
that meet a given condition.

Authentication 
An electronic security scheme that requires a user to enter a user name and 
password to view certain files or open certain parts of a user interface.

Authorization 
The validation of access rights. Authorization uses authentication and evaluation of 
constraints to process a request. 

Autopay rule 
Automatic payment rule. A rule in the database, set up in advance by the customer, 
that prompts the system to automatically pay the bills sent to that customer by a 
particular biller. 

The customer can specify, for a given biller: 

n The amount of payment 
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n The date on which to pay the bill 

n The payment instrument to use 

When such a rule is established, the system automatically pays all of that biller’s 
bills without intervention from the customer until the customer changes the rule. 

Autopayment 
The automatic payment of bills according to autopay rules set up by the customer.

Availability matrix
A table containing information on the availability of software products. It covers the 
various versions of a product classified by platform, with their respective release 
dates.

Back to Top

B

Back end payment system
An application used by a biller site to process payment requests for a specific kind 
of payment method. For example, one payment system might handle certain kinds 
of credit card payments, while another payment system handles only financial 
institution (bank) account transfers. 

Example of payment systems: CyberCash, Check Free, Verifone. 

See financial institution payment system and credit card payment system.

Backflush operation
A routing operation where you backflush component items.

Backflush transaction
A material transaction that automatically issues component items into work in 
process from inventory when you move or complete the assembly. Also known as 
post-deduct or pull.

Bank account transfer 
See financial institution account transfer. 
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Bill of material
A list of component items associated with a parent item and information about how 
each item relates to the parent item. Oracle Manufacturing supports standard, 
model, option class, and planning bills. The item information on a bill depends on 
the item type and bill type. The most common type of bill is a standard bill of 
material. A standard bill of material lists the components associated with a product 
or subassembly. It specifies the required quantity for each component plus other 
information to control work in process, material planning, and other Oracle 
Manufacturing functions.

Bill-to address
The customer’s billing address. It is also known as invoice-to address. It is used as a 
level of detail when defining a forecast. If a forecast has a bill-to address associated 
with it, a sales order only consumes that forecast if the bill-to address is the same.

Bill/routing reference
A bill or routing you assign to non-standard discrete jobs. You use the bill reference 
to create the material requirements for the job. You use the routing reference to 
create the routing for the job.

BOM
Bill of material

BOM item type
An item classification that determines the items you can use as components in a bill 
of material. BOM Item types include standard, model, option class, and planning 
items.

Bonus
Incentive compensation typically paid for meeting a goal, including quantitative 
and qualitative goals.

Booked date
The date that an order is booked, signifying that the order is firm and includes all 
the information necessary to be processed through its order cycle. 

Browser 
See web browser.
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Bug
A product defect or failure. Failure may be exhibited as an outage, incorrect or 
undocumented behavior, inaccurate documentation, or performance degradation.

Bundle sequencing
Sequencing of different bundles in an order. One bundle cannot continue until an 
earlier bundle completes.

Bundles
Collection of line items of an order.

Business application
Software that performs a particular business function or group of functions 
(accounts payable, for example).

Business document
A document used for conducting business between two trading partners—a 
purchase order or invoice, for example.

Business process
Business rules for the type of support, such as field or help desk.

Back to Top
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Calculator
A database that uses the data collected by the collector to calculate a compensation 
payment.

Campaign
A marketing activity that is displayed on merchant or affiliate web sites. A 
campaign can be a promotion, an advertisement, a survey, an event, or a publisher’s 
ad.

Capture
Phase in the payment process when funds are transferred from the customer’s 
account to the payee’s account for an already authorized transaction.
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Certification matrix
A table containing certified information of the availability of software products. It 
covers a range of platforms and products and their respective versions, and clarifies 
which combinations do or do not work together.

Channel
A unique route from Service Delivery Platform to the Network Element via a 
Service Platform Delivery Adapter.

Classification
A classification of the type of business area that an account or opportunity is 
interested in. This can be anything—such as a type of product, a technology, or a 
business sector. Classifications are created for you by your system administrator.

Classification rules
A user-defined set of rules used to classify a sales transaction.

Clawback
The amount of compensation credited for a sale that is taken back when the invoice 
due date grace period is exceeded.

CLEI code
Common Language Equipment Identifier code. A 10-character code identifying 
telecommunications equipment in a uniform, feature-oriented language.

Client 
A software application (such as a browser) that requests services, data, or 
processing from a server or from another application. 

CLLI code (also CLLIA, CLLIZ)
Common Language Location Identifier code. An 11-character code identifying and 
describing buildings, non-buildings, equipment locations, and related job functions.

Close date
The date by which you expect your prospect to make a purchase decision. Close 
date determines the period for which an opportunity is forecasted.
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Close reason
The reason an opportunity is no longer active. An opportunity closes because it 
turns into a sale, is lost to a competitor, or is not a viable. 

Code
A unique identifying number used anywhere a unique identifier is required, for 
example, event code, advertisement code, letter code, and so forth. Your system 
administrator determines if code is user- or system-generated.

Collection
The process of collecting transactions from feeder systems into the application.

Collector
A database that collects the data required to pay compensation.

Column headings
Descriptions of the contents of each column in the report.

Committed amount
The amount you agree to spend with a supplier.

Compensation plan
A collection of plan elements used to calculate a compensation payment. One 
compensation plan is assigned to a salesperson for a given period of time. See 
source document or source transaction.

Compensation rate
A multiplier on net sales credit. Rate is determined by level of quota achievement, 
as defined in a rate table. 

Compensation transaction
The smallest logical unit of data on which a compensation payment can be 
calculated. Each transaction comprises several attributes, some of which can be 
user-defined during implementation.

Competitor
A company that competes with your enterprise.
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Component
A serviceable item that is a part or feature in another serviceable item. Your 
customers cannot report service requests against this type of serviceable item 
directly. You can reference components when you enter service requests against 
actual end item-type serviceable items, or products. For example, if you define three 
inventory items, A, B, and C, where A and B are products (end item-type 
serviceable items) but C is a component (non-end item-type serviceable item) of A, 
you can enter service requests against A and B directly, but not against C. When you 
enter a service request against product A, you can reference C because it is a 
component of A.

Component item
An item associated with a parent item on a bill of material.

Computer-telephony integration (CTI)
The practice of using a computer to control one or more telephone and 
communications functions.

Concurrent manager
Components of your applications concurrent processing facility that monitor and 
run time-consuming tasks for you without tying up your terminal. Whenever you 
submit a request, such as running a report, a concurrent manager does the work for 
you, letting you perform many tasks simultaneously.

Concurrent process
A task in the process of completing. Each time you submit a task, you create a new 
concurrent process. A concurrent process runs simultaneously with other 
concurrent processes (and other activities on your computer) to help you complete 
multiple tasks at once with no interruptions to your terminal.

Concurrent queue
A list of concurrent requests awaiting completion by a concurrent manager. Each 
concurrent manager has a queue of requests waiting in line. If your system 
administrator sets up simultaneous queuing, your request can wait to run in more 
than one queue.
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Concurrent request
A request to complete a task for you. You issue a request whenever you submit a 
task, such as running a report. Once you submit a task, the concurrent manager 
automatically takes over for you, completing your request without further 
involvement from you, or interruption to your work. Concurrent managers process 
your request according to when you submit the request and the priority you assign 
to your request. If you do not assign a priority to your request, your application 
prioritizes the request for you.

Configuration
A product a customer orders by choosing a base version and a list of options. It can 
be provided as individual pieces, as a set, or as an assembly (configuration item). 

Configuration bill of material
The bill of material for a configuration item.

Configure-to-order
An environment where you enter customer orders by choosing a base model and 
then selecting options from a list of choices.

Contact
An individual that works for an account. 

Coterminous
Setting the same end date for all ordered or renewed service programs.

Coupon
A consumable promotion. This term is based on the analogous use of coupons you 
find in stores.

Credit memo
A document generated when an invoice is fully or partially reversed.

Credit
Phase in the payment process when funds are transferred from the payee’s account 
to the customer’s account.
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Credit card payment system 
A type of payment system that handles certain kinds of credit card payments only. 
These payment systems communicate with payment processors for credit card 
payments. They do not require any communications with the Automated Clearing 
House network. CyberCash is an example of a credit card payment system. 

See back end payment system. 

Credit receiver
A salesperson who has been assigned sales credit.

Credit type
A salesperson can receive monetary or non-monetary credit. The credit types are 
user-defined. Examples of monetary types are commission and bonus. Examples of 
non-monetary types are air miles and holidays.

Crediting transaction
A type of transaction that gives or takes away sales credit after sales credit has been 
allocated for an invoice transaction.

CTI
See computer-telephony integration.

Current date
The present system date.

Custom fields
Also known as flexfields. Custom fields are available on most screens. A flexfield 
must be set up by the system administrator, include a custom label for the field, and 
indicate what type of data is allowed in the field. A key flexfield is indexed, and a 
search may be conducted against it or data may be sorted by the field in a report.

Customer number
A system-generated number that uniquely identifies a customer or prospect.

Customized plan
A compensation plan for which you have changed the defaults for quota or 
compensation rates, according to the needs of an individual salesperson.
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Customer product
An entity that identifies a serviceable item or customer product. The customer 
product identifies not only the product and the customer, but also the product 
quantity, the product’s serial number (if the product is under serial number control 
and has been assigned a serial number), the location of the product, the various 
contacts, such as service administration, support, and bill-to associated with the 
product. A customer may have several of the same customer products.

Customer site
A specific area or place, such as a building or a floor on a building, at a customer 
address. A customer address may have one or more related customer sites.

Cycle counting
An inventory accuracy analysis technique where inventory is counted on a cyclic 
schedule rather than once a year.
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Dashboard
The navigation control panel that is accessible to the user at all times.

Database diagram
A graphic representation of application tables and the relationships among them.

Database view
Provides access to an underlying database table. You do not need to know how the 
data is stored to use a database view.

Decision maker
A contact having authority to make purchase decisions.

Default plan
A compensation plan that has user-defined default values for plan elements. When 
you assign a base plan to a salesperson, you can customize values in the plan 
elements such as the quota, rates, periods, draw amounts, and so forth.
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Delayed service order
An order for service against existing customer products. The service order is 
"delayed" because service is ordered later than the product is ordered.

Dequeuer
Process that processes the items of a queue.

Depot repair
A process used to track items returned by a customer for repair or replacement.

Descriptive flexfield
A field you use to collect information unique to your business. You determine the 
additional information you need and descriptive flexfield lets you customize your 
application to your needs without additional programming.

De-support notice
A brief announcement specifying a platform/product/version combination for 
which regular support will no longer be provided as of a certain date.

DHCP
Dynamic Host Configuration Protocol. A protocol that automatically assigns 
Internet Protocol (IP) addresses on TCP/IP networks when users log on, thereby 
reducing configuration time. DHCP centralizes IP address management on central 
computers that run the DHCP server program.

Dimension
A type of hierarchy.

Direct sales credit
Sales credit directly assigned to a salesperson in a transaction in a feeder system, 
such as Oracle Order Entry or Oracle Receivables, or a foreign source.

Discount
A reduction of the list price of an item.
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Display rule
In iMarketing, a display rule is an object that selects a campaign (from a group of 
eligible campaigns for the specific customer in the session) at run-time (display 
time). A display rule can be called from any template, including an iStore template.

Display style
A display style is a template design that specifies how information displays on a 
web page. For example, you use one display style to display product A on a special 
sale page, and a different display style to display product A on a page detailing 
product information.

DMS
Defect Management System.

DNS
Domain Name Server. Server computers connected to the Internet that maintain a 
database of domain names and their associated IP address numbers.

Domain name
A unique name that identifies an Internet site that points to one specific server.

Do not mail
A check box indicating the exclusion of this account or contact from promotional 
mailings.

Down stream system
A system that a communication company has to have a link with. It can be a system 
to provision service, to bill a customer, to register a number for E911, and so forth.

Draw
An advance paid to a salesperson toward future earnings.

Drill down
A term referring to clicking on an item within a screen to open a submenu or 
another screen.

Back to Top
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E-commerce
E-commerce builds on e-business, leveraging the Internet supply chain to shift 
business from a supply-driven to a demand-driven business model. Internet-based 
sourcing and requisitioning puts the customer completely in control and facilitates 
the delivery of products and services. The Internet enables e-commerce to connect 
and extend the value chain, streamline business processes, lower operational costs, 
and improve time to market.

e-Commerce is possible through the use of the latest Internet-based applications, 
which can capture older data in various data storage formats from companies and 
their suppliers and make it available across current applications.

Electronic payment
Any non paper-based type of payment.

Encryption 
The data security practice of scrambling (encrypting) data in such a way that only 
an intended recipient can decrypt and read the data.

Engineering change order (ECO)
A record of revisions to one or more items usually released by engineering.

Entity
A data object that holds information for an application.

ESN
Electronic Serial Number. A 32 bit binary number that uniquely identifies each 
wireless phone. For analog systems, the ESN along with the Mobile Identification 
Number (MIN) comprise the handshake information that identifies each mobile 
phone. See also mobile number (MIN or MSISDN).

Event alert
An alert that runs when a specific event occurs that you define. For example, you 
can define an event alert to immediately send a message to the buyer if an item is 
rejected on inspection.
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Expected purchases
Products or services you expect to sell with this opportunity. 

Expense subinventory
Subdivision of an organization, representing either a physical area or a logical 
grouping of items, such as a storeroom where no value exists but the quantities may 
be tracked.

Back to Top
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Feeder system
An order or billing receivable system that inputs transactions to the database. 
Example: Oracle Receivables.

Financial institution (FI) payment system
A type of payment system that handles bank account transfers and certain kinds of 
credit card payments. These payment systems communicate with Automated 
Clearing House (ACH) networks, credit card systems, or both. See back end 
payment system. 

Financial institution account transfer 
A bank account transfer. The direct transfer of funds, for payment, from a 
customer’s financial institution account to a payee’s financial institution account. 

finished good
Any item subject to a customer order or forecast. See also product.

Flexfield segment
One part of your key flexfield, separated from the other parts by a symbol you 
choose (such as -, /, or \). Each segment typically represents a cost center, company, 
item family, or color code.

Forecast
Based upon a sales quota, a forecast of future sales can be entered either by a sales 
representative or managers.
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FTP
File Transfer Protocol. Internet tool to transfer files through the Internet from one 
computer to another. FTP is used to download files from another computer, as well 
as to upload files from your computer to a remote computer.

Fulfillment actions
Re-usable functions used to perform pre-defined provisioning tasks. Used as part of 
the fulfillment of a work item.

Fulfillment element
A unique identifiable physical Network Element/Operational Support System 
belonging to a fulfillment element type.

Fulfillment procedure
Provisioning Procedure for the fulfillment of service at the fulfillment element.

Fuzzy find
A feature you use to search for a name, address or account for which you are not 
sure of the exact spelling or wording. Fuzzy find follows a prescribed set of rules to 
accomplish its search.
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Giveback
The payment received for a clawback.

GSM
Global System for Mobile. A digital mobile telecommunications system currently 
most prolific in Europe and well established in most countries outside the U.S. 

Back to Top
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Hierarchy
A group of related entities arranged in an inverted tree structure according to rank 
or successive grades.

Holiday support 
An application component that controls the way weekends and holidays affect a 
payment system’s lead time—the time it takes the payment system to process a 
payment request. Holiday support applies rules to FI payment systems. 

Lead time is computed in business days and does not count weekends and 
holidays. If a payment system’s normal lead time is two days, and the payment 
system receives a request on Friday, the payment may not be processed until 
Tuesday. Similarly, if July 4 is a bank holiday and the payment system receives the 
request on July 3, the payment may not be processed until July 6. 

Payment systems may have their own customized set of holidays. The payment 
system may provide a PL/SQL file to use for holiday computation. 

HTML 
Hypertext Markup Language. A standard format for encoding documents for use 
on the World Wide Web. 

HTML documents may contain text, graphics, references to programs, and 
references (links) to other hypertext (web) documents. 

HTTP
Hypertext Transfer Protocol. The protocol that clients use to issue requests for 
documents over the Internet. 

When HTTP appears at the beginning of a URL, it tells the browser to expect a 
hypertext document. 

HTTPS
A secure version of Hypertext Transfer Protocol (HTTP). HTTPS coexists with 
HTTP and provides security mechanisms to secure transactions between Web 
clients and servers.

Back to Top
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ICX
The Inter Cartridge Exchange is an API provided by Oracle Web Server to issue 
HTTP requests between cartridges.

IMAP
Internet Mail Access Protocol. An Internet protocol that expands on the features of 
POP, an Internet mail server protocol that provides an incoming message storage 
system. Like POP, IMAP works in conjunction with SMTP, which moves mail from 
one system to another. See also SMTP.

IMEI
International Mobile Station Equipment Identity is a unique electronic serial 
number identifying a particular mobile station.

IMSI
International Mobile Subscriber Identity. A unique number identifying a particular 
subscriber.

incentive factors
See quota uplift and period.

incentive type
Three types of incentive compose the monetary amount of a compensation 
payment: commission, bonus, and manual payments.

incident
An entry logged in to record a customer’s request for product service. You can log a 
different incident for each issue a customer reports, including questions about 
products, problems using the products, requests for preventive maintenance, and 
requests for service contract renewals.

included item
A standard mandatory component in a bill, indicating that it ships (if shippable) 
whenever its parent item is shipped. Included items are components of models, kits, 
and option classes.
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indirect sales credit
Credit inherited by a salesperson according to his/her place in the salesperson 
hierarchy. Indirect credit can roll up from a subordinate to a manager, or across from 
a salesperson to a peer. 

inspection
A procedure you perform to ensure that items received conform to your quality 
standards. You can use inspections to prevent payment for goods and services that 
fail to meet your quality standards.

interest
See interest type. 

interest code
A code created by your system administrator for an item or business area that you 
use to track account, contact, and opportunity interests. Each primary code can 
have secondary codes, so that you can break your account and contact interests 
down. For example, you might have one product that is available in more than one 
version or model. You can create a primary interest code for the product itself and 
then link it to a number of secondary codes that represent the different versions or 
models.

interest type
A classification of the type of business area in which a contact is interested. This can 
be anything—such as a type of product, a technology, or a business sector. Interest 
types are created for you by your system administrator.

internal requisition
See internal sales order, purchase requisition.

internal sales order
A request within your company for goods or services. An internal sales order 
originates from an employee or from another process as a requisition, such as 
inventory or manufacturing, and becomes an internal sales order when the 
information is transferred from purchasing to order entry. Also known as an 
internal requisition or a purchase requisition.
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inventory transaction
A record of material movement. The basic information for a transaction includes the 
item number, the quantity moved, the transaction amount, the accounting flexfields, 
and the date. See material transaction.

issuer
A financial institution that establishes an account for a consumer and issues the 
payment instrument.

issue transaction
A material transaction to issue component items from inventory to work in process.

item
Anything you make, purchase, or sell, including components, subassemblies, 
finished products, or supplies.

item attribute control level
To maintain item attributes at the item master attribute level or the organization 
specific level by defining item attribute control consistent with your company 
policies. For example, if your company determines serial number control at 
headquarters regardless of where items are used, you define and maintain serial 
number attribute control at the item master level. If each organization maintains 
serial number control locally, they maintain those attributes at the organization 
specific level.

item master level attribute
An item attribute you control at the item master level as opposed to controlling at 
the organization level.

item sequence
The sequence of the component item on the bill of material used to sort components 
on reports.

item specification
See specification.

Item status
Code used to control the transaction activity of an item. 
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Item type
Entity in Oracle Workflow that identifies a set of business processes.

Back to Top

J

Java 
An object-oriented, portable computer language developed by Sun Microsystems 
and supported by the Oracle Application Server. 

The Oracle Application Server can execute Java directly and send Java programs to 
a client’s browser for execution there. 

JBC 
JavaBeans cartridge.

K

Key indicators
A report that lists statistical receivables and collections information that lets you 
review trends and projections. Also, an Oracle Applications feature you use to 
gather and retain information about your productivity, such as the number of 
invoices paid. You define key indicators periods, and the application provides a 
report that shows productivity indicators for your current and prior period activity.

Key site
A site you work with frequently. 

Knowledge area
A collection of knowledge objects that pertain to a specific product or other 
categorization.

Back to Top
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Latest commitment
The latest amounts committed by the user or by the user’s subordinates at the 
product category level for Forecast and Upside statuses. ’None’ is displayed if no 
previous commitment was made.

LDAP
Lightweight Directory Access Protocol. A directory service specification that 
provides white pages services for an organization, for example, helping people locate 
other people or services. A directory service is a database that users can search and 
manipulate in a number of ways to display information about a network and its 
resources, or to create and manage user accounts. In Oracle Applications, LDAP 
refers to the server used for such purposes.

Lead
A potential to sell products and/or services to an account or contact. Leads record 
the initial interest a customer or prospect has in making a purchase or in evaluating 
a product for purchase. One contact can generate many leads. One marketing 
activity can generate many leads. Qualified leads become opportunities. 

Life end date (LED)
The date when an asset will be fully depreciated. For example, if an asset with a life 
of three years is entered into an accounting book on 1 January 2003, then its LED 
will be 31 December 2005.

Line item
Individual products/services part of an order.

Line item sequencing
Line items that do not depend on the start/completion of any other line item (if 
any) in an order.

List price
A standard item cost charged to a customer for your product. 

Local database 
A database that runs on the same machine as the Oracle Application Server.
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Locator
Physical area within a subinventory where you store material, such as a row, aisle, 
bin, or shelf.

Back to Top
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Mail merge
A feature of word processing software that lets you personalize a form letter. In 
general, two files are involved: a form letter containing both the text that remains the 
same and tokens representing information to be personalized and a merge file 
containing database information that replaces the tokens, such as a company name 
or a contact’s name and address. 

Mandatory component
A component in a bill that is not optional. Oracle Applications distinguish 
mandatory from optional components in model and option class bills of material. 
Mandatory components in pick-to-order model bills are often referred to as 
included items, especially if they are shippable.

Manual transaction
A user-entered transaction created for reversing or changing sales credit.

Mapping
Rules defining collection that map the table columns of a feeder system to the 
transaction columns in the application.

Mass change order
A record of a plan to replace, delete, or update one or more component items in 
many bills of material at the same time.

Mass retirement
A feature that allows you to retire a group of assets at one time. In Oracle Assets, 
mass retirements may be made through the Asset Hierarchy or through the Mass 
Transactions menus.
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Material transaction
Transfer between, issue from, receipt to, or adjustment to an inventory organization, 
subinventory, or locator. Receipt of completed assemblies into inventory from a job 
or repetitive schedule. Issue of component items from inventory to work in process.

Merge file
An operating system file that contains information pulled from the database, for 
merging into the text of a form letter to personalize it. For example, a merge file 
might contain name and address information for 15 contacts. When merged into the 
text of a form letter, it produces 15 personalized letters.

Message set 
See OFX message set. 

Middle ware
Software that sits between two or more types of software and translates information 
between them.

Mobile number (MIN or MSISDN)
Mobile Identification Number. The North American standard consists of 10 digits 
and follows this sequence: “(###) ###-####”. The European standard consists of 6 
digits and follows this sequence: “## ####”. For analog systems, the MIN and the 
Electronic Serial Number (ESN) comprise the handshake information that identifies 
each mobile phone. See also ESN.

Model bill of material
A bill of material for a model item. A model bill lists option classes and options 
available when you place an order for the model item.

Model item
An item whose bill of material lists options and option classes available when you 
place an order for the model item.

Module
A program or procedure that implements one or more business functions, or parts 
of a business function in an application. Modules include forms, concurrent 
programs, and subroutines.
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Multimedia
Multimedia consist of files used to present content on a web page to your customer, 
such as graphics, text, audio, and video.

Multimedia component
Multimedia components define the types of media objects available to display on a 
web page, such as a certain size picture, short text description, or audio of a certain 
length.

Back to Top
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Name-value pair
Used in HTTP communications to pass data. Name-value pairs may be either input 
or output. 

Net sales credit
The product of the transaction factor and sales credit, given if a salesperson is 
eligible. Net sales credit is further multiplied by the compensation uplift to 
determine compensation credit.

NLS
National language support.

NNTP
Network News Transfer Protocol. The delivery mechanism for the USENET 
newsgroup service. It provides a way to exchange messages, articles, and bulletins 
throughout the Internet.

Non-standard discrete job
A type of discrete job that controls material and resources and collects costs for a 
wide variety of miscellaneous manufacturing activities. These activities can include 
rework, field service repair, upgrade, disassembly, maintenance, engineering 
prototypes, and other projects. Non-standard jobs do not earn material overhead 
upon assembly completion.
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Non-standard expense job
A type of non-standard job expensed at the close of each accounting period. Typical 
expense jobs include maintenance and repair.

Note
A piece of information about a site, opportunity, or contact. A note is either entered 
by you or generated automatically to record the occurrence of a specific situation 
such as the receipt of a telephone call from a contact. 

Notification 
An e-mail message that the system creates and sends automatically to users or other 
addressees when certain events occur in the system. 

Numeric number type
An option for numbering documents, employees, and suppliers where assigned 
numbers contain only numbers.

Back to Top
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Offer rules
Rules used to specify if a promotion applies to a customer during order checkout in 
a given web site session.

Offline payment processing 
The payment processing model in which a payment processing request is not 
immediately forwarded to back-end payment processors. 

OFX
Open Financial Exchange. A framework developed by CheckFree, Intuit, and 
Microsoft for exchanging financial data and instructions between customers and 
their financial institutions. 

OFX enables institutions to connect directly to their customers or other institutions 
without requiring an intermediary. 

OFX is an open specification that anyone can implement: any financial institution, 
transaction processor, software developer, or other party. It uses widely accepted 
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open standards for data formatting (such as SGML), connectivity (such as TCP/IP 
and HTTP), and security (such as SSL). 

OFX message 
The unit of work in OFX, consisting of a request and response pair and the status 
codes associated with that response. 

OFX message set 
A collection of OFX messages. OFX message sets are the basis for OFX version 
control, routing, and security. They are also the basis for the required ordering in 
OFX files. 

On hold job/schedule
A job or repetitive schedule that is not accepting further activity and is therefore 
untransactable.

Online payment processing
The payment processing model in which a payment processing request is 
immediately forwarded to the back-end payment processor.

Open interface
A manufacturing function that lets you import or export data from other systems 
through an open interface. An example is a bar code reader device accumulating 
data you later import into your manufacturing system for further processing.

Open requirement
A Work In Process (WIP) material requirement you have not yet transacted to a 
discrete job or repetitive schedule. It equates to the component quantity required 
less any quantity issued.

Opportunity
A qualified sales lead with the potential to bring in revenue. An opportunity has a 
life span and it eventually closes either because it turns into a sale, is lost to a 
competitor, or is a bad opportunity. An opportunity is assigned to one or more 
territories based on a variety of criteria and may be worked on by a single sales 
representative, by a team of employees, or by a sales partner. 
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Opportunity item
A line item associated with an opportunity.

Opportunity number
The unique identifying number for an opportunity. 

Option
An optional item component in an option class or model bill of material.

Option class bill of material
A bill of material for an option class item that contains a list of related options.

Option class item
An item whose bill of material contains a list of related options.

Option dependent operation
An operation in a model or option class item’s routing that appears in a 
configuration item routing only if the configuration contains an option that 
references that operation.

Order analyser
PL/SQL (Service Delivery Platform) procedure used to add/delete/modify 
contents of orders.

Order date
The date an order for goods or services is entered. See also work order date.

Order line number
A number that uniquely identifies a specific line of a sales order.

Order number
A number that uniquely identifies a sales order.

Order type
A classification of a sales order. 
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Organization
An entity that can conduct business with your company. An organization can 
consist of multiple sites and may have multiple contacts associated with it.

Organization-specific level attribute
An item attribute you control at the organization level.

Original pipeline
Consists of the actual Opportunity amounts, totaled by Won, Forecast, and Upside 
statuses.

Outside processing
Performing work on a discrete job or repetitive schedule using resources provided 
by a supplier.

Outsource service
A company that provides billers with external web-based bill presentment and 
payment. The outsource service acts as a host for one or more billers’ websites.

Back to Top
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Packages
Pre-defined collection of products.

Parent node
An asset hierarchy is built using parent/child relationships. A parent node is a 
logical collection of assets or logical grouping of other hierarchy nodes. An asset 
record cannot be a parent node. A parent node can have only asset records as 
children or only hierarchy nodes as children. It cannot have both.

Parameter form
The HTML form that defines the parameters required for a report. For example, if 
the report you are creating is a list of all customers for a particular biller, the user 
must be able to enter the name of the desired biller when running the report. 
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Partition
A feature of the Oracle 8 database that provides a way to support very large tables 
by allowing you to decompose them into smaller and more manageable pieces. 
These pieces are called partitions. 

After you define your partitions, you can access and manipulate them instead of 
manipulating the entire table. 

All the partitions of a table have the same logical attributes. 

Partner
A company acting on behalf of your enterprise that helps close business for you by 
selling your products.

Pay group
A group of pay periods. It is used to identify the payment cycles of a salesperson. 
Each pay group may have one or many pay periods. 

Pay period
A range of dates over which calculated plan element commissions are collected for 
payment.

Payee
The company or other entity, such as a biller, that is being paid in a given 
transaction. 

Payee account 
The account (typically, a bank account) where the proceeds of all payments to a 
given payee are transferred. 

Payment instrument 
A bank account or credit card account that a customer uses for paying bills. 

Payment method 
A form of payment that a biller accepts for the payment of its bills. 

For example, the payment method that National Utility accepts might be credit 
cards and financial institution account transfers, while Big Bank Credit Card 
Company might accept only financial institution account transfers. 
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Payment processing 
The process of submitting, authorizing, and returning a payment request and 
related data. 

Payment state, payment status 
The status of a payment in iPayment. The five possible payment states are Pending, 
Scheduled, Paid, Failed, and Canceled. 

A payment is Scheduled when any of the following conditions apply: 

n The customer has scheduled it 

n The system has determined that the payment will be paid by autopayment 

n The payment was Failed and a CSR has rescheduled it for payment 

A payment is Pending when the customer has scheduled it, but the scheduling 
system has not sent it to the payment system. 

A payment is Paid when it has been completed successfully. 

It is Failed when it cannot be paid for any reason, such as insufficient customer 
funds. 

A payment is Canceled when a CSR has canceled it following a customer dispute or 
when he or she has determined for whatever reason that the payment cannot be 
rescheduled. Note that a scheduled payment can be canceled as long as the 
cancellation occurs before it reaches a bank. 

Payment system 
An application used by a biller site to process payment requests for a specific kind 
of payment method. For example, one payment system might handle certain kinds 
of credit card payments, while another payment system handles only financial 
institution (bank) account transfers. 

Example of payment systems: CyberCash, Check Free, Verifone. 

See financial institution payment system and credit card payment system.

Payment uplift
A type of incentive, the payment uplift is a multiplier on the compensation rate. The 
payment uplift varies the compensation payment without affecting quota 
achievement.
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The account (typically, a bank account) where the proceeds of all payments to a 
given payee are transferred. 

Pending
A status where a process or transaction is waiting to be completed.

Pending-iPayment
A payment status in which the customer has scheduled the payment but the 
scheduling system has not yet sent it to the payment system. See role. 

Period
A unit of time, such as one week, two weeks, or a month, on which your accounting 
calendar is based.

Period target
The target quota amount for a plan element for each period in the compensation 
plan.

Pipeline
An accumulation of the forecasted opportunity purchase lines that contain a status 
of Upside or Forecast.

Plan element
Terms defining the conditions a salesperson must meet to be paid compensation 
and the amount of compensation to be paid. A plan element includes one or more 
revenue classes, quota, transaction factor, incentives and compensation rate.

Point code
A unique code that identifies a network node so that the SS7 network can route calls 
properly.

Point of presence (POP)
A location where dial-up phone lines or leased line connections exist for Internet 
connection to an Internet service provider. Do not confuse with POP (Post Office 
Protocol).
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POP
Post Office Protocol. Do not confuse with point of presence (POP). An Internet mail 
server protocol that provides an incoming message storage system. POP works in 
conjunction with SMTP, which moves mail from one system to another. See also 
SMTP.

Posting
In iMarketing, posting is a campaign that is displayed by publishers or is displayed 
on advertiser sites (could be driven by a display rule). Posting is usually associated 
with terms of contract such as the display program, billing rate, effectivity dates, 
and so on.

PPP
Point-to-Point Protocol. A scheme to encapsulate and transmit Internet Protocol (IP) 
datagrams over serial point-to-point links. PPP provides router-to-router, 
host-to-router, and host-to-host connections.

Primary code
See interest code.

Primary routing
A list of the operations you most frequently perform to build a product. The 
primary routing is the default routing for defining a job and calculating 
manufacturing lead times.

Privilege 
The right or ability to perform an operation in the system. 

See role. 

Proactive knowledge
Information that is created based on analysis of customer need with the primary 
purpose of minimizing service requests. Typically, this information can be technical 
bulletins, white papers, FAQs, alerts, availability matrices, step-by-step instructions, 
and so forth.

Process
A set of Oracle Workflow activities that need to be performed to accomplish a 
business goal. See process activity, process definition.
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Process activity
An Oracle Workflow process modelled as an activity so that it can be referenced by 
other processes; also known as a subprocess. See also process.

Process definition
An Oracle Workflow process as defined in the Oracle Workflow Builder. See also 
process.

Product
A finished item that you sell. See also finished good.

Product catalog
Summarized product information can be searched for and viewed in the product 
catalog along with any additional files relating to the product.

Product category
A product category is a concatenation of interest type, primary interest code, and 
secondary interest code, or it is an inventory item description.

Profile option
A set of changeable options that affect the way your applications run. In general, 
profile options can be set at one or more of the following levels: site, application, 
responsibility, and user.

Promotion
In iMarketing, a promotion is a specific type of campaign with a discount value. It 
impacts the price of the item bought, the shipping charge, and the order amount 
during the checkout process. A promotion is associated with modifiers such as 2% 
off on the order.

Prospect
A company or other entity that has not yet placed a purchase order with your 
enterprise. 

Protection level
In Oracle Workflow, a numeric value ranging from 0 to 1000 that represents who the 
data is protected from for modification. When workflow data is defined, it can 
either be set to customizable (1000), meaning anyone can modify it, or it can be 
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assigned a protection level that is equal to the access level of the user defining the 
data. In the latter case, only users operating at an access level equal to or lower than 
the data’s protection level can modify the data.

Proxy server
Proxy server services run on a firewall server at the application level to protect 
internal resources on networks from other networks, such as the Internet. Proxy 
server services include controls for Web services and file transfer services.

Publisher
In iMarketing, a publisher is an affiliate that displays its ad on the merchant site. 
Publishers can be subsidiaries, suppliers and channel partners, ad networks, 
portals, and so on.

Purchase order (PO)
A document used to buy and request delivery of goods or services from a vendor.

Purchase requisition
An internal request for goods or services. A requisition can originate from an 
employee or from another process, such as inventory or manufacturing. Each 
requisition can include many lines, generally with a distinct item on each 
requisition line. Each requisition line includes at least a description of the item, the 
unit of measure, the quantity needed, the price per item, and the Accounting 
Flexfield you are charging for the item.

Purchased assembly
An assembly that you normally buy.

Purchased item
An item that you buy and receive. If an item is also an inventory item, you may also 
be able to stock it.
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Quantity
The number of items ordered on a sales order line.
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Qualified lead
A lead becomes qualified when it appears likely to lead to a sale. Leads can be set to 
"qualified" by a sales representative, or automatically, if the information in a lead 
meets criteria preset by the application administrator. For example, a lead can 
become qualified automatically as soon as a telemarketer makes entries in the Time 
Frame, Budget and Budget Status fields.

Queue
An intraoperation step in an operation where assemblies are waiting to be worked 
on, or service requests are waiting for response. The default intraoperation step for 
every operation in a routing.

Quota
A revenue goal for a sales representative that affects compensation.

Quota achievement
Accumulated performance against a quota that determines the compensation rate.

Quota credit
The product of the net sales credit and quota uplift. Quota credit is added to a 
salesperson’s quota achievement.

Quota percent
For an expected purchase, the percentage of the amount that you can claim as credit 
toward your quota. If you enter a value here, the system automatically calculates 
the Quota Credit.

Quota type
You can choose to view forecasts of actual revenue amounts or non-revenue 
amounts used for quota credits. Non-revenue amounts are created only for the 
purposes of sales representative remuneration.

Quota uplift
A type of incentive, the quota uplift is a multiplier on net sales credit, resulting in 
higher or lower quota credit applied toward the quota.
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Quote
A quote is a list of items and prices presented to a prospect. It is created by a sales 
representative when a contact, agreement, price list, and ship to site have been 
specified.
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Rate bracket
A range of achievement associated with a compensation rate. Also called a rate tier.

Rate table
A structure that associates compensation rates with brackets.

Reactive knowledge
Information created in real time mode based on information contained within a 
service request. Typically in the form of a product/solution.

Reconciliation
The process by which a payee and it’s bank exchange transaction report and match 
their records.

Reference
A check box that indicates whether a customer, site, or contact is trusted enough to 
act as a reference to other prospects.

Remaining useful life (RUL)
The remaining accounting periods for which an asset may be depreciated. For 
example, if an asset is entered into your system with a useful life of five years, then 
in its third year of service, that asset will have an RUL of two years.

Renewal order
An order containing service order lines to renew or extend existing services applied 
to products.

Requisition
See purchase requisition and internal sales order.
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Return
The process of transfer of funds from the payee’s account to the customer’s account 
in which the orderID is available.

Return material authorization (RMA)
Permission for a customer to return items. Receivables allows you to authorize the 
return of your sales orders as well as sales made by other dealers or suppliers, as 
long as the items are part of your item master and price list.

Revenue amount
For an expected purchase, each item, the amount you can roll upwards on a revenue 
forecast. 

Revenue class
A user-defined category of business revenue. Revenue classes are assigned to plan 
elements and help determine if sales credit is applied toward a compensation 
payment.

Revenue class hierarchy
A hierarchical arrangement of revenue classes and their subclasses in which you 
define very broad classes at the top of the structure. A revenue class hierarchy 
makes it possible to pay compensation for a broad revenue class without specifying 
all its subclasses.

Revenue classification rules
A set of one or more conditions a revenue class must have to classify into a given 
revenue class.

Revenue percent
For an expected purchase, the percentage of the amount that you can roll upwards 
on a revenue forecast. If you enter a value here, the system automatically calculates 
the Revenue Amount.

Revised component
Component changes to an assembly that is a revised item on an ECO.
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Revised item
Any item you change on an engineering change order. Revised items may be 
purchased items, subassemblies, finished goods.

Revised item status
A classification you can use to track and control a revised item’s life cycle. Revised 
item statuses include Open, Released, Scheduled, Hold, Implemented, and 
Cancelled.

Revision
A particular version of an item, bill of material, or routing.

Revision control
An inventory control option that tracks inventory by item revision and forces you to 
specify a revision for each material transaction.

Revision quantity control
A condition placed on an item that ensures that you always identify an item by its 
number and its revision. Certain items require tighter controls than other. For 
instance, you may want to control the quantities you have in inventory for an item 
by revision. For another item, you may just want to know the quantities you have 
on hand across all revisions. You keep track of inventory quantities by revision 
when an item is under revision quantity control. You keep track of inventory 
quantities by item when an item is not under revision quantity control.

Risk factor
Information that an electronic commerce application finds fit to use to evaluate risk 
of the customer.

Risk factor score
A number from 0-100 that assigns a risk value for a risk factor.

Risk formula
A formula that is based on multiple risk factors and used by a merchant to evaluate 
the risk of the customer.
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Risk Management (iPayment)
A new functionality provided by iPayment for electronic commerce applications 
both for business-to-business and for business-to-consumer models. iPayment 
includes a number of built-in risk factors and provides the option to the payees to 
run or not run the risk evaluation for each payment operation.

Risky Instruments Upload Utility (iPayment)
A Java application used to store risky payment instruments.

Role 
A group of related privileges.

See privilege. 

Roll across
In a hierarchy, nodes at the same level in the hierarchy branches. For example, in a 
salesperson hierarchy, credit rolls across to one or more of a salesperson’s peers who 
are at the same level in the organization.

Rollup
In a hierarchy, all ancestors of a node. For example, sales credit rolls up the 
salesperson hierarchy from the direct credit receiver to all salespeople above him in 
the credit chain.

Rollup territory
A territory without rank or group that represents a region. Your rollup territories 
can be customer-based, geographically-based, product-based or any combination of 
these and other factors. Each rollup territory is of a particular territory type and is 
defined by a set of territory values.

Route sheet
A report that provides full routing, operation, resource, and material requirement 
details for jobs and repetitive schedules. Typically used to know how, when, where, 
and who builds an assembly. Also known as traveler.

Routing
A sequence of manufacturing operations that you perform to manufacture an 
assembly. A routing consists of an item, a series of operations, an operation 
sequence, and operation effective dates. 
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Routing revision
A specific version of a routing that specifies the operations that are active for a date 
range.

Run
An intraoperation step where you move assemblies that you are working on at an 
operation.
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Safety stock
Quantity of stock planned to have in reserve in inventory to protect against 
fluctuations in demand or supply.

Sales channel
A method used to generate a sales order, such as telemarketing, direct marketing or 
sales partner. Sales Channels are set up by the administrator using QuickCodes.

Sales credit
An amount of revenue or non-revenue credit awarded to a salesperson. See also 
indirect sales credit.

Sales credit adjustment
A change in the amount of sales credit assigned to a salesperson by an order or 
billing system. The change may be retroactive. See also account adjustment.

Sales group
A sales organization within your enterprise that has a manager.

Sales partner
A company acting on behalf of your enterprise helping close business for you by 
selling your products. Examples of sales partners are reseller or dealer.

Sales rep
A sales representative or salesperson.
Glossary-44         



Sales rep territory
A sales area that you assign to an employee or team. Your sales rep territories can be 
customer-based, geographically-based, product-based or any combination of these 
and other factors. You can also base a sales rep territory on any number of rollup 
territories such that the sales rep territory automatically inherits the qualifier values 
of the rollup territories. Each sales rep territory is of a particular territory type 
within a particular territory group, and has a rank.

Sales stage
A defined step in the sales cycle. Your implementation team defines permissible 
values based on the sales methodology employed by your sales organization.

Sales status
A defined step in the sales cycle. Your enterprise’s implementation team defines 
permissible values based on the sales methodology employed by your sales 
organization.

Sales team
A sales team is a group of sales representatives and partners associated with a 
particular site or opportunity. Members of sales teams can be assigned 
automatically by the territory assignment program and may belong to different 
sales groups and reporting hierarchies. Each sales team has at least one sales team 
leader.

Salesperson
Any entity receiving sales-related incentive compensation including direct 
salespeople, managers, external agents, distributors, VARs, and customers.

Salesperson hierarchy
A hierarchical arrangement of salespeople in an organization that specifies the 
relationships between managers and their subordinates.

Scrap
An intraoperation step where you move assemblies that cannot be reworked or 
completed.

Scrap account
An account that you may use to charge scrap transactions.
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Scheduler 
The application component that schedules payment requests to back end payment 
systems and updates the system at regular intervals. 

On a regular basis, the scheduler schedules payments and sends and receives 
payment status updates. 

Schema
A collection of database objects associated with a single user or logon account, such 
as the roles, privileges, views, data files, tables, and tablespaces associated with that 
account.

Secondary code
See interest code.

Section
You can group products for sale into sections and arrange the sections into a 
hierarchy. The hierarchy is used to move your customer through your webstore.

Selling price
List price less any discounts.

Serial number
A number assigned to each unit of an item and used to track the item.

Serial number control
A manufacturing technique for enforcing use of serial numbers during a material 
transaction.

Serialized unit
The unique combination of a serial number and an inventory item.

Service
A benefit or privilege that can be applied to a product. In Oracle Applications, if the 
items you define are categorized as serviceable items, then you can order or apply 
service to those serviceable items.

Products offered by carriers.
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Service contract
A support license.

Service contract detail
Lines that specify start dates, end dates, product and coverage types.

Service designator
A number or string of characters that uniquely identifies a product or service that a 
communications service provider has sold to a customer. For example, a phone 
number or an e-mail address may serve as a service designator.

Service item
An inventory item used to define a service program or warranty. Service items can 
be recorded against serviceable products. A synonym for serviceable item is a 
serviceable product.

Service item feature
A particular service component, such as implementation or telephone support, that 
you include with a service item. When you classify an inventory item as a service 
type item and enter the service program-related attributes for it, you can list the 
specific services your service item includes.

Service material
Material used for the repair and/or maintenance of an assembled product.

Service order
An order containing service order lines. Service may be for new products or for 
existing, previously ordered products.

Service program
A billable service item. Usually a service that customers purchase in addition to a 
product’s base warranty.

Service person
An employee whose function is to provide support and service to customers. 
Service person is also a synonym for service specialist.
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Serviceable item
An inventory item that your organization supports and services, either directly or 
through the supplier of the item, regardless of who actually manufactures the item. 
A serviceable item can be an end item, both an end item and a component or part in 
other end items, or just a component.

Serviceable item class
A category that groups serviceable items. Each class must be of the type Serialized 
or Non-Serialized. You can group serialized serviceable items in a serialized 
serviceable item class. You can group non-serialized serviceable items in a 
non-serialized serviceable item class. A given item may be the member of only one 
item class at any given time.

Serviced customer product
An entity that identifies a service your customer has recorded against a particular 
product installation. If you order service against a product, then the application 
automatically links the product and the service being recorded against the product 
by creating a serviced customer product. A customer product installation may have 
more than one serviced product.

Serviced installation
A synonym for serviced customer product.

Servlet
A Java program that runs as part of a network service, typically an HTTP server. It 
responds to requests from clients. A servlet is commonly used to extend a web 
server by generating web content dynamically.

SET
The Secure Electronic Transaction protocol. An open standard developed jointly by 
Visa and MasterCard to ensure the privacy and security of credit card transactions 
over open networks such as the Internet.

Settlement
A process including capture, voids, returns, and credits.

SLA
Service level agreement
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SR
Service request

Set of books
A financial reporting entity that partitions general ledger information and uses a 
particular chart of accounts, functional currency, and accounting calendar. This 
concept is the same whether or not the Multi-organization support feature is 
implemented.

Ship to
The address of the customer who is to receive products listed on the invoice or 
order.

Ship-to address
A location where items are to be shipped.

SIM
Subscriber Identification Module. GSM (the European Global System for Mobile 
system) employs signal encryption via the SIM, a programmable smart card that 
slips into a slot built into the mobile phone handset. The SIM card also provides 
personal mobility. It contains identification information so all subscribed to services, 
regardless of the subscriber’s location, are available by inserting the SIM card into 
any accessible GSM mobile phone. See also GSM.

Site
A specific location (address) for a customer or prospect. There can be many sites 
associated with one customer or prospect.

Sites
A Web site, such as a consolidator site or biller site.

Site code
A system-generated number that uniquely identifies a site.

SMTP
Simple Mail Transfer Protocol. The Internet mail exchange protocol responsible for 
moving messages from one e-mail server to another. E-mail servers run a 
message-handling protocol called POP (Post Office Protocol) or IMAP4 (Internet 
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Mail Access Protocol, version 4). SMTP is like the mail carrier, responsible for 
transporting mail, while POP and IMAP4 are like the post office, responsible for 
receiving, storing, and forwarding mail. See also entries for POP and IMAP.

Source document or source transaction
Transactions collected from a feeder system. Examples include orders, invoices, and 
credit memos. See also compensation plan.

Source line
Source information tracking where an asset came from. This includes information 
from capital asset and accounts payable systems, as well as information added 
manually.

Spare part
A synonym for service part. It is an inventory item used without modification to 
replace an original part during the performance of maintenance or repair to a 
serviceable item or product.

Specification
Describes the requirements of a product in Oracle Quality. You can define 
specifications for the key characteristics of the products you produce.

SSL
Secure Sockets Layer. A standard for encrypting data that flows between a browser 
and a server, commonly used by payment systems for secure transactions.

Standard bill of material
A bill of material for a standard item, such as a manufactured product or assembly.

Standard costing
A costing method where a predetermined standard cost is used for charging 
material, resource, overhead, period close, job close, and cost update transactions 
and valuing inventory. Any deviation in actual costs from the predetermined 
standard is recorded as a variance.

Standard discrete job
A type of discrete job that controls material and resources for standard production 
assemblies.
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Standard item
Any item that can have a bill or be a component on a bill except planning items, 
option classes, or models. Standard items include purchased items, subassemblies, 
and finished products.

Standard operation
A commonly used operation you can define as a template for use in defining future 
routing operations.

Standard unit cost
The unit cost you may use to cost all material and resource transactions in your 
inventory and work in process system. This cost represents the expected cost for a 
component or assembly for a specified interval of time. The basis for standard cost 
may be the cost history, purchase order history, or predicted changes in future costs.

Standard warranty
A standard coverage type bundled with all sales of a particular product.

Start date
The date you plan to begin production of assemblies in a discrete job.

Status 
See payment status.

Subassembly
An assembly used as a component in a higher level assembly.

Subinventory
Subdivision of an organization, representing either a physical area or a logical 
grouping of items, such as a storeroom or receiving dock.

Supply type
A bill of material component field that controls issue transactions from inventory to 
work in process. Supply types supported by Work in Process include: Push, 
Assembly pull, Operation pull, Bulk, Supplier, Phantom, and Based on bill.
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Support site
A support territory (as opposed to a sales territory).

Supported product
An Oracle product and version combination for which technical assistance and 
error correction is provided.

System
A grouping of customer products.

Back to Top

T

Tablespace 
An area of a database where a defined group of tables is stored. 

Target segment
Defines a group of related customers. A segment may be associated with a set of 
campaigns. iMarketing checks the segments a customer belongs to, and determines 
the campaigns eligible for the customer. A segment can be organized hierarchically 
and can have up to one parent segment. The set of customers in a segment is always 
a subset of the customers in its parent segment.

Target segment rule
In iMarketing, a conditional statement associated with a target segment.

Target
A revenue goal associated with a single revenue class. Targets do not affect the 
compensation payment. 

Target quota
A revenue goal for a salesperson associated with a plan element. Target quotas do 
not affect the compensation payment. 

Template 
Specifications written in HTML that control the appearance and characteristics of an 
HTML document, such as a web page.
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Territory
An artificial aggregation of accounts, contacts, or leads.

Territory group
A territory group is a set of territory types that compete with each other when 
assigning leads and accounts to employees by territory. For a particular lead or 
account, access is granted to the employees whose territories rank highest within 
each territory group. 

To move
An intraoperation step where assemblies can either be completed to a subinventory 
or wait to be moved to another operation.

Total product value
The total product list value less the total product discount value. 

Total order value
The total product value plus the total service value.

Total commitment value
The dollar value of a contractual guarantee, with a customer, for future purchases. 

Transaction attribute
A single piece of information required to calculate compensation earnings. For 
example, a salesperson’s name or an employee ID.

Transaction date
The date you enter and Oracle Manufacturing maintains for any manufacturing 
transaction. The date must fall within an open accounting period and be greater 
than the release date for transactions on a discrete job or repetitive schedule.

Transaction factor
A multiplier on sales credit that determines net sales credit given for each type of 
transaction.

Transaction manager
A concurrent program that controls your manufacturing transactions.
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Transaction worker
An independent concurrent process launched by a transaction manager to validate 
and process your manufacturing transactions.
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Unit of measure (UOM)
The unit in which the quantity of an item is expressed.

Unit of measure class
A group of units of measure and their corresponding base unit of measure. The 
standard unit classes are Length, Weight, Volume, Area, Time, and Pack.

Unit of measure conversions
Numerical factors that enable you to perform transactions in units other than the 
primary unit of the item being transacted.

UOM
See unit of measure (UOM).

URL
The Universal Resource Locator. The address for any file of text, graphic, sound, or 
video information displayed on the World Wide Web.

User currency
The currency which the user has defined as the preferred currency.

V

Void
Removing a particular transaction from the records.

Back to Top
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W

Warranty
A non-billable, zero-monetary service item attached directly to a product at 
shipment.

Web browser
Software that enables a user to view information (browse) on the World Wide Web 
using HTTP.

Web server
A server connected to the Internet that stores documents and files and can display 
them to people accessing the server.

Win probability
The likelihood that the opportunity can close as a win by the expected close date. 
Your implementation team determines permissible values. Win probability can be 
linked to status so that status automatically updates when win probability changes. 

Work in Process (WIP) accounting class
A set of accounts that you use to charge the production of an assembly. You assign 
accounting classes to discrete jobs and repetitive schedules. Each accounting class 
includes distribution accounts and variance accounts. Also used in cost reporting.

Work in Process (WIP) move resource
A resource automatically charged to a discrete job or repetitive schedule by a move 
transaction. Resources are automatically charged when a forward move occurs, and 
uncharged when a backward move occurs.

Work items
Functions to be performed as part of the fulfillment of a service.

Work order date
The date to begin processing the paperwork for the discrete job. This date is offset 
from the start date by the preprocessing lead time.
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Worker
An independent concurrent process that executes specific tasks. Programs using 
workers to break large tasks into smaller ones must coordinate the actions of the 
workers.

Workflow Engine
The Oracle Workflow component that implements a workflow process definition. 
The Workflow Engine manages the state of all activities, automatically executes 
functions, maintains a history of completed activities, and detects error conditions 
and starts error processes. The Workflow Engine is implemented in server PL/SQL 
and activated when a call to an engine API is made.

X

XML (extensible Markup Language)
XML is a method for putting structured data into a text file. It is a subset of SGML 
(Standard Generalized Markup Language), which is a system for tagging and 
organizing elements of a document (in the case of XML, that document is a text file). 
’Structured data’ would appear in such things as spreadsheets, configuration 
parameters, or financial transactions. Applications that produce such data often also 
store it on disk in either a binary or text format. If the data is stored in text, you can 
view it without having access to the application that created it. XML is a set of rules, 
guidelines, and conventions for designing text formats for such data in such a way 
that it is easy for computers to generate and read. Using XML to define data avoids 
such pitfalls as ambiguity, lack of extensibility, lack of support for 
internationalization or localization, and platform dependency.
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